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Getting Started with DME Designer

In this manual the abbreviation “DME” refers to the DME64N/DME24N/DME8i-C/DME8o-C/DME4io-C/
DMES8I-ES/DME80-ES/DME4io-ES. The abbreviation “DME Satellite” refers to the DME8i-C/DME8o-C/
DME4io-C/DMES8i-ES/DME80o-ES/DME4io-ES.

Your DME, SP2060, ICP1 and the DME Designer software, let you build a custom audio system
installation that can support an incredible variety of conditions. You can build an entire system from
input to output with the DME Designer software, then send the system data to the DME and SP2060
which become independent processors.

An amazing variety of applications are possible, including audio installations, sub-mixing, speaker
system control, matrix/routing, and multi-effect processing.

Here the abbreviation “DME” does not include the “DME32.”

This manual is based on the English version of operating system. lllustrations, command names, window names, and similar
information are from that version. Some items may differ from what you see on the computer screen, depending on which
operating system you are using.

SPECIAL NOTICES

¢ The software and this Owner’s Manual are the exclusive copyrights of Yamaha Corporation.

¢ Copying of the software or reproduction of this manual in whole or in part by any means is
expressly forbidden without the written consent of the manufacturer.

* Yamaha makes no representations or warranties with regard to the use of the software and
documentation and cannot be held responsible for the results of the use of this manual and the
software.

e The company names and product names in this Owner’'s Manual are the trademarks or registered
trademarks of their respective companies.

¢ The screen displays as illustrated in this Owner’s Manual are for instructional purposes, and may
appear somewhat different from the screens which appear on your computer.

e Future upgrades of application and system software and any changes in specifications and
functions will be announced separately.

* Windows® is the registered trademark of Microsoft® Corporation.
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The DME Audio System Network

In an audio system including one or more DME units and/or SP2060 units, the “control space” is
logically organized using the concepts of “Area”, “Zone”, and “Device Group”. The space covered by
the entire system is the “Area”, while independent sonic spaces within that Area are called “Zone”.

A group of DME or SP2060 units assigned to the same function are considered a “Device Group”.

An Area is comprised of one or more Zones, and each Zone can include up to 32 Device Groups.

A single Device Group can include as many as 16 devices. Each Device Group has one “Group

Master”.

Meter response may deteriorate as the number of meters displayed in a single device group in DME Designer increases. In
such cases meter response can be improved by dividing the device group.
See “Zone Window” (page 298) for details on deleting devices from a device group.

DME and SP2060 units cannot be combined in the same Device Group.

All devices in a Device Group must be on the same subnet.

A single device group cannot be controlled from multiple computers (multiple instances of DME Designer).

4 ) ) )
Area Zonefl Device Group1
( ) e N e N
< . < Device1
Zonel \ Device Group1 \ (Grou
p Master)
. J . J \ J/
4 ) ( ) ( )
Zone2 Device Group2 (Dsei;if :)2
. J/ . J/ \ J
" S " S . v

DME Designer Owner’'s Manual 3



4

The DME Designer Software Application

The DME Designer software application provides a convenient, central interface for the creation and
control of DME-based audio systems.

By connecting the computer on which the DME Designer application is running to a Group Master it
becomes possible to control multiple devices simultaneously.

With DME Designer, DME audio systems can be designed and configured via a comprehensive block-
diagram interface on the computer screen.
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The main concepts used in the creation of DME audio systems are “Components”, “Configurations”,
“Preset Parameters”, and “Scenes”.

B Components

Any independent signal-processing block, such as an equalizer, compressor, input/output module, or
external device control object is a “Component”.

B Configurations
A “Configuration” is group of components, including their placement and interconnections.

B Preset Parameters

The set of parameters for all components in a Configuration is know as the Configuration’s “Preset
Parameters”.
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B Scenes
A Configuration and its Preset Parameters are a “Scene”.

Composition of scene
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DME settings as well as Configuration and Preset Parameter settings are sent from the DME Designer
application running on the computer to the Device Master via USB or Ethernet, allowing each device

to function as a separate processor, independently from the computer. It is also possible to keep the

DME Designer application on line and control the devices in real time.

It is possible to use the DME Designer to create Configurations that include multiple devices when the
appropriate devices are connected.

Although it is possible to have multiple Zones in an Area, multiple Device Groups in a Zone, and
multiple Scenes and Configurations in a Device Group, only one Area, Zone, Device Group and
Configuration can be active and editable via the DME Designer at any one time. The active elements
are known as the Current Zone, Current Device Group, Current Scene, and Current Configuration.
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Data Handled by a DME Audio System

B DME Data Structure

Common Overall Data

Scene Link Settings

Settings required for linked scene operation between multiple
groups.

Data for Each Device Group

User Defined Button Settings

Settings required for component parameter control from the
DMEG4N/DME24N or ICP1 panel.
Up to 24 parameters can be registered for control.

Global Parameter Link Settings

Settings required for linked operation of the same types of
parameters between multiple devices.

Data Used by the Scene Manager

MIDI program Change Settings

Settings required to allow scene selection via MIDI commands.

Scenes

The information required to switch audio data processing
setups.

Scenes include configurations and preset data.

The Scene Manager facilitates registration and management of
scene data.

Up to 999 scenes can be registered, and registered scenes are
managed by their scene numbers.

Data for Each Device

Configurations

A combination of the audio signal processing, audio input/
output, and external device control components and their
interconnections, created to create the desired audio system.

Local Parameter Link
Settings

Settings that allow linked operation between similar types of
internal DME parameters.

Component Link
Settings

Settings that allow linked operation between similar types of
internal DME components.

External Device
Settings

Settings required to allow control of component parameters from
external devices.

Independent settings are required for each device.

The external devices that can be used are as follows:

e MIDI Controller (MIDI Control Change, Parameter Change).

e GPI Controller.

DAW Controller.

AMX;, Crestron, and other remote controllers.

PM5D or other compatible mixing console (controlling DME
internal head amp)

Preset Parameters

The settings for the components in a configuration.

Audio processing setups can be switched by changing the

preset parameters.

Components included in the preset parameter set are as follows:

e GEQ, MatrixMixer, and other audio signal processing
components.

e Internal AD/DA (DME24N), Cascade (DME64N), and Mini-YGDAI
card /O components*.

e Components for external devices such as the AD8HR and AD824
remote head amplifiers.

Wave file

Audio files to be played back by the Wav File Player.

File Storage

Project files and other file types can be stored.

* Some settings not included.
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B SP2060 Data Structure

Common Overall Data

Scene Link Settings

Settings required for linked scene operation between multiple devices.

Data for Each Device

Scenes

The information required to switch audio data processing setups.
Scenes include configurations and preset data, The last Library name
recalled is specified.

The Scene Manager facilitates registration and management of scene
data.

Up to 99 scenes can be registered for 12 preset areas and 87 user
areas, and registered scenes are managed by their scene numbers.

Configurations

A combination of the audio signal processing, audio input/output, and
external device control components and their interconnections, created
to create the desired audio system.

Local Parameter Link
Settings

Settings that allow linked operation between similar types of internal
SP2060 parameters.

Preset Parameters

The settings for the components in a configuration.

Audio processing setups can be switched by changing the preset
parameters.

Preset parameters can be recalled by SP2060 units, but not edited.

Data for Each Component

Library

Settings specific to the speakers to be used.
In addition to the preset data provided, settings can be created by the
DME Designer.
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Il One DME unit/Device Group

Microphone Input
Mixer
External Head Amp

etc...

————

External Device (MIDI, GPI, DAW, AMX/Crestron, controlling DME internal head amp)
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Scene Manager

Preset Parameters

Scene Name | Configuration

o0a | Banaset 1|

LCD Display | Assigned Parameter
Dome Low | Crossover: Output Low: Level
Dome Mid | Crossover: Output Mid: Level
Dome Hi Crossover: Output High: Level
(No Assign)
(No Assign)
(No Assign)

Specifies the parameter to be changed.

Specifies the configuration
and preset parameters combination.

e N
Configuration Preset parameters for output processor
Set the value
Local parameter link settings
External device settings
\_ J

M Two DME units/Device Group (When one DME unit doesn't provide sufficient processing power, up to 16 DME units can be used)

External Device (MIDI, GPI, DAW, AMX/Crestron, controlling DME internal head amp)
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LCD Display | Assigned Parameter No. | Scene Name | Configuration Preset parameters Configuration Preset parameters

Dome Low | #1: Crossover: Output Low: Level

Dome Mid | #1: Crossover: Output Mid: Level

.| Dome Hi #1: Crossover: Output High: Level m

Hall Low #2: Crpssover: Output Low: Level
—p-| | Hall Mid #2: Crpssover: Output Mid: Level

Hall Hi #2: Crpssover: Output High: Level

Selects the parameter to be
edited from two DME units.

] Specifies the configuration and preset

data combination in each DME

-
DME#1
Configuration

Local parameter link settings

External device settings

Preset parameters

A4 N
DME#2
Configuration

Preset parameters

All On

BGM & MC

Local parameter link settings

External device settings
VRN J

DME Designer Owner

Specifies the parameter to be linked between DME units.
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Separate SP2060 units normally handle scenes independently, but the Scene Link function can be set from the DME
Designer to allow linked scene operation. See “Scene Link Manager” on page 151.
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Main Changes from V1.0 to V1.1

H Main Panel Window

¢ Instead of the former Parameter Link function, there are now two functions: a Global Link function
that links parameters within all DMEs in a zone and a Local Link function that links parameters
within a single DME unit. (page 94)

¢ The Synchronization function can now not only send data from DME Designer to the DME unit,
but can also synchronize by reading data from the DME unit. (page 97)

¢ Scene Increment/Decrement and Time Adjustment can now be assigned in the GPI input
function. (page 114)

e DME unit events can now be recorded by the Event Logger function and displayed in the Event
Logger window. (page 177)

e The time for executing an event can now be set by using the Event Scheduler function.
(page 139)

e Parameters in the current configuration can now be listed on the display and printed out by using
the Parameter List function. (page 144)

e The Wav File Manager can manage Wave files played by the Wav File Player. (page 151)

e Settings can be made by the DAW Control function that are used for controlling DMEs from a
DAW controller. (page 157)

¢ DME unit data can now be saved as a backup file by using the Backup function. (page 157)

Designer Window

® The port name display can now be switched between long name display and short name display.
(page 206)

¢ DMEBG4N cascade connections can now be set. (page 221)

e Priority items can now be set when compiling configurations by using the [Compile Priority]
function in the “Preferences” dialog box. (page 220)

¢ Delay time can now be displayed for each component by using the Show Signal Delay function.
(page 305)

¢ Monitoring points can now be edited by using the “Monitoring Point List” dialog box. (page 306)

¢ The status of connections in a configuration can now be analyzed in advance by using the
Analyze function, without connecting the DME unit. (page 308)

® You can now set the action that occurs when you double-click a user module object. You can also
turn user module security ON or OFF, and set a password. (page 246)

e Libraries with component parameters saved in them can now be recalled from the context menu
for a component object. (page 236)

¢ A new rule for wiring prohibits connections to terminals that would short the terminator.

B Component Editor/Component

¢ A status bar has been added to the component editor. It displays the component name,
component ID, and parameter IDs for parameters that are being edited. (page 320)

¢ A Snap function has been added that records parameters in the editor temporarily. Parameter
sets can then be switched by using the Snap buttons. (page 362)

e The meter’s peak hold function can now be turned ON or OFF. (page 359)
e A Wav File Player component has been added for playing Wave files. (page 430)

¢ An effect component called SPX has been added that supports many different effect
applications, such as reverb, delay, and modulation effects, along with complex combinations of
multiple effects. (page 471)

¢ A Slot Out component editor has been added. (page 488)

¢ An Undo/Redo function is now available when using the design mode. It can undo the most
recent operation (control movement/resize/deletion).

DME Designer Owner’s Manual



Changes from V1.1 to V1.2

B Main Panel Window
® The synchronization algorithm has been refined for faster synchronization.

e Synchronization now can be executed from DME to DME Designer without any break in the
sound.

¢ |n the following cases, synchronization can be executed from DME Designer to DME without any
break in the sound:

The second or later synchronization after starting DME Designer* and when differences in data
between the DME and DME Designer are limited to parameters within components, AD824/
AD8HR/DME24N AD/DA setting data, or Mini-YGDAI card setting parameters.

* If the file was saved when DME Designer was closed, there will be no break in sound even in the first
synchronization after saving.

e Compile speed has been increased.
Up to three times faster when AutoDelayCompensation is turned On.
Up to two times faster when AutoDelayCompensation is turned Off.

e Synchronization is possible when no Mini-YGDAI card or a different Mini-YGDAI card is installed
in the DME unit (a confirmation message will appear).

e An option to automatically close the dialog after synchronization has been added. (page 99)
e A progress bar has been added to the Synchronization dialog. (page 51)
* A message appears to warn when synchronization will cause muting.
¢ The following operations can be performed while on line:
- Scene storage.
- Scene name changes.
- Fade ON/OFF and Fade Mode changes.
- Fade time changes.
- Parameter link setting changes.
* When a scene store is executed, that scene becomes the current scene.
¢ Wave files can be saved as DME data files, and are included in import/export operations.
(page 44)
e Wave files can be saved in the Wav file library.
e Event Log events can be output via GPI. (page 79)
* The on-line indicator appears as a button which can be used to switch between on-line and
off-line. (page 59)
e Scene edits cause the EDIT indicator to appear. (page 57)
¢ An auto file save function (Auto Save, post synchronization) has been added. (page 73)
¢ Different zones can be specified for use by different users. (page 158)

e Scene parameters related to User Defined Button, Program Change, GPI In and GPI Out can be
set via the Scene Manager. (page 82)

¢ [Select All] and [Clear All] buttons have been added to the Scene Manager Recall Safe dialog
box. (page 86)

e User Control can be created for individual users as well as security levels. (page 91)

¢ A Remote Control Setup List has been added. (page 139)

This list can be used to make detailed settings for a new software protocol that allow the DME to
be controlled from AMX, Crestron, and similar devices.

Refer to the “DME-N Remote Control Protocol Specifications” document for details about the
communication protocol. Information about the “DME-N Remote Control Protocol Specifications”
document can be found at the Yamaha pro Audio website (URL below).

http://www.yamahaproaudio.com/

e |t is possible to specify whether listed events will be executed by the Event Scheduler.
(page 139)
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¢ The order of same-time events can be changed in the Event Scheduler. (page 139)
¢ Exceptions can be specified for Event Scheduler execution day/time. (page 107)
e Event Scheduler execution times can be specified in 1-second increments. (page 106)

¢ Head amp gain and Mini-YGDAI Card can be set via GPI, MIDI, User defined Button, DAW
Control.

e Parameter values, scene recall, GPI output, Wave file playback, and head amp gain can be set
via the User Defined Buttons. (page 132)

e The Component Lock function dialog is separate from the Parameter List dialog. (page 150)
e Shortcuts can be freely set as required. (page 156)

e Files can be saved in the DME unit. (page 70)

¢ A [Close All Editor Windows] button has been added to the Window menu. (page 69)

¢ External head amp parameters will be recognized by the DME unit when either the DME or the
external head amp (AD824, AD8HR) are turned on. Execute a scene recall to send DME settings
an external head amp.

¢ This manual is now separate from the DME Designer installer, and can not be accessed from the
DME Designer menus.

Designer Window
¢ The following operations can be carried out via the shortcut keys.
- Navigator
- Activate Navigator
- Activate Toolkit
- Activate Design Window
- Select Left Port and Start Wiring
- Select Right Port and Start Wiring
- Wire Auto Single to Right
- Wire Auto Multi to Right
- Wire Auto Single to Left
- Wire Auto Multi to Left
- Delete Wire

e |t is now possible to simultaneously edit multiple objects of the same type.
Example: Change the thickness or color of multiple wires at once.

¢ Files related to user modules (user module files, library files, user module editor files) can be
combined and exported/imported as a single file.

e Port colors can be independently specified for each port type. (page 219)

¢ Default wire thicknesses and types can be independently specified for each port type.
e An automatic hot-spot connection function has been added. (page 285)

¢ Port display has been added to External Device, Picture, DME, and ICP1 objects.

¢ When drawing wires the keyboard cursor keys can be used to move the mouse cursor, and the
<Enter> key can be used to create nodes.

e When drawing wires <Shift> key plus <—> key and <Shift> key plus <<«-> key combinations can
be used to automatically connect horizontally-aligned hot spots.

¢ DME object ports can be freely specified.

e Compilation of configurations with loop connections is possible when Auto Delay Compensation
is On.

e The name has been changed from “Foot Monitor” external device to “Floor Monitor.”

¢ Addition External Device types have been provided.

e External Devices can be double-clicked to open a file saved by other applications. (page 233)
e Picture objects can be double-clicked to open a specified editor. (page 249)

¢ Text objects can be double-clicked to open a specified editor. (page 252)
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e User module port labels can be edited. (page 246)
e Graphics can be placed to represent user modules. (page 247)

¢ The Legend field automatically resizes to accommodate project names and titles of different
lengths.

¢ A Generic “MY-Others” setting has been provided to accommodate third-party Mini-YGDAI
cards.

B Component Editor Window
¢ Undo and Redo are now shortcut compatible.
¢ A scroll bar appears when the size of the component editor window is reduced.
¢ The size and position of the component editor window are memorized.
¢ An option to allow mouse-over zooming of the edit box has been added. (page 323)

¢ A [Back] button that allows switching between related parent and child windows has been
added. (page 320)

¢ A [Close All Editor Windows] button has been added to the contextual menu.

e Source Selector, Speaker Processor, Limiter, Slot In, Cascade In, and Cascade Out components
have been added.

¢ The Delay algorithm has been revised. (page 399)
- LEVEL and MUTE are effective when Delay is Off for each channel.
- The name of the overall Delay [On] parameter has been changed to [All Bypass].

Input  Input Input Input
Mute Level On Mute Level Mgte Level On Mute Level
IN oo—) Dela o o Delay On IN p—e—oce¢o—) Delay o ° Delay All Bypass
y o—oto o °
1—0 ° ouT ° ouT

¢ The bus send level range for Delay, Matrix, and Matrix Mixer components has been changed to
-oco through 0.0 dB.

e Snap copy is possible. (page 363)

e Snap can be retained until the application is quit or another file is opened.
e Security status is displayed in the user module editor status bar.

e Multiple controllers can be selected by clicking while holding the <Ctrl> key when the editor is in
the design mode. (page 337)

¢ [Picture], [Text], [Box], [Ellipse], and [Frame] have been added to the tool palette of the user
module editor and user control editor design mode. (page 325)

e Controller properties can be accessed by double-clicking controllers in the user module editor or
user control editor design mode. (page 344)

¢ Picture and Text objects can be clicked to open a specified editor in the user module editor or
user control editor.

¢ The User Module Editor and User Control Editor offer a greater range of customization options for
color, size. etc., of the placed controls.

® MIDI Setup

¢ A MIDI Setup minimize function has been added.

H V1.2 Precautions

¢ When using project files (*.daf) created by version 1.1.5 or earlier, synchronize from the DME
Designer to the DME unit for the first synchronization.

¢ Project files (*.daf) created using version 1.2 will not open properly on version 1.1.
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Changes from V1.2 to V2.0

B General

e Support added for DMES8i-C/DME8o-C/DME4io-C, SP2060 units and MY 16-ClI.

¢ “Device Groups”, or groups of the same type of device, have been added at the lowest Zone
level.

¢ |t is now possible to have one master device per device group rather than one master device per
zone. This means that it is possible to have multiple master devices in a single zone.

e Group masters can now be assigned regardless of the IP address. This makes it possible to have
multiple device groups at a single network address.

e Configurations can be created and deleted for each device group.

® Component

¢ A Feedback Suppressor component has been added. (page 419)
* The Speaker Processor component PEQ “Q” parameter now goes to “63”. (page 464)

Main Panel Window
¢ Firmware and component data can now be updated simultaneously. (page 186)

¢ A Recovery Update function that allows recovery from program corruption has been added.
(page 188)

e A Component Link function that allows simultaneous linking of all component parameters has
been added. (page 94)

e Scene Link function that allows simultaneous control of multiple devices in different device
groups has been added. (page 151)

¢ A Protect function has been added to the scene manager. (page 82)

e Card settings are no longer included in scene data.

e A Utility window has been added to allow editing of device utility settings. (page 167)

e The Local Parameter Link display order has been changed. (page 94)

e Parameter Link operation can now be turned on or off for each device group. (page 94)
e Compilation and analysis is now possible even if no connections have been made.

¢ Navigator window hide/show can now be selected from the main window.

¢ The Event Logger can now display only the event data for a specified device. (page 75)
¢ The GPI terminal names have been changed from [CH] to [PORT].

Designer Window

¢ A hand tool for window movement has been added. The hand tool can be selected via the hand/
arrow icon in the toolbar, or from the [Tools] menu. The hand tool can also be temporarily
selected by holding the spacebar on your keyboard.

¢ Window magnification and reduction can now be controlled via the mouse wheel while holding
the keyboard “Ctrl” key.

e Horizontal scrolling can be controlled via the mouse wheel while holding the keyboard “Shift” key.
¢ The Edit Mode on/off can now be changed from the tool bar. (page 192)

e Scene information now appears in DME objects, and the Scene Manager can be launched from
the scene information display. (page 82)

¢ An [On-line] button has been added to DME objects, and synchronization is now possible.
(page 59)

e Sampling frequency display has been added to the resource meter window. (page 196)
e Sampling frequency display has been added to the configuration window status bar. (page 301)
e The sampling frequency is now displayed during analysis.
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¢ Double-clicking the component name now opens the properties window.
¢ Organization of the Tool Kit window has been changed. (page 198)

¢ A [Draw Image] checkbox that displays or hides the worksheet background image file has been
added to the Sheet properties. (page 263)

¢ [Configuration Manager] has been added to the contextual menu that appears when a DME or
SP2060 object is right-clicked. (page 217,page 226)

¢ [Recall Component Library] and [Store Component Library] now appear in the contextual menu
that appears when a component is right-clicked, even when the Edit Mode is OFF.

¢ The Compile Settings can now be edited for each DME unit. (page 220)
* Only one Zone window is now provided for multiple configurations.

¢ The [Export DXF] and [Preferences] commands have been moved from the [Print] menu to the
[Tools] menu.

¢ [Configuration] has been changed to [Configuration Manager] in the [Tools] menu.

¢ When [Prohibit Diagonal Connections] in the [Tools] menu is active it is possible to select 2
diagonal points and those points will automatically be connected by a combination of horizontal
and vertical wires.

Component Editor Window

¢ A [Level Meter Enable] command that displays or hides the meter values has been added to the
contextual menu. Hiding the meters can result in increased communication speed in some
cases. (page 360)

¢ A [Display Order] function that allows the order of the controllers to be changed as required has
been added to the User Control Editor and User Module Editor. (page 325)

¢ An [Add Component to Component Link] command has been added to the controller contextual
menu.(page 360)

¢ The registered group is now displayed in the [Add Parameter to Parameter Link] submenu of the
contextual menu of controllers registered for Parameter Link operation.(page 368)

¢ Increased speed when selecting and dragging a large number of controllers in the User Control
Editor and User Module Editor

e |t is now possible to switch from the Navigator window to Zone display while online.

V2.0 Precautions

Please use DME Designer V2.0 with DMEG4N/24N V2.0 or later, DMES8i-C/DME8o-C/DME4io-C V2.0
or later, and SP2060 V1.1 or later.

See the Yamaha Pro Audio website for compatibility details (http://www.yamahaproaudio.com/).
When DMEG64N/24N and DMES8i-C/DME8o-C/DME4io-C are used together in the same device
group, faster communication speed as well as smoother DME Designer meter display can be
obtained by assigning a DMES8i-C/DME8o-C/DME4io-C unit as the device group master.
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Changes from V2.0 to V3.0

B General

¢ DMES8i-ES/DME80-ES/DME4io-ES support.

® The DME Designer and DME-N Network Driver installers have been combined, so the
appropriate DME-N Network Driver version is now installed automatically with the DME Designer
application.

¢ The following connections to the Slave DME units are now possible when a DME Satellite unit is
assigned as the Device Group Master:

- USB/Ethernet connection to the computer (DME Designer).
- Cascade connection to control from the PM5D console (DMEBG4N only).

Component

¢ Ambient Noise Compensator component added (page 379).
¢ Audio Detector component added (page 381).

¢ Auto Gain Control component added (page 382).

e Auto Mixer Il component added (page 431).

e Simple Mixer component added (page 450).

¢ Room Combiner component added (page 460).

e Matrix Mixer and Router component variations added.

Main Panel Window

¢ To allow project information to be easily reproduced on a different computer, it is now possible to
export and import all necessary files at once, rather than only project files with the “.daf”
extension (page 45).

¢ A Device Information window that lists the status of all devices has been added (page 190).

¢ |t is now possible to individually set each user control to determine whether it will open
automatically when the project file is opened (page 91).

¢ |In accordance with the above change, the Startup User Control item has been removed from the
Security dialog box.

e [t is now possible to assign Direct Parameter Value to the GPI input function, and assign Direct
Parameter Value and Audio Detector to the GPI output function (page 112, page 122).

¢ An option that automatically saves the project file (.daf extension) in the DME unit when going
online has been added (page 98).

¢ |t is now possible to control internal DME-24N/DMES8i-C/DME4io-C/DMES8I-ES/DME4io-ES head
amps from a PM5D or other compatible mixing console (page 141).

¢ Remote control from AMX, Crestron, and similar controllers is now possible via Ethernet
connection only for DME Satellite units. (page 171).

¢ The display format of the parameter values displayed in the Remote Control Setup List and
Parameter List dialog box can now be switched between the internal settings and the values
displayed in the editor windows (page 139, page 147).

® The Event Logger window can now display additional error messages shown on the DME display
panel (page 80).

¢ |t is now possible to set the DME unit so that the internally stored event log is not erased
(page 77).

¢ Improvements have been made to the additional error message information shown in the Event
Logger window.

¢ The DME unit internal clock and DME Designer time display now support daylight saving time
(DST) (page 180).

e Firmware updates can now be applied to entire device groups, for improved speed and
efficiency.
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B Designer Window

¢ |t is now possible to set a “clear” background color for text, box, and ellipse objects (page 252,
page 254, page 256).

e Password entry is now required when opening a User Module Properties dialog box or saving/
exporting in a user module to which security has been applied.

¢ | inked software applications can now be launched from the Slot component contextual menu
(page 240).

e User module templates that use the same library are now categorized and displayed as user
module groups (page 310).

¢ Image files are now included in User Module exports.

e Component and parameter links can now be copied when DME objects, components, and user
modules are copied/pasted or duplicated.

e Parameter links are now saved when User Module data is saved/exported.

¢ \When already-placed picture files are replaced, they will be updated and displayed correctly
without the need to restart the DME Designer application.

B Component Editor Window

¢ [Line] and [Scene Recall] tools have been added to the User Module Editor and User Control
Editor design modes, allowing placement of lines and scene recall buttons (page 332).

¢ In the User Module Editor and User Control Editor it is now possible to convert placed sliders to
knobs, and vice-versa (page 343).

¢ More options are available for customizing the controls listed below in the User Module Editor
and User Control Editor:
- A property dialog box has been added for sliders, allowing customization of direction, scale,
color, size, and other parameters (page 345).
- Level meter size can be customized (page 347).
- A property dialog box has been added for slider level meters, allowing customization of
direction and size (page 348).
- Knob color and knob background color can be customized (page 344).
- Text background color can be customized (page 352).
- A property dialog box has been added for indicators, allowing customization of color and size
(page 348).

H V3.0 Precautions

Use DME Designer V3.0 only with DME64N/24N V3.0 or later, DME Satellite V3.0 or later, and/or
SP2060 V1.2 or later. Refer to the Yamaha Pro Audio website (http://www.yamahaproaudio.com/)
details on combinations.

When combining DMEG64N/24N and DME Satellite units in a device group, be sure to assign a DME
Satellite unit as the device group master. Synchronization cannot be performed if a DME6G4N/24N is
assigned as the device group master.

When using the Windows Vista operating system, use only USB-MIDI Driver V3.0 or later, and DME-
N Network Driver V1.2 or later.
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Changes from V3.0 to V3.5

B Component

e Program Ducker component added (page 412).

¢ (V3.5.1) During installation it is possible to select and install speaker library data for third-part
speakers into the Speaker Processor component library.

Main Panel Window

e MIDI Setup has been discontinued. Communication ports can now be directly selected via the
[Setup] menu [Communication Port] item. (page 155)

¢ (V3.5.1) [SP2060 Backup] has been added to the main panel window [Hardware] menu, allowing
internal SP2060 data to be transferred to a computer for backup. Multiple SP2060 units can be
restored from the backup data. (page 184)

Designer Window

¢ Improvements in the compiler algorithm achieve greater DSP resource utilization efficiency.
(page 98, page 305, page 308)

e MY16-ES64, MY16-EX, and MY16-MD64 |/O cards can now be specified for slot installation.

e The TX6n/TX5n/TX4n, ACD1, SB168-ES, IMX644, IPA8200, and NEXO products can now be
specified as external devices. V3.5.1 adds the IM8, MSR250, and other devices.

¢ When cascade connecting DMEG4N units across device groups, unit numbers are automatically
assigned when a connection is made between the [CAS IN] and [CAS OUT] terminals in the
Zone window.

Others (Firmware V3.09 changes)

¢ When controlling DME units remotely from a PM5D using the DME Control function, it is now
possible to set an ID number other than “2” for the group master DME unit. In this case the PM5D
firmware must be updated to V2.20 or later.

¢ |t is now possible to replace the default DMEG4N/24N startup screen (normally the model name)
with an original graphic file. (page 71)

V3.5 Precautions

Use DME Designer version V3.5 with DME64N/24N or DME Satellite units running firmware version
between V3.0 and V3.8, and SP2060 units running firmware version V1.2 or later. Refer to the
Yamaha Pro Audio website (http://www.yamahaproaudio.com/) details on combinations.

When combining DMEG64N/24N and DME Satellite units in a device group, be sure to assign a DME
Satellite unit as the device group master. Synchronization cannot be performed if a DME6G4N/24N is
assigned as the device group master.

When using the Windows Vista operating system, use only USB-MIDI Driver V3.0 or later, and DME-
N Network Driver V1.2 or later.

When using the Windows 7 operating system, use only USB-MIDI Driver V3.0.4 or later, and DME-N
Network Driver V1.2.1 or later.
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Changes from V3.5 to V3.8

B New Features

e The DMEG4N/24N (V3.8x or later) can now be controlled via Ethernet connection from certain
external control devices.

e The DMEG64N/24N (V3.8x or later) can now be assigned as the device group master when the
device group is formed by combining the DME64N/24N (V3.8x or later) and the DME Satellite.

¢ A new [Show Unconnected Node] button which displays unconnected nodes has been added
into the Designer window toolbar.

¢ The window sizes of User Control Editor/User Module Editor can now be enlarged more than the
display resolution of computers. When a size is set that is larger than the display resolution of
computers in the “User Control Editor Settings” dialog box which can be selected in the context
menu, a scroll bar is displayed.

¢ New library data has been added into the Preset Library of the Speaker Processor.

¢ The following devices can now be set for the external devices: M7CL-48ES, DSR series, S5, NS-
AW series, NS-IC series, KMS-710, CD-S300RK, CD-C600RK, Gooseneck Microphone and
Boundary Microphone.

B Changes

¢ The layout of the Remote functions and MIDI functions have been changed through revisions of
the operation of the Utility dialog.

B Fixed Bugs
¢ Fixed problems in which the Remote Control settings were not applied to the DME Designer
appropriately when synchronizing.
¢ Fixed a problem in which the meter laid out in User Control might not move.

¢ Fixed a problem in which the window might not be displayed when the external display status
was changed.

¢ Fixed a problem in which the parameters of both Recall Safe and Global Link, might not be
displayed appropriately when Scene Recall was executed.

H V3.8 Precautions

¢ Use DME Designer version V3.8.0 with DME64N/24N or DME Satellite units running firmware
version V3.0 or later, and SP2060 units running firmware version V1.2 or later.

¢ Use the latest DME Designer to update the DME firmware to the latest version.

¢ DME Designer cannot be used to update firmware version 3.5 or earlier to version 3.8 or later, or
to downgrade from version 3.8 or later to version 3.5 or earlier (this does not apply to the SP2060
or ICP1). Contact your Yamaha dealer.

e Save an up-to-date DME project file (*.daf). Don’'t update unless an up-to-date “.daf” file has
already been saved on your computer. Without the “daf” file, you will not be able to restore DME
operation.

¢ When DMEG64N/24N units running firmware version 3.5 or earlier and DME64N/24N or DME
Satellite units running firmware versions 3.8 or later are combined in the same device group,
DMEB4N/24N units running firmware version 3.5 or earlier cannot be designated as the group
master.

¢ |f the Program Ducker component is used, both DME firmware and DME Designer versions must
be V3.5 or later.
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Changes from V3.8 to V4.0

B New Features

e The MY4-AEC card can now be selected for I/O card slots. AEC components, which are available
when the card is installed, have been added.

¢ The “Partial Recall” function has been added. Scenes can now be recalled on a per component
basis. By utilizing both Recall Safe and the new Partial Recall functions, components to be
recalled or not recalled can now be selected precisely.

¢ Configurations can now be duplicated in the “Configuration Manager” window.

¢ In the Main Panel window, configuration names are now displayed, and configurations may be
selected.

® The V5S4, VS6, and NS-IC600 can now be specified as external devices.

Changes
* The Remote V3.5 tab and the MIDI V3.5 tab in the “Utility” dialog box have been deleted.

¢ The [Cancel] button has been added in the “Project File has been modified. Save?” dialog box
which is displayed before closing DME Designer to cancel closing procedure.

Fixed Bugs

¢ Fixed a problem in which SP2060 configurations could be edited when the “Configuration
Manager” dialog box was opened via [Tools] menu [Configuration Manager] item.

¢ Fixed a problem in which configurations could be edited while online when the “Configuration
Manager” dialog box was opened via the context menu displayed by right clicking a DME object
in the Designer window.

¢ Fixed a problem in which the compiling procedure would occasionally complete successfully
even though an error should occur when an IN port was connected to multiple OUT ports.

¢ Fixed a problem in which the compiling procedure would occasionally not complete when
compiling was executed on a complex configuration with multiple SPX components.

¢ Fixed a problem in which the compiling procedure would occasionally not complete when
compiling was executed on a complex configuration having an SPX component with an output
connected to any other component.

¢ Fixed a problem in which the [+48V Master] indicator didn't light in the AD8HR component editor.

¢ Fixed a problem in which DME Designer could occasionally freeze when closing the application
by means other than clicking [Exit] in the [File] menu of the Main Panel window.

¢ Fixed a problem in which parameter links remained functional for parameters of different types
which should not be linked after the effect type was changed for an SPX component having
linked parameters.

¢ Fixed problems in which Scene Store and Recall functions might not work when Parameter Link
settings were no longer appropriate due to editing the Configuration.

V4.0 Precautions

¢ Use DME Designer V4.0 with DME64N/24N or DME Satellite units running firmware V4.0 or later,
and SP2060 units running firmware V1.2 or later.

¢ Use the latest DME Designer to update the DME firmware to the latest version.

¢ DME Designer V4.0 cannot be used to update firmware V3.5 or earlier to V4.0 or later, or to
downgrade from V4.0 or later to V3.5 or earlier (this does not apply to the SP2060 or ICP1).
Contact your Yamaha dealer.

e The DME firmware V3.8 can be updated to V4.0 using DME Designer V4.0.
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Chapter 1 Before Using

Installing DME Designer

To use DME Designer, you must first install the software on the computer. Before you can connect the
DME Designer software to the DME or SP2060 unit, you must first install the USB MIDI Driver or the
DME-N Network Driver, according to how you will be connecting, and then make the appropriate
settings.

For instructions about the installation and setup for the DME Designer and DME-N Network Driver, and
about the installation for the USB-MIDI Driver, see the “DME Setup Manual.”

Initial settings for DME Satellite units must be transferred via USB-MIDI, so it is necessary to properly install the USB-MIDI
Driver.

Starting DME Designer

The DME Designer software is started from the [Start] menu. DME Designer is used with one user
logged on. The user logs on when the software is started.

B DME Designer Start Up and Logon (When Auto-Logon Is Not Set)

1 Click [Start] = [All Programs] = [YAMAHA OPT Tools] = [DME Designer] = [DME
Designer].
The “Log On” dialog box will be displayed.

Uzer | Adminiztrator j

Pagzzmord |

Enit

Automatic log-on is the default setting. If the automatic logon feature is enabled, the “Log On” dialog box will not be
displayed when the application is started. Instead, the auto-logon user will be logged on automatically. See page 31
for information about auto-logon.
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Chapter 1 Before Using

2 Click the [¥] at the right of the [User] box, and select the user.
If no user has been created, only [Administrator] will appear in the list. When starting DME
Designer for the first time after installing, select [Administrator].

3 Enter the password into the [Password] box.

Enter the password set for the user.
If no password has been set, leave the password box blank when you log on.

4 Ciick the [OK] button.
DME Designer starts up.

B When Automatic Logon Has Been Set (page 31)

If automatic logon has been set, the “Log On” dialog box will not be displayed. The user set for
automatic logon will be logged on.

With automatic log on, even if a password is set for a user, it will not be requested during log on.
This is useful when logging on a specific user.

B Starting by Opening a Project File
DME Designer starts when a project file with a saved configuration is opened. When the project file
is opened, DME Designer is started with the window configuration that was in place when the file
was last saved.
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Chapter 1 Before Using

Closing DME Designer

To close DME Designer, click [Exit] on the [File] menu of the Main Panel window. It can also be closed
by clicking the [Close] button on the Main Panel window.

1 click [Exit] on the Main Panel window [File] menu.
When you try to close DME Designer, “Project File has been modified. Save?” will be displayed in a
dialog box.

Sometimes the “Project File has been modified. Save?” dialog box will not be displayed.

= DME Designer

\i{) Project file has been modified.

Save?

2 To save the file, click [Yes]. To close without saving, click [No]. To cancel the
operation, click [Cancel].
If you click [Yes], the File Save dialog box will be displayed.
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Chapter 2 DME Designer Overview

Names and Functions of the Windows

The DME Designer software has several windows, including the Main Panel window, Designer window,
Component Editor window, Resource Meter window, and others.

Main Panel Window Component Editor Window

T OME Desiener 1 | -+ Gompresser

=) EAindint Haich Congarsston
= Evfudio Detector

2 B fan Conrel

= I

= EnCrose Procssor

¥ Erossaver Processer I

Designer Window Resource Meter Window

Main Panel Window

Menus and buttons are available in the Main Panel window. The current DME Designer environment,
including the active zone, device group and scene the currently logged on user name, and the
connection status to the DME unit are displayed on the right side of the Main Panel window.
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Chapter 2 DME Designer Overview

Designer Window

The Designer window displays several different windows. First among them is the Area window, where
you can manage the entire system. The Area window includes one or more Zone windows, which in
turn include one or more DME or SP2060 units that are used to build a zones within the area. Next is
the Configuration window, where you create the internal configuration of each DME or SP2060 unit.
Within the Configuration window are the User Module windows, where you can assemble often-used
components into templates the Toolkit window, which displays objects used in the other windows as
the basic building blocks for sound designs; and the Navigator window, which lets you grasp the
overall status of the system at a glance.

Zone Window Configuration Window Navigator Window

o L
= B!
o
I Conteationd
ACMLR

Toolkit Window

B Area Window

The Area window is used for designing areas, which manage the entire system. While at least one
zone is included within an area, multiple zones can be arranged there.

Zones
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Chapter 2 DME Designer Overview

B Zone Window
The Zone window is used to design zones within the area. A zone is a more concrete blueprint that
includes at least one DME or SP2060. It shows the DME’s connections with other devices and the
wiring between them. You can create multiple zones.
The DME and SP2060 units and connected devices are arranged in each Zone window, creating
configurations.

Configurations ——

B Configuration Window
The Configuration window is used to design the internal configuration of each DME unit contained
in the Zone window. By arranging and connecting components in the Configuration window, you
can create things like complex processors or matrix mixers, that determine the actual internal
structure that operates each DME unit.

Components

B User Module Window

The User Module window is used for designing user modules that can be arranged in the
Configuration window. You can create original modules by combining multiple examples of often-
used components. When you save these modules as templates you can recall them easily
whenever you want.

| Ursaved User Madule(Zone1)
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Chapter 2 DME Designer Overview

B Toolkit Window

The Toolkit window displays the objects that you can use in each window that can be displayed in
the Designer window. Those windows are the Area, Zone, Configuration, and User Module
windows. The Toolkit displays different objects, according to the currently active window. To place
an object in a window, double-click it in the Toolkit window where it is displayed or drag it to the
currently active window.

® Navigator Window

The Navigator window displays the area, zones, configurations, and components in a hierarchal
fashion that lets you check their status as a whole. When editing offline, you can click an area
name, zone name, or configuration name to make that window active. Clicking a component name
will open the component editor window for that component.

B Resource Meter Window

This window provides an indication of component usage for each DME unit currently placed in the
Configuration window. The usage percentage increases as the number of components increases. The
component usage percentage is shown in graph form for each DME unit.

The window appears simultaneously with the designer window, and can be used as a component
usage guide while creating configurations. The sampling frequency for each DME unit is also
displayed. Please note that the sampling frequency of the DME unit itself will also affect the usage
percentage.

In configurations that have a large number of connections, compilation might not be possible in some cases even if the
resource meter reading is less than 100%. To determine whether compilation is possible we recommend using the “Analyze”
dialog box (page 308) prior to actual compilation.

This window is not displayed for SP2060 units.

™ ResourceMe... El
FS : 48 0kHz

B Objects and Components

“Object” is the name for the parts that are arranged in the various design windows, such as the
Area, Zone, Configuration, and User Module windows. Objects are always laid out in the Toolkit
window. Only the appropriate objects for each window are displayed. The blocks displayed at the
higher level of the Toolkit window in particular are called “components.” This refers to each type of
processor that operates the DME. “Object” normally refers to Picture, Text, Ellipse and other items
that are used after connecting them by wire to the various components.
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Chapter 2 DME Designer Overview

Component Editor

The blocks that are arranged in the configuration window are called “components.” When you
double-click on a component block arranged in the Configuration window, the Component Editor
window will open. There you can edit the parameters for that component. The types of parameters
displayed will differ, depending on the component.

i iDMEG4N(Zane1)

Component Editor
(Stereo Compressor)

Component

Window Operations

Operations in all windows are the same as for normal Windows applications. The windows are
controlled with the [Minimize], [Maximize/Restore], and [Close] buttons at the upper right of the title
bar. DME Designer is closed by clicking the [Close] button on the Main Panel window.
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Users and Security

You can create multiple users in DME Designer and set the functions that are available to each user.
Although users who will design and put together installations must be able to use all the functions of
DME Designer, users who will only operate the system can be restricted to functions that will not allow
them to accidentally change the settings.

DME Designer is used with one user at a time logged on. To change the user, click the [File] menu -
[Log Off] command on the Main Panel window.

About Users

To use DME Designer, you must logon when you start the software. Except for the first time the
software is started or when separate settings are made for the first time, you can logon by specifying
the name and password for a user that has been set as the administrator. The administrator can build
the system as a whole, or apply function limitations that let other people edit. Administrators or other
people that can use DME Designer are called “users.” The user name for the currently logged on user
appears below [User] on the Main Panel window.

2 DME Desiener :

i P r_% Fry (i; Hil :Eﬁ Zone Device Group

Configuration

Mute | Rx Tx On-line

Currently Logged On User Name

The default user, named [Administrator], is set to use all of the functions. Immediately after DME
Designer is installed, [Administrator] is the only user, and there is no password set.

Multiple users can be created. When the system administrator creates multiple users, restrictions can
be applied separately for each one of them. A user with restrictions applied can edit using only the
functions the administrator enables for him.

The place to create, setup, and delete users is the “Security” dialog box. See “Scene Manager” on
page 157.

Automatic Logging On

With the auto-logon function, you can have a specified user automatically logged on when the
application is started. If you enable the auto-logon feature, the specified user will be logged on when
the application is started, without displaying the “Log On” dialog box.

Auto-logon is set from the “Security” dialog box. See “Scene Manager” on page 157.
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Logging On

The “Log On” dialog box is displayed whenever the application is started or a user is logged off.
Whenever one user is already logged on, another user cannot be logged on. To log on as another
user, first log off the currently logged on user.

Unless you specifically want to restrict access, we recommend enabling automatic logon. If the access password is
forgotten or lost it will not be possible to logon or operate the system.

If the automatic logon feature is enabled, the “Log On” dialog box will not be displayed when the application is started.
Instead, the auto-logon user will be logged on automatically.

B The “Log On” dialog box

o— -[U 81 | Administrator ﬂ] Uzer | Administrator j

e— -[F'asswnrd | ] Paszward |

e_

Exit

© [User]

From the list, select the user you want to log on as.

@ [Password] Box
Enter the password.

© [OK] Button
Log on as the selected user.

O [Exit] Button
When the application is started, and the “Log On” dialog box is displayed, there is an [Exit]
button. This closes the application without logging on a user.

© [Cancel] Button
When the “Log On” dialog box is displayed after a user is logged off, there is a [Cancel] button
instead of an [Exit] button. This cancels the logoff. The original user will continue to be logged
on.

B Logon Procedure

1 Click ['¥] at the right of the [User].
A drop-down list of user names will be displayed.

2 Click the user you want to log on.

3 Enter the password into the [Password] box.
When you type in the password box, the characters you enter will display as asterisks (*).

4 Ciick the [OK] button.
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Logging Off

Logoff is used when changing users. When you log off, the document currently being edited is closed,
and the “Log On” dialog box is displayed so you can log on the next user. Log off with the [Log Off]
command on the [File] menu in the Main Panel window.

1 Click the [File] menu — [Log Off] command on the Main Panel window.

= DME Designer :

Chrl+M

L - R S
! o @@ O tfl e

Ctrl+0

u
Chri+S ser &

Save As...

Import DME Designer All File

Export DME Designer All File

DME File Storage

Import Device Configuration ¥
Export Device Configuration »
1< f5etup0s.daf

2 CifSetupla, daf

Preferences

Lag OFf

Exit

Log on the next user in the “Log On” dialog box.
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Files Used by the DME DESIGNER

The following files are used by the DME designer application.

Name Description Extension
Project File Stores information relating to the entire project. .daf
DME Data File Stores information for independent DME or SP2060 units. .ddf
Library File Stores component parameters. .cel
Stores user control parameters. .ucl
Stores user module parameters. .uml
Stores user modules. .umf
Stores SP2060 libraries. A
Wave List File Stores the Wav File Manager list. .dwl
DME Backup File Stores DME or SP2060 backup data to a file. .dbk
SP2060 Backup File Stores SP2060 unit data as SP2060 Backup file. .spb
DME Designer All File Stores the project file, library data files, and all DME Designer settings at | .dme
once.

Project Files

Systems built with DME Designer are saved as project files. Project files have “.daf” as the extension
for their filenames.
These files include settings for the area, zones, device groups, configurations, and each parameter.

[
=

FILE
project03, daf

Since only one project file can be open at a time, before you can open a second file, the first one must
be closed.

The commands for opening project files, creating new ones, and saving them, are found in the [File]
menu of the Main Panel window.

Creating New Project Files

Project files are created using the [File] menu = [New] command in the Main Panel window.

1 Click [File] menu - [New] in the Main Panel window.
Since the currently open project file must be closed before a new one can be created, a “Project
file has been modified. Save?” dialog box will be displayed.

" DME Designer

- Praject file has been modified.
\\I) Save?

i) | Zancel ‘

2 To save the file, click [Yes]. the File Save dialog box will be displayed.
If you click [Yes], the File Save dialog box will be displayed.

A new project file will be created.
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Saving Project Files

Project files are saved using the [File] menu - [Save] and [Save As] commands in the Main Panel
window. The [Save] command overwrites the previously saved version of the file. The [Save As]
command lets you give a new name to the file before saving it. When you save the file with a new
name, you can protect it with a password.

B The “Save As” Dialog Box

When you click the [File] menu = [Save As] command in the Main Panel window, the “Save As”
dialog box is displayed. Except for some [Security] options, this dialog box is the same as the
normal Windows dialog box for saving files.

@ [Up One Level] Button
© [Create New Folder] Button
@ [Views] Button

soers ] FK

-|Eve in: |59 YAMAHS bidg | & B8

?

P

G— Filename: | | [ sawe :—_@
e_ 5ave as type: |Project File [*daf) - — I_ _@
O—— sy

@ ‘P

m— _IEnflrmPasswurd=

© [Save In]

Specify the folder for saving the file. The folder name is displayed in this box. Click the [¥] on
the right to move to another folder.
The large box below displays the contents of the folder in this box.

@ [Up One Level] Button
Moves to the folder one level higher in the hierarchy.

© [Create New Folder] Button
Creates a new folder in the folder currently being displayed.

O [Views] Button

Changes the way the folder content list is displayed. If you click this button, a menu appears
that lets you change the arrangement and display format of the files in the list.

O List

This box displays the contents of the folder shown in the [Save In] box. Only files belonging to
the type selected in the [Save As Type] box will be displayed.

O [File Name] Box

Enter the filename. If the currently open file has already been saved, its name will be already
entered in this box. To save using a different flename, change the name here.
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@ [Save as type]

Selects the format for the file you are saving. When saving project files including Wave files set
for Wav File Player, select “Project File with wave (*.daf)”. Otherwise, select “Project File (*.daf)”.

O [Security]

Protects files with a password. If you check here, you will be able to enter settings in the [ID],
[Password], and [Confirm Password] boxes.

© [ID] Box

Enter the ID that has been set for the file. The currently logged on user name will be pre-
entered, but you can change it. This need not be the same as a user name.

@ [Password] Box

Enter the password that has been set for the file. You can enter up to 256 alphanumeric
characters. The characters you enter will be displayed as asterisks (*) in the [Password] box.

® [Confirm Password] Box

Enter the password once again to confirm it. Enter the same password as was entered into the
[Password] box. The characters you enter will be displayed as asterisks (*), the same as in the
[Password] box.

When someone attempts to open a password-protected project file, the application will request an ID and password.
If they are not entered correctly, the file cannot be opened. Be careful to avoid mistakes when entering the ID and
password. The password cannot be reissued and the ID and password cannot be changed. Be careful not to forget
them.

@ [Save] Button

Saves the project file.

If the characters entered into the [Password] and [Confirm Password] boxes were not the same,
a “Password is different” dialog box will be displayed. Click the [OK] button and reenter the
correct password in the [Password] and [Confirm Password] boxes.

! E Password is different

® [Cancel] Button
Cancel the file save process.
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B Saving Project Files

1 Click [File] menu - [Save] in the Main Panel window.

"= DME Designer :

Mew Chrl+h

Save As...

Import DME Designer All File

Export DME Designer All File

DME File Storage

Import Device Configur ation 3
Export Device Configur ation 3
1 C:fSetup0s. daf

2 CifSetup0e, daf

Preferences

Log Off

Exit
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VB oo Ty e ®
[ in @8 8 Ul o

&

If there is a file already saved with the same name, it will be overwritten.
When saving a project file for the first time, you must name the file before saving it. The “Save
As” dialog box will open, the same as when clicking the [File] menu [Save As] command. Enter

a filename and specify the folder where the file will be saved.

B Saving a File with a New Name

With the [File] menu [Save As] command in the Main Panel window, you can save the currently
open file with a new filename. When saving for the first time, this creates a new file. A file that has

already been saved with a name will be saved as a separate file.

1 Click [File] menu - [Save As] in the Main Panel window.

The “Save As” dialog box will be displayed.

Save As

Save in | £ YAMAHA bidg

=l « @ e B

RIX

|E 123.daf
‘Easd.daf
IEpmjectﬂl .daf
IEpﬂ'ojectDZ.daF
’Epmjectﬂ&daf

File name: |

Save as type: |Pn:|iacl File [*.daf]

™ Security

j Cancel

D [

Paszmord |

Confirm Password |

Save

2 Enter a filename into the [File name] box.

3 Specify the folder where the file will be saved.

4 Click the [Save] button.
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B Protecting a Project File with a Password

When you save a project file with a new name, you can set a password and protect the file. If a
password is set, an ID and password will be requested when the file is opened.

The security settings for a file cannot be changed by resaving the file with the same name. They
can only be changed when saving the file with a new name using the [Save As] command. Once
set, the ID and password cannot be changed. To change the ID and password for password-
protected project files, use the [Save As] command to save the file as a new one with a different
name.

1 Click [File] menu - [Save As] in the Main Panel window.
The “Save As” dialog box will be displayed.

2 Place a checkmark for [Security] in the file save dialog box.

3 Enter an ID into the [ID] box.

The name of the currently logged on user will be automatically entered into the [ID] box. To
change it, enter another ID into the box.

When using [Save As] to save a password-protected file, the dialog box will be displayed with
the ID and password boxes automatically filled in with the ID and password that were assigned
to the original file. To change the ID and password, enter new ones into the boxes.

4 Enter the desired password into the [Password] box.
You can enter up to 256 alphanumeric characters for the password. The characters you enter
will be displayed as asterisks (*) in the [Password] box.

5 Enter the same characters into the [Confirm Password] box as were entered into the
[Password] box.
The characters you enter will be displayed as asterisks (*) in the [Password] box.

6 Click the [Save] button.

Save As E]E]
Save i | ) YAMAHA bidg | &5 B~
B 123, daf
ﬁasd.daf
'ﬁpmjectﬂl.daf
ﬁpmjectDZ.daF
ﬁpmjectDS.daF
File name: |yamaha Save |
Save as type: |Pmiact File [*.daf] j Cancel
¥ Security
D |Administratol
Paszward | ******
Confirmn Pasgword |~

When saving a password-protected file without changing the name, the same ID and password
will be set (the ID and password cannot be changed).

Using the [Save] command, you cannot password protect an already saved project file that was
not already password protected. To set a password for a file that is not already password
protected, save it as a separate file using the [Save As] command.
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Opening Project Files

Project files are opened using the [File] menu = [Open] command in the Main Panel window. Since
the currently opened project file must be closed before another one can be opened, a “Project file has
been modified. Save?” dialog box may be displayed.

B [Open] Command
Project files are opened using the [File] menu = [Open] command in the Main Panel window.

1 Click [File] menu - [Open] in the Main Panel window.
A “Project file has been modified. Save?” dialog box may be displayed.

= DME Designer

/{ Project file has been modified.
Save?

Mo Cancel |
2 Click the [Yes] or [No] button.
The “Open” dialog box will be displayed.
Open E]
Look in: | 3 YAMAHA bldg = cF B~
5 B 123.daf
m Easd.daf
My Recent Eprmectm Jdaf
Documents Epro]ecttlz.daf
?[‘ Eprn]ectDS.daF
Deskiop
7
My Documents
fdy Clomputer
Myprlwl:ct.;nrk File name: | ﬂ Open |
Files of type: |P|o\ect File [*.daf] j Cancel

3 Selects the file to be opened.

4 Click the [Open] button.
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B Opening a Project File That Has Security Set

If security is set for a project, the “Enter ID & Password” dialog box will be displayed when you click
the [Open] button in the “Open” dialog box.

™ Enter ID & Password

Enter the ID and password for the file into the [ID] and [Password] boxes, and click the [OK]
button.

If you enter an incorrect ID or password and click the [OK] button on the “Enter ID & Password”
dialog box, the “Wrong ID or password!” dialog box will be displayed.

" DME Designer @

& Wrong ID of password!

Click the [OK] button and enter the correct ID and password the “Enter ID & Password” dialog box.

B Opening a Project File from the “Recently Used Files” List

Recently used project files are displayed on the [File] menu in the Main Panel window. If you click
one of the filenames, you can open that project file.

"= DME Designer :

Mew Chrl+M = =
@ T hd
66 b tfl L.

- E o
E Open... o
H Save Chrl+35 User &

Save A5,

Import DME Designer Al File

Export DME Designer Al File

DME File Storage

Import Device Configuration »

Export Device Configuration »

Recently Used Files _{ L Cifsetupoe.daf ]

2 Cifsetup0e,daf

Preferences

Log OFF

Exit

If security is set for a project file, the “Enter ID & Password” dialog box will be displayed if that file is
selected from the recently used files list. Enter the ID and password to open the file.
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B Double-Click the Icon for the Project File
When you double-click the icon for the project file, the file will open. If DME Designer is not started,
it will start. After logon, the project file will open.
Just as when you use the [Open] command, if DME Designer is already started, the currently open
project file must be closed before another one can be opened. Therefore, a “Project file has been
modified. Save?” dialog box will be displayed.

Sometimes the “Project file has been modified. Save?” dialog box will not be displayed.

=2 DME Designer

- Project File has been modified.
\I) Save?

If security is set for the project file, the “Enter ID & Password” dialog box will be displayed. Enter
the ID and password to open the file.

Closing Project Files

You cannot have multiple project files open simultaneously in DME Designer. To close the currently
open project file, you can create a new project file or open another project file.

DME Data File

You can import or export parameters for a DME or SP2060 that is arranged in a configuration file.
Parameters for a single DME or SP2060 unit in the current configuration (the one being edited) are
saved as a file. Saved parameters can be imported into another project file.

Files with parameters saved in them are called “DME Data Files.” These files have “.ddf” as the
extension for their filenames.

3

FILE
datall . ddf
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DME Data Import
This imports DME data file settings into a DME or SP2060 included in the current configuration.

1 Activates the DME or SP2060 configuration layout to be imported.
If multiple configurations are available, the DME or SP2060 configuration layout to be imported can
be selected via the Navigator window.

2 Click the [File] menu in the Main Panel window, and move the mouse cursor over [Import
Device Configuration].
A submenu will be displayed. The DME groups and SP groups included in the current configuration
will be displayed on a submenu.

" DME Designer :

Chrl+ = = P
/ r-ﬁu 6o (il :;ﬁ

Chrl4+0
User E

Chrl+5
Sawe fs...
Import DME Designer All File
Export DME Designer All File

DME File Storage

DME Groupl »
Expart Device Configuration 4 SP Groupl 3
1 C:fSetup08. daf Create Mew Group

Z C:f5etup06. daf
Preferences

Log Off

Exit

3 Select the device group to which the DME or SP2060 is to be imported from the submenu.
DME and SP2060 units cannot be used assigned to the same device group.

DME and SP2060 units cannot be combined in the same Device Group.

4 on the submenu, click on the DME or SP2060 into which you will import settings.
The “Open” dialog box will be displayed.

Open E]
Laokire | £ YAMAHA bldg | ot EB-

L\ﬁ [ datant. oo
My Recent
Documents

G

Desktop

<y

Iy Documents

Iy Netwark File name: | - Open
Places | J \—I
Files of tupe: |DME File [*.ddf) j Cancel

5 Select the DME data file and click the [Open] button.
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B [Import Device Configuration] Submenu

The device groups included in the current configuration, as well as the DME or SP2060 units
included they contain, will be displayed in the [Import Device Configuration] submenu.

"= DME Designer :

= Ctrl+M

E Open... Chrl+C
H Save Chrl+3 User £

Save As...

" @& oy e B
! i @@ (U tf] Fart Zone

Scene

Import DME Designer All File
Export DME Designer All File

DME File Storage

Import Device Configuration I DMEGAN
Export Device Configuration 4 3P Groupl DMESi-C

1 C:fSetup08.daf Create New Group Create New
2 CifSetupi. daf

Preferences
Log OFf
Exit

Select [Create New Group] to create a new device group
[Create New DME] creates a new DME and imports settings.

Only users for whom the [Operation Security] — [Edit] checkbox in the “Security” dialog box has been checked can
import DME data. For information about user security levels, see “Scene Manager” on page 157.

If DME data file import was not possible, a “DME file import failed.” message will be displayed.
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DME Data Export

This exports parameters from a DME or SP2060 included in the current configuration and saves them
as afile.

1 Activates the DME or SP2060 configuration layout to be exported.
If multiple configurations are available, the DME or SP2060 configuration layout to be exported can
be selected via the Navigator window.

2 Click the [File] menu in the Main Panel window, and move the mouse cursor over [Export
Device Configuration].
A submenu will be displayed. The DME groups and SP groups included in the current configuration
will be displayed on a submenu.

Chrl4n

B oo Ty af] ¥
¢ S8 Y UI o

Chrl+o

Ctrl+s _ |User £

Save As..,

Impart DME Designer All File
Export DME Designer &l File
DME File Storage

Import Device Configuration »

Expart Device Configuration DME Groupl
1 CifSetup0s.daf k 5P Groupl 3

2 Cifsetupl6.daf

Preferences
Log Off
Exit

3 On the submenu, click on the DME or SP2060 from which you will export settings.
The “Save As” dialog box will be displayed.

Export DME @
Save jn: |.D My Documents j £ B0
[
-‘ﬁMy Pictures
remare |
Save az bpe: |DME File with wave [*.ddf) j Cancel
[ Securty
s} [
Password [
Confirm Password |

4 Enter the filename.
Determines whether a selected file type will be exported along with a wave file.

5 Specify the folder where the file will be saved, then click the [Save] button.

Library data is not contained in the DME data files exported from SP2060.
Refer to “SP2060 Library Manager” on page 153.
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B [Export Device Configuration] Submenu

The DMEs or SP2060s included in the current configuration will be displayed on the [Export Device
Configuration] submenu.

"= DME Designer :

Chrl+M

T T
! i @8 O 1] Py

Chrl4O

Ctri+s User

Save fs..

Import DME Designer All File
Export DME Designer All File
DME File Storage

Import Device Configuration »

Expart Configuration ml DMEE4N
1 CifSetup0s.daf SP Groupl 4 DMESi-C

2 CifSetupl6.daf

Preferences
Log Off
Exit

Library Files

Component Editor, User Control Editor, and User Module Editor parameters can be stored to and
recalled from library files. Refer to “Library Files” on page 325.

The library data for a single SP2060 unit can be imported or exported as required. Refer to “SP2060
Library Manager” on page 153.

DME Designer All Files

The project file and all DME Designer settings related to the project file can be managed as a DME
Designer All file. DME Designer All files have a “.dme” extension.
DME Designer All files include the settings listed below:

® Project file

e Library files

e User module files

e Wave files

e Picture files

¢ All DME Designer settings

DME Designer All files are a convenient way to move project data and DME settings you have created

from one computer to another. The DME Designer All import and export commands are provided in the
Main Panel Window [File] menu.
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Importing DME Designer All Files

Only users with Administrator access can import DME Designer All files.

1 Click [Import DME Designer All File] in the Main Panel Window [File] menu.
Since the imported data will overwrite the existing DME Designer settings, the confirmation
message shown below will appear.

™ DME Designer

& User settings will be averwritten.

Cancel |

2 Click [OK] to continue with the import procedure, or [Cancel] to abort the import.
If you click [OK] the “Open” dialog box will appear.

Laok i | Iy Documnents j e B~
_ [CJ)DME Designer
4 My Music
My Recent |[Z}my Pictures
Documents Setup0l,dme
Desktop

My Documents

®

My Computer

=)

&

by Metwark File name: |SetupD‘I j Open |
Flaces
Fils of type: | 4 File *.cme) =l Cancel

3 Select the DME Designer All file you want to import.

4 Click the [Open] button.
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5 The “save Project File in DME Designer All File” dialog box will appear, allowing you to save
the imported project file.
For details on saving project files refer to “Saving Project Files” on page 35.

Save Project File in DME Designer All File 3]
Save in: | uD My Documents j I‘::F B~
2 |CZ)DME Designer
. dMy Music
II:\)‘iy Fecent u-ﬂMy Pictures

ocuments &Setupﬂl

@ B setupoz

Desktop

by Documents

@

My Computer

M Metwark,
Places

File name: | j Save |
j Cancel

Save as type: |Proiect File [*.daf)

6 it security is set for the file the “Enter ID & Password” dialog box will appear. Enter your 1D
and password, and click [OK].

™= Enter ID & Password

Pazsword |

ok Lancel

The imported files are stored in the folders listed below.

Name Folder
Project File Specified in step 5.
Library Files The “Library” folder in the folder specified by the [Contents Folder] item in the Main
Panel Window “Preferences” window.
Wave Files The “Wav” folder in the folder specified by [Contents Folder].
Picture Files The “image” folder in the folder specified by [Contents Folder].
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Exporting DME Designer All Files

1 Click [Export DME Designer All File] in the Main Panel Window [File] menu.

The “Select File for Export” dialog box will appear. Check the checkboxes of the files you want to

export. To select all the available files click the [Select All] button, or click [Clear All] to uncheck all
the files.

™= Select File for Export

CrossoverProcessor?

| Fader

- 4 Fader 2 Charinel
f. M Librar/Fader/Fader 2 Channel/librand 2. cel
+- M GEQ
- B HPF
+- W SpeakerProcessar
- [ 5P
+- [mage
=I- Project File
C:/Projectl2. daf
=- M Templatel serModule
Iger Module Groupl
Uzer Module Group2
Way

| | 2
Select Al | Clear &1 ok | cancel |

[+

-

¢ Only wave and image files used by the currently open project file will be displayed. All user module templates will be
displayed under TemplateUserModule.

* The project file and image files will always be exported, so their checkboxes cannot be removed. The DME Designer
settings will also always be exported, so they are not displayed here.

2 Check the file(s) to be exported and click [OK].

The “Save As” dialog box will appear. This is the same as the “Save As” dialog box used when
saving project files, and details can be found in the “Saving Project Files” section on page 35.

Save in: |@ My Documnents j I‘j( E3-
[CZ)DME Designer
My Music
My Pictures

Florons:  [senetd
Save as type: | Al File (" dme) =] Cancel

[~ Security

(o} [

Passward [

Confirm Pagsword |

3 Enter a file name, destination folder and, if necessary, security settings including ID and
password, then click the [Save] button.
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Configuration Creation Procedure

The configuration is a design diagram that determines the DME configuration. Transferring this data
causes the DME to operate. Follow the procedure below to create a DME Designer configuration.
SP2060 configurations can be selected from scene preset data, but cannot be edited.

Configurations can be created only when the DME unit is offline. To transfer the data, you must first go into online status. The
procedure for going online is given later in this document.

1 Creating a New Project.
When you start DME Designer, a new project is created. If another project file is already open, use
the [File] menu = [New] command in the Main Panel window to create a new file.
“Main Panel Window Menu” = [File] menu = [New] (page 60)

2 Zone Settings.
Zone names are set, and zones are added and deleted using the “Zone Manager” dialog box.
See “Adding, Deleting, and Renaming a Zone” on page 291.

3 DME, ICP, External Device Layout.
Position the required DME, ICP, and other external devices in the Designer window, set the device
groups for the DME and ICP units, and set the properties.
See “Device Group Selection” on page 276,
“Designer Window” on page 193,
“Objects” on page 210,
“Design Window Shared Settings and Operations” on page 268.

4 Configuration Settings.

Configurations can be named, added, and deleted via the “Configuration” dialog box.
See “Adding, Deleting, and Renaming a Configuration” on page 295.

5 Placing Components.
Place components and user modules in the Configuration window.
See “Configuration Window” on page 301,
“User Module” on page 309,
“Types of Components” on page 371.

6 Component Logical Connections.

Use wires to connect the components and user modules you placed in the Configuration window.
See “Drawing and Editing Wires” on page 279.

7 Setting Parameters.

Edit the component parameters in the component editor.
See “Component Editor Window” on page 319.

8 Setting User Defined Button

Parameters can be assigned to function keys F1 through F6 in the DME unit.
See “User Defined Button (User Defined Parameters)” on page 132.

9 Storing Scenes.

Store the scene using the [Tools] menu = [Scene Manager] command in the Main Panel window.
See “IP Address Setup” on page 82.
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Online

You can connect the DME or SP2060 unit to your computer and transfer configurations, scenes and
parameters created in DME Designer into the DME or SP2060 unit. You can also read data from the
DME or SP2060 unit into DME Designer, synchronizing it with the status of the DME or SP2060 unit.
Because Synchronization presupposes that the DME or SP2060 unit can communicate with the
computer where DME Designer is installed, the necessary drivers (USB-MIDI or DME-N Network
Driver) must be installed, and appropriate settings must be made for each driver and for DME
Designer communication port.

Because there are no scene settings when the DME unit is purchased, the configuration and scene information created in
DME Designer must first be transferred.

A maximum of 32 device groups can be online.

1 DME Unit and Computer Connection.
Connect the DME unit and computer using a USB cable or an Ethernet cable.
See separate DME or SP2060 unit Owner's Manual for details.

2 Communication Driver Installation.
Install the USB-MIDI driver or DME-N Network driver in the computer.
See separate “DME Setup Manual” for details.

3 Communication Driver Setup.
Make the necessary settings for the communication driver installed in the computer. If the driver is
set up already, check the settings before going online.
See separate “DME Setup Manual” for details.

4 Making Communication Port Settings in DME Designer.
The port for each device group master can be selected via the “Communication Port” dialog box. If
the driver is set up already, check the settings before going online.
“Communication Port” dialog box (page 155)

Slave DME64N/DME24N units connected via Ethernet and ICP1 units cannot be set.

Only USB x-1 can be selected for a DME Satellite unit connected via USB.

5 Storing and Checking Scenes.
When moving online, the lowest scene must be stored. You can check if a scene is stored using the
“Scene Manager” dialog box.

Since the SP2060 has scene preset data this confirmation is not necessary.

See “Scene Manager” on page 82.
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6 Recalling Scenes.
When going online, the scene will be recalled. Its scene number must be displayed in [Scene
Number], and its scene name will be displayed in Scene Name. If [-------- ] is displayed of [Scene
Name], the scene will be recalled.

Since the SP2060 has scene preset data this confirmation is not necessary.

When the scene device group display mode is “ALL” the scene link name will be displayed. Select a DME group to
display the DME group scene name.

Main Panel Window — “Current Scene” (page 57)
See “Scene Manager” on page 82.

7 Display the “Synchronization” dialog box.
Click [Synchronization] in the [Tools] menu or the large [Synchronization] button on the toolbar.
When the dialog box opens, a list of connected DME and SP2060 units will be obtained.
DMEs and SP2060s connected to the computer are displayed in the [Network] list.

=3 Synchronization

. Go Off-line Gloze
Group | DME Groupl ﬂ
DME Designer Metwork
Device ‘IP Address IF Address Type |
DMEdio-G 192168000004 | 92.160.000.004 DMEdio-C
DMEZ4N 1927168000007 X 1 92,168 000.007 DME24M

Messaze

0%

Iv Close this window after synchronization

Iv Store Project File into DME after synchronization

When requesting the “Synchronization” dialog box, a one-time alert will be displayed if the Communication Port settings
have not been made. After clicking the [OK] button on the alert, a dialog will open. At this time, you can make the
needed settings in the displayed dialog box, and then again display the “Synchronization” dialog box.

8 Device Group Selection
Select the device group to be synchronized from the [Group] list in the [Synchronization] window.

Only one device group can be online in one operation.

DME Designer Owner’'s Manual 51



52

Chapter 2 DME Designer Overview

9 IP Address Selection

The DMEs and SP2060s included in the current device group are displayed in the [Designer] list in
the “Synchronization” dialog box. Click the [IP Address] box, then select the DME or SP2060 unit IP
address that matches the DME or SP2060 currently in the DME Designer.

Click [¥] to display the IP addresses of all similar devices in the area.

™= Synchronization

i Go Off-line

Group | DME Groupl

DME Desiener

Network.

| Device | IP Address |

IP Address Tvpe |

DME4io-C  192163.000.004

DHME24N  RESRIEITTES

R 1 92 168,000,004 DME4io-C
kR 52 168.000007 DME24N

Select IP Address
192.168.000.004

Mezsage

0%
[v Close this window after synchronization

v Store Project File inta DME after synchronization

10Going Online.

Clicking the [Go On-line] button displays a dialog box where you can decide the synchronization
method.

An alert will be displayed if no scene has been recalled.

= Sync Direction

DME Desigrer -» Device

DME Desigrer <- Device |

LCancel |

Click the [DME Designer = Device] direction button.
Transfer of the configuration will begin, and DME Designer will be synchronized with the unit.
If there are many zones, this process may take time.

When a configuration has already been transferred to a DME unit, we recommend using the [DME Designer <- Device]
button for synchronization. The transfer time is faster than using the [DME Designer -> Device] button. If the
configuration has been edited, however, synchronization can only be achieved by using the [DME Designer -> Device]
button.
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When going online is finished, the [Go On-line] button will be grayed out, and the Main Panel
window [On-line] button will light up. At this point if the [Store Project File into DME after
synchronization] item is checked, the project file will be automatically transferred to the DME unit
and stored. And if the [Close this window after synchronization] item is checked, the window will

close automatically.

It may not be possible to go online if a scene has not been stored when [Recall Safe] is selected.

Group | DME Group =]
DME Designer Metwork
Device |IP Address IP Addrezs Twpe ‘

DME4io-C 192168.000.004
DMEZ4N 192168000007

o 1 02 165,000,004 DME4io-C
e 1 92.168.000.007 DME24H

Message

=
Clear Zone ID < Success > ﬂ
Write Zone D < Success »

Synchronize Zone. < Success >

Recall Scene Mol. < Buccess »
Get Wiord Glock Fs < Success >
Get Wiord Glock Fs < Success »
Start Event Logeer < Success »
Start Event Scheduler < Success >
Start Wave Manager < Success >
Start Monitoring Point List < Success >
Get Component Preset (DME4io-C:Setup) < Success »
Get Component Preset (DME24MN:Setup) < Success >

Transmission complete.

-

CLLLELL LU LR L L]

v Cloze this window after spnchronization

I Store Project File into DME after synchronization

>

Untitled

Device Group
Configuration

Mute Rx

To go off line, click either the [On-line] button in the main panel window, or the [Go Off-line] button

in the “Synchronization” dialog box.

If the IP address of the DME device is changed after the device has been synchronized with DME Designer, it will be
necessary to re-transfer the configuration data. The “Full Resync” operation forces a re-transfer of all configuration data,
and can be initiated by clicking the [Go On-line] button while holding down the [Ctrl] key.

If LAN cable connections are changed while DME Designer is running, the DME units will continue to attempt to connect
to the original computer. If it is necessary to switch computers, either quit DME designer before changing the

connections or set the Port parameter to No Assign.
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Names and Functions of the Windows

The Main Panel window is the main window of DME Designer.

Current Zone Current Device Group Current Configuration

Title Bar
Menu Bar
Tool Buttons (Small)

_ '
Tool Buttons (Large) | - W

Log On User Current Scene [Mute] Button ~ Communication
Status

Title Bar
“‘DME Designer” is displayed on the title bar.

Menu Bar

Commands that can be executed in the application are collected into categories on the menu bar.
When you click one of the categories, a list of commands is displayed.

Also, the name of the currently open project file is displayed at the right. When a new project file has
been opened, or has not yet been saved, “Untitled” will be displayed for the file name.

Tool Buttons (Small)

Frequently used commands are arranged here as buttons. When a command cannot be used, its
button will be grayed out.

[Open File] Button
[Save File] Button
[Undo] Button
[Undo History] Button
[Redo] Button

BT D ee W e

= Por

[Port] Button
[User Control Manager] Button

[Clock] Button
[Parameter Link] Button
[MIDI] Button
[GPI] Button
[Word Clock] Button
[User Defined] Button

B [Open File] Button

Opens project files.
- [Open] on the [File] menu (page 61)
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[Save File] Button

Saves the project file currently being edited.
- [Save] on the [File] menu (page 61)

[Undo] Button

Undoes the most recent edit operation.
- [Undo] on the [Edit] menu (page 63)

[Undo History] Button

Opens the “Undo History” dialog box. Undoes multiple operations.
- [Undo History] on the [Edit] menu (page 63)

[Redo] Button

Restores operations undone with the [Undo] button back to their original condition.

- [Redo] on the [Edit] menu (page 63)

[User Defined] Button

Opens the “User Defined Button” dialog box.
- See “[User Defined Button]” on page 132.

[Word Clock] Button

Opens the “Word Clock” dialog box.
- See “[Word Clock]” on page 177.

[GPI] Button

Opens the “GPI” dialog box.
- See “[GPI]” on page 112.

[MIDI] Button

Opens the “MIDI” dialog box.
- See “[MIDI]” on page 125.

[Parameter Link] Button

Opens the “Parameter Link” dialog box.
- See “[Parameter Link]” on page 94.

[Clock] Button

Opens the “Clock” dialog box.
- See “[Clock]” on page 180.

[User Control Manager] Button

Opens the “User Control Manager” dialog box.
- See “[User Control]” on page 325.

[Communication Port] Button

Opens the “Communication Port” dialog box.
- See “Communication Port” dialog box on page 155.
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Tool Button (Large)

[Synchronization] Button

[User Control] Button [Event Logger] Button

[Show/Hide Designer] Button [Event Scheduler] Button

[Show/Hide Navigator] Button

[Show/Hide Designer] Button
Displays or hides the Designer window.

[Show/Hide Navigator] Button
Displays or hides the Navigator window.

[User Control] Button

Works the same as the [User Control] command on the [View] menu. Clicking this button displays a
menu.

User Control will be display there, the user control window will be displayed.
If you click [New User Control], the “New User Control” dialog box opens.

[Synchronization] Button

Opens the “Synchronization” dialog box.
- See “Synchronization” Dialog Box on page 98.

[Event Logger] Button

Opens the “Event Logger” window.
- See “Event Logger” Window on page 75.

[Event Scheduler] Button

Opens the “Event Scheduler” dialog box.
- See “Event Scheduler” Dialog Box on page 101.

Current Zone

Displays the name of the active zone. A list where you can select a zone is displayed when you press
the [V].

Mute
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Current Scene

Displays information about the current scene. You can switch between scenes.

[Change displayed Scene]
(displays DME groups/SP2060s)

[Scene Number] [Scene Name] [Scene Manager] Button

B [Change Display Scene]
Selects the information to be displayed. When “All” is selected scene link information is displayed
in [Scene Number] and [Scene Name]. When a DME group or SP2060 is selected scene
information is displayed in [Scene Number] and [Scene Name].
Refer to “Scene Manager” on page 82 for information on scenes, and “Scene Link Manager” on
page 151 for information on scene linking.

B [Scene Number]

Displays the number of the current scene or scene link. A list where you can select a scene or
scene link is displayed when you press the [¥]. The EDIT indicator will light when a parameter has
been edited after recalling or storing a scene.

|| Device Group

| On-line

v 00:Scene 001
002:5cene 002
003:5cene 003

Seene 100 - 199 !

3
Scene 200 - 299
Scene 300 - 399 7
Scene 400 - 499 »
Seene GO0 - 599
Scene 600 - 699 »
Scene 700 - 799 »
Scene 800 - 899 »
3

Seene 500 - 999

Press <Ctrl> key and <+> key simultaneously recall the next scene and press <Ctrl> key and <-> key simultaneously recall
the previous scene. These settings can be changed via the Shortcut keys dialog box (page 156).

B [Scene Name]
Displays the name of the current scene or scene link.

B [Scene Manager] Button
Opens the “Scene Manager” dialog box.

DME Designer Owner’s Manual

57



58

Chapter 3 Main Panel Window

[User] (Logged On User)

Currently Logged On [Security] Button
User Name

B Currently Logged On User Name
Displays the currently logged on user name.

B [Security] Button
Opens the “Security” dialog box.

Current Device Group

Device Group

Configuration

Mute (R On-line

Displays the name of the currently active device group. Click [¥] to display a list that allows selection
of a different device group.

Device Group k DME Groupl

Configuration SF Groupl

Mute Rx On-line

Current Configuration

Configuration v Configuration

Mute Rx ConfigurationZ

Displays the name of the currently active configuration. Click [¥] to display a list that allows selection
of a different configuration.

B [Mute] Button

Mute OFF Mute ON

Turns ON and OFF the DME mute button for the current device group.

To turn it ON, press the <Shift> key while clicking. If you click the button while it is OFF without
pressing the <Shift> key, the following message will be displayed: “Click the Mute Button with the
Shift Key.”

To turn it OFF, click on the button. There is no need to press the <Shift> key.

™= DME Designer

\il) Click the Mute Butkon with Shift ey
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B Communication Status

Displays the status of communication between the group master of the current device group and
the computer.

Message Transmit/Receive Indicator Ro Tx On-line On-line Button

[On-line] Button

When the group master of the current device group is connected to a computer, clicking this button
alternately switches the unit's on-line/off-line status. The indicator will light when the DME unit is on-
line.

Message Transmit/Receive Indicators

* [Rx]
Lights when MIDI messages from the group master of the current device group are received
by DME Designer.

* [TX]
Lights when MIDI messages are transmitted from DME Designer to the group master of the
current device group.
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Main Panel Window Menu

[File] Menu

" DME Designer :

Chrl+1

3 t-%l L7 Qi’ Ul-l e

Fort

Chrl+0

u
Ctil+s ser E

Save 4s...

Irport DME Desigrer All File

Export DME Designer All File

DME File Storage

Import Device Configur ation ]
Export Device Configuration 3
1 Cifsetup0s.daf

2 T fSetups, daf

Preferences

Log OFf

Exit

B [New]
Creates a new project. When a new project is created, the current project will be closed.
A confirmation message asking “Project file has been modified. Save?” will be displayed.

=2 DME Designer

\il) Project File has been modified.

Save?

Mo Cancel |

[Yes] Button

Saves the currently open project.

If the currently open file was already given a name and saved, that saved file will be overwritten.
The “Save As” dialog box will be displayed for files that have not yet been saved. In this dialog box,
you can name the file when you save it.

[No] Button

Closes the project without saving it. If the file has already been given a name and saved, the most
recently saved version will remain as is. If the project has not been given a name and saved, it will
be lost.

[Cancel] Button
Cancels creation of a new project.
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B [Open]
Opens saved project files. Because the currently open project will be closed, a confirmation
message asking “Project file has been modified. Save?” will be displayed.

When you select this command, the “Open” dialog box will be displayed. Select the project file you
want to open and click the [Open] button.

Open @

Look in: [ YAMAHA bidg =l & E-

@

My Recent Epmjectﬂl.daf
Documents B project0z.daf

Desktop Epmjectl‘l.daf

¥

4y Documents

@

Iy Computer

My Metwork File name: || j l&l
Places
Files of type: |F'r0iec:t File [*.daf] j m

If security is enabled for the project file, the “Enter ID & Password” dialog box will be displayed.
Enter the ID and password to open the file and click the [OK] button. The project file will open.

M Enter ID & Password §|

D u

FPazzward |

ak. LCancel

B [Save]

Overwrites an already saved project file with the current changes. If the file is being saved for the
first time, the “Save As” dialog box will be displayed.
- See “Project Files” on page 34.

H [Save as]

Saves the current project file as another file with a new name or in a new location. When you select
this command, the “Save as” dialog box will be displayed.
- See “Project Files” on page 35.

B [Import DME Designer All File]

Imports DME Designer All files (.dme extension).
- See “Importing DME Designer All Files” on page 46.

B [Export DME Designer All File]

Exports the DME Designer All file (.dme extension).
- See “Exporting DME Designer All Files” on page 48.

B [Import Device Configuration]

Imports parameters for a device that is arranged in a configuration file.
- See “DME Data Import” on page 42.
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B [Export Device Configuration]

Exports parameters of a device that is arranged in a configuration file.
- See “DME Data Export” on page 44.

DME File Storage

Opens the “DME File Storage” dialog box.
- See “DME File Storage” on page 70.

Recently Used Files
Displays recently saved files. If you click one of the file names, you can open that file.

[Preferences]

Opens the “Preferences” dialog box.
- See “Preferences” on page 72.

[Log Off]

Logs off the currently logged on user. Because the currently logged on user must be logged off
before a new one can be logged on, the “Log On” dialog box will be displayed so you can log on
the next user.

- See “Users and Security” on page 31.

[Exit]
Closes “DME Designer.” A confirmation message asking “Project file has been modified. Save?”
will be displayed. To save, click [Yes]. To close without saving, click [No.]

= DME Designer

i Project file has been modified.
\I) Save?
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[Edit] Menu

= DME Desiener :

n Undo Mowve Objects Cirl+Z

S THO R
) Fedo Append Wire  Cirl+y

I' ﬂ Undao Histaory User
STHE i

5=)) ==

H [Undo]

Undoes a single operation. The name of the operation that will be undone by [Undo] is displayed in
the command name. You can also select the commands that come after that.
When [Undo] is not possible, the command will be grayed out.

[Redo]

Returns to the status before the [Undo] command was executed. The name of the operation that
will be restored by [Redo] is displayed. You can [Redo] only as many operations as were undone
with the [Undo] command. When [Redo] is not possible, the command will be grayed out.

[Undo History]

Opens the “Undo History” dialog box. Undoes multiple operations. Also deletes the history of
operations.

"= Undo History

Ar x H-e
00— onece (= H
bepend e (o= )}

Append Wire
Append Object
Append Wire
Append Wire
Mave Objects
Mave Objects
Append Wire
Append Wire

“Append Object

Deletesl  H—@

O List
Displays all operations performed so far, in order starting with the oldest. You can select an
operation by clicking on it.

© [OK] Button
Undoes all operations below the one selected on the list. The operation selected on the list does
not get undone.

© [Close] Button
Closes the dialog box.

O [Delete All] Button
Deletes the entire history of operations displayed on the list. When an operation is deleted from
the list, it cannot be undone.

Operations undone from the [Undo History] can be re-executed one-by-one using [Redo].
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[View] Menu

H E Designer

Event Logeer  Cirl+L
E User Control

Mavigatar Ctrl+B

B [Designer]
Displays or hides the Designer window.

B [Event Logger]
Displays the network event log.
Not displayed if selected while the network event log is showing.
— See “Event Logger” on page 75.

B [User Control]

This opens User Control.

The user controls that can be opened by the currently logged on user are displayed on a submenu.
If you click [New User Control] on the submenu, the “New User Control” dialog box opens.

- See “User Control/User Module Editor” on page 325.

Controls that are not available to the currently logged-on user are not shown in the menu.

The User Controls that are displayed when the DME Designer is launched can be set on the “User Control Manager”

dialog box.
- See ““User Control Manager” Dialog Box” on page 91, page 325.

B [Navigator]
Displays or hides the Navigator window.
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[Tools] Menu

= DME Designer :

E Scene Manager Chrl+1
User Control Manager  Chrl+2
E Parameter Link Chrl+3

] Synchronization Chrl+4

Z_'_El Event Scheduler

Way File Manager

E P Chrlts

[]
A Mo Chrl+6
User Defined Button Chrl+7
DA Control

Remote Control Setup List
Internal HA Control
Parameter Lisk
Component Lock,

Scene Link Manager

SPZ060 Library Manager

B [Scene Manager]

Opens the “Scene Manager” dialog box.
- See “Scene Manager” on page 82.

B [User Control Manager]

Opens the “User Control Manager” dialog box.
- See “User Control” on page 91, page 325.

B [Parameter Link]

Opens the “Parameter Link” window.
- See “Parameter Link” on page 94

B [Synchronization]

Opens the “Synchronization” dialog box.
- See “Synchronization (DME Designer and Unit Synchronization)” on page 97.

B [Event Scheduler]

Opens the “Event Scheduler” dialog box.
- See “Event Scheduler” on page 101

B [Wav File Manager]

Opens the “Wav File Manager” dialog box.
- See “Wav File Manager” on page 108.

m [GPI]
Opens the “GPI” dialog box.
- See “GPI” on page 112.
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m [MIDI]

Opens the “MIDI” dialog box.
- See “MIDI” on page 125.

B [User Defined Button]

Opens the “User Defined Button” dialog box.
—>See “User Defined Button (User Defined Parameters)” on page 132.

H [DAW Control]

Opens the “DAW Control” dialog box.
- See “DAW Control” on page 136.

B [Remote Control Setup List]

Opens the “Remote Control Setup List” Dialog box.
- See “Remote Control Setup List” on page 139.

H [Internal HA Control]

Opens the “Internal HA Control” dialog box.
- See “Internal HA Control” on page 141.

B [Parameter List]

Opens the “Parameter List” dialog box.
- See “Parameter List” on page 144,

B [Component Lock]

Opens the “Component Lock” dialog box.
- See “Component Lock” on page 150.

B [Scene Link Manager]

Allows scene link setup.
- See “Scene Link Manager” on page 151.

H [SP2060 Library Manager]

Allows setup of SP2060 libraries.
- See “SP2060 Library Manager” on page 153.
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[Setup] Menu

= DME Designer :

m Cornmunication Port

Shortout Kevs

B [Communication Port]

Opens the “Communication Port” dialog box.
- See “Communication Port Setup” on page 155.

B [Shortcut Keys]

Opens the “Shortcut Keys” dialog box.
- See “Shortcut Keys” on page 156.

B [Security]

Opens the “Security” dialog box.
- See “Security (Creating Users and Making User Settings)” on page 157.

[Hardware] Menu

" DME Designer :

Metwark Setup
Uitiliby
Word Clock, Chrl+a

Momitor Out Chr3
Qi Clock
Language
Backup
SP2060 Backup

Firmware Update ¥

Device Information

B [Network Setup]

Opens the “Network Setup” dialog box.
- See “Network Setup” on page 165.

m [Utility]
Opens the “Utility” dialog box.
- See “Utility” on page 167.

B [Word Clock]

Opens the “Word Clock” dialog box.
- See “Word Clock” on page 177.
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B [Monitor Out]

Opens the “Monitor Out” dialog box.
- See “Monitor Out” on page 179.

m [Clock]

Opens the “Clock” dialog box.
- See “Clock” on page 180.

B [Language]
Opens the “Language” dialog box.
- See “Language Settings” on page 182.

B [Backup]

Opens the “Backup” dialog box.
- See “Backup” on page 1883.

B [SP2060 Backup]

Opens the “SP2060 Backup” dialog box.
- See “SP2060 Backup” on page 184

B [Firmware Update]

Updates the DME, SP2060, or ICP1 firmware.
- See “DME Firmware Update” on page 186.

B [Device Information]

Opens the “Device Information” dialog box.
- See “Device Information” on page 190.
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[Window] Menu

™= DME Desiener -

Cloge All Editor Windows  Ctr+E

| Diesighsi scene Hum|

2 Compressor

Displays the open windows. Click a window name to bring that window to the front.

H [Close All Editor Windows]

Closes all editor windows.

Each design windows within the Designer window can be switched using the [Window] menu in the Designer window.

[About] Menu

™ DME Desiener -

fbout DME Desiener
T e L

Mute

B [About DME Designer]

Displays information about this application.
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DME File Storage

Allows management of DME files. Project files can be managed on the DME, eliminating the need to
manage them on the computer. Project files can be managed on a DME unit without the need for a
computer. Since project files are necessary to allow synchronization of DME and SP2060 units, we
recommend that you save your project files to the DME unit for enhanced reliability.

Click [DME File Storage] in the [File] menu to display the “DME File Storage” dialog.

Does not apply to SP2060 units

If the file name is to include Japanese characters, select “Japanese” via the “Language” dialog box (page 182). If the file
name is to include non-English Latin characters (Latin-1), select “English/German/French/Spanish”. Inappropriate
combinations of file names and Language settings can make files unreadable in some cases.

Names and Functions

= DME File Storaee

Zohe | File Name |Size |Date | Send.. |

= Zonel

L. 0 DME4io-C[192168.000.003] Beceive
Delate

Remaining Memory
0.0 KB

Cloge

B Zone List
Select the desired zone and device group and DME from the list.

B File List
A list of the files stored on the selected DME.

B [Send] Button
Transfers selected files from the computer to the DME.

B [Receive] Button
Transfers selected files from the DME to the computer.

B [Delete] Button
Deletes selected files from the DME.

H [Close] Button
Closes the dialog box.

Synchronization may become impossible if the [Remaining Memory] value (the amount of remaining DME memory)
becomes too small. If this occurs, delete unwanted scenes or files to increase the amount of available memory.
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Replacing the DMEG64N/24N startup screen

The screen image appearing when the DME64N/24N starts up can be replaced with a graphic file of
your choice in the following way. This function allows you to display a desired startup screen-for
example, one that includes your facility's name and logo.

B Preparing the graphic data
Create the desired graphic data at a size of 160 x 48 dots in black-and-white bitmap format
(extension .bmp) and save it as a file with the name “opening.bmp.”

B Replacing the graphic data
Transmit the graphic file (“opening.bmp”) to the DME unit using the DME File Storage function from
the DME Designer. This image will be displayed at the startup screen from the next time when the
DME starts up.

« To restore the default startup screen, create a dummy file and change the name to “blank.bmp.” and storage it in the same
way as above. The default startup screen will be displayed from the next time when the DME starts up.

¢ The file transmitted to the DME unit using the DME File Storage function will be automatically erased after completing the
internal configuration. This means the file is not stored on the DME unit.

e Compatible graphic files are limited to black-and-white bitmap format at a size of 160 x 48. Other graphic files cannot be
displayed.

* The “Copyright” indication at the bottom of the screen cannot be erased.

® Only the DME64N/24N is compatible with this function. The ICP1 is incompatible.
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Preferences

When you click the [Preferences] command on the [File] menu in the Main Panel window, the
“Preferences” dialog box is displayed. Here you can make environmental settings for using DME
Designer.

Names and Functions

H [Application] Tab

Here you can set the general usage environment.

"= Preferences @

Application lCnmpnnent Editor ]

On Startup
COn Startup ({6

ContentzFolder
o=/ Y AMBHAOPT Toole/DME Desianer

Auta Save
[~ Enable

Interval in minute 30 =

[T Confirm Scene Store

[ Save after Swnchronization

0] 4 Cancel

On Startup
Selects the action when the application starts up or a user logs on.

* [Load the last file opened]

Opens the last opened file. If the file cannot be found because it was moved, deleted, or its
name was changed, a new project will be opened.

* [Create an empty file]
Opens a new project.

* [Load File & Synchronization]
Opens the last opened file and synchronizes with the DME or SP2060 unit.

Contents Folder

Specifies the folder in which common files that are not project dependent are saved. Click the
[Browse] button to locate and specify the folder. The files listed below are saved in the specified
folder.

e User module template files
¢ All types of library files

e Wave files

¢ Graphic files

If the folder is changed, files that were stored in the previous folder will not be automatically moved or copied to the new
folder. To carry the files over to the new folder, export the files as “DME Designer All” before changing the folder, then re-
import the files after the new folder has been specified.
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Auto Save
Set up the automatic file save feature.
This setting has no effect when the file being worked on has not previously been saved, or the
computer is online.
* [Enable]
Auto save of project files being worked on will occur when checked. The file will be
overwritten, but the Undo history will not be cleared.

¢ [Interval in minutes]
Specifies the auto-save interval in minutes.

[Confirm Scene Store]
Place a checkmark here to have a confirmation message displayed when storing a scene.

[Save after synchronization]

If a save is performed after the DME Designer is synchronized to the DME or SP2060 unit, the next
synchronization will be significantly faster because one the difference needs to be synchronized.
Check this checkbox to specify auto-save after the DME Designer is synchronized to the DME or
SP2060 unit.

B [Component Editor] Tab
Sets up operation of the Component Editor knobs, sliders, and edit boxes.

T
-- Preferences

Application | Component Editor l

Knob Made =)

Slider Mode [ Ramp =l

Edit Box Zoom [ On =l

Edit Box Font | MS UI Gothic =]
QF Cancel

Knob Mode
Sets how the knobs operate.

e Circular
The knob is dragged following its shape, as though you were drawing a circle.

e Linear
As you drag the knob to the upper, the value increases. Dragging it down decreases the value.
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Slider Mode
Sets the action that occurs when you click on the scale located under the sliders.

* Ramp
When the fader bar is clicked the knob will move a preset amount in the corresponding
direction.

* Touch
The slider does not move without directly touching it, even if you click the mouse button.

e Jump
The slider jumps to the location where you click.

Edit Box Zoom
When “On” the edit box will enlarge on mouse-over.

Edit Box Font
When “On” the edit box will enlarge on mouse-over.

This is the font when the box is enlarged, not the font that is used when the box is at it's smallest size. The text may bleed
beyond the box with some fonts.

To make a finer setting, press the <Shift> key while dragging the slider.
If you click a slider while pressing the <Ctrl> key, the setting will return to its default value.

B Common to All Tabs

[OK] Button
Applies any setting changes and closes the window.

[Cancel] Button
Closes the window without changing any settings.
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Event Logger

Click [Event Logger] in the [View] menu to open the “Event Logger” window. This window displays the
DME unit event log, and it allows specifying the log file to be stored on the computer as well as the log
file to be store in the DME unit.

If the window is opened while online the event log is automatically retrieved from the DME unit and
displayed as a list in the “Event Logger” window. New events are displayed in real time while the
window is opened and the system is online. If [Enable Logging] in the “Log Setup” dialog box is ON,
the event data will be written to the computer log file at the same time.

Does not apply to SP2060 units.

Only users for whom the [View Log Window] checkbox in the “Security” dialog box has been turned ON can display the
“Event Logger” window. The default setting for this parameter is OFF.

The events you wish to display in the Event Logger window must be set in advance in the “Event Log List” dialog box.

Up to 1,536 events can be stored in the DME unit, while the maximum number of events that can be displayed in the “Event
Logger window is 12,288. When the DME unit even log becomes full, further events cannot be stored. When the DME event
log does become full, use the “Get Log” dialog box to retrieve the event log and then click the [DME Log Clear] button to
clear the DME unit log as necessary. If the “Event Logger” window event log becomes full, the oldest events are
automatically deleted to make room for new events.

Periodically make [Enable Logging] in the “Log Setup” dialog box active so that the event log is saved as a file on the
computer. This operation will automatically clear the DME unit event log.

Names and Functions

= Event Loeeer

| Get Log.. | Zaohe ’PqII—L| ’5 ’E |§ GClear Screen

Date |Time | Tvpe |Zone |Gr0up | DME | Event |
2006-04-20 14:40:45 \‘i)Information Log Orchdministrator
2006-04-20 14:40:46 \‘i)Information Log Off:Administrator
2006-04-20 14:40:46 \‘i)Information Log Orchdministrator
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m DME List

¢ [Date]

Displays the date the event occurred. (Example Display: 2004-08-24)
e [Time]

Displays the time the event occurred.
* [Type]

Displays the event type and icon.

There are three event types:

A\ (Warning): Warning event

€ (Error): Error event

L) (Information): Other events
* [Zone]

Displays the name of the zone in which the event occurred.
¢ [Group]

Displays the name of the device group in which an event has occurred.
e [DME]

Displays the name of the DME in which the event occurred.

e [Event]
Displays the content of the event.

[Log Setup] Button
Displays the “Log Setup” dialog box (page 77). Here you can make Event Log settings.

[Get Log] Button

When offline, this opens the “Get Log” dialog box (page 78). The event log data can be taken from
the DME units, and written to a file on the computer.

[Zone]

Selects the zone, device group and device for which events will be displayed. Only events from the
selected device will be displayed in the window. If [All] is selected, events will be displayed for all.

Display button (Information/Warning/Error)

e 1) [Display Information] Button
Switches between displaying and hiding Information events.
When turned ON, Information events are displayed in the “Event Logger” window.

« [\ [Display Warning] Button

Switches between displaying and hiding Warning events.

When turned ON, Warning events are displayed in the “Event Logger” window.
« € [Display Error] Button

Switches between displaying and hiding Error events.
When turned ON, Error events are displayed in the “Event Logger” window.

[Clear Screen] Button
Clears the event log from the “Event Logger” window. The DME unit event log is not cleared.
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“Log Setup” dialog box

Click the [Log Setup] button in the “Event Logger” window to display the “Log Setup” dialog box. Here
you can make Event Log settings. These settings apply to the system as a whole.

b= Log Setup g]
Iv¥ Enable Logging Dizplay Event
Record |7 3: days per log file

[T Automatically delete log files after 30 3: days T
Iv Erar
Log file folder:
|::a"Documents and Settings sty Documents, Browse...
Log List Setup...

Iv Display Log Buffer Full Message

ak. LCancel

B [Enable Logging]

Turns the function that writes the event log to a file ON or OFF.

When the checkbox is checked the event log is saved to a file, and the saved event log is cleared
from the DME unit.

If the checkbox is unchecked the DME event log is saved in the DME unit.

When checked, it is set in the [Enable Logging] frame.

Record _ days per log file

Sets the number of days recorded into a single log file. When the specified number of days is
exceeded, a new log file is created, and future log events are recorded there.

When “1” is set for the number of days at 10:00 AM, information will be recorded in the same file
until the next day at 9:59 AM. The number of days counted is cleared and a new log file is created
when the system goes online, or when the “Log Setup” dialog box is closed by changing the
settings such as the number of days or the log file folder, and then clicking the [OK] button.

Automatically delete log files after _ days

When a check is placed here, log files exceeding the specified number of days are automatically
deleted. Specifies the number of days after which log files are automatically deleted.

Log file folder

Specify the folder for saving log files. Clicking the [Browse] button opens the standard operating
system dialog box for specifying folders. Here you can select a folder.

Log files are saved with the following file name: “LOG + Start_Date.txt”.

If there is a file with the same name already in the specified folder, a number will be affixed to the
end of the file name, and it will be saved as a separate file. (Example: LOG20040824-2.txt)

B [Display Event]
Displays events with checks next to them. This operates together with the [Display Information],

[Display Warning], and [Display Error] buttons in the “Event Logger” window. You can place
checks next to multiple events.

H [Display Log Buffer Full Message]

This applies to DME64N/24N units in all zones. When checked, if the DME event log becomes full a
“Log Buffer Full” message will appear on the display of the corresponding DME unit.

B [Log List Setup] Button
Sets events sent from the DME units. Clicking here displays the “Event Log List” dialog box.

DME Designer Owner’'s Manual 77



Chapter 3 Main Panel Window

B [OK] Button

Applies any setting changes and closes the window.

B [Cancel] Button
Closes the window without changing any settings.

“Get Log” dialog box

Click the [Get Log] button in the “Event Logger” window while offline to open the “Get Log” dialog box.
The event log can be retrieved from the DME unit while offline and saved as a file on the computer.

Target DME

DME Tpe |

L] Zorel

=- [ DME Groupl
L[] DMESIFC[192.168.000.002] DMESIC

Dutput File M ame

|E:.-’L0g. 13 Browse...
DME Log Clear ok LCancel |

® DME List

Displays the IP addresses and types of DME units included in the device group. Click the DME
from which to obtain events by placing a check next to it.

B [Output File Name]

Sets the file name and save location for the log file. Clicking the [Browse] button opens the file
select dialog box, where you can select a file.

® [DME Log Clear]

Clears (erases) logs in the DME units checked. When you click this button, a confirmation dialog is
displayed.

B [OK] Button
Applies any setting changes and closes the window.

B [Cancel] Button
Closes the window without changing any settings.
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“Event Log List” Dialog Box

Click the [Log List] button in the “Log Setup” dialog box to open the “Event Log List” dialog box. This
allows selection of the events to be stored in each DME unit. Events not selected here will not be
saved either in the DME unit or to a log file.

= Event Loe List

Chapter 3 Main Panel Window

Zone |Zonel -
DME | DME Group/DMEG4N

Event

Event Type GPI Out =
External device control buffer full. Information  ——— :'
Communication between external AD unit and DME ended.  Information  —-
The power waz turned on. Information --—-
Panel Locked. Information  ——-
nel Unlocked. Information  ———
TOUT transmitted.
i Portl Information  ———
.. ] Port2 Information  ——-
Portd Information  ———
.. ] Portd Information  ——-
Porth Information  ———
.. ] Portfi Information  ——-
Port? Information  ———
.. ¥ Portd Information  ——-
Portd Information  ———
.. ] Port10 Information  ——-
Port11 Information  ———
.. ] Port12 Information  ——-
Port13 Information  ———
.. ] Port14 Information  ——- hd|
(o] 4 Cancel |

B [Zone]

If you click here, a list will be displayed. Specifies a zone.

m [DME]

If you click here, a list will be displayed. Specifies DMEs.

H [Event]

Selects the events to be logged.

B [Type]

Selects the event type for each event: [Information]/[Warning]/[Error].

m [GPI OUT]

Specifies the port for event-triggered GPI output. If the same GPI port is specified for multiple
events GPI output will be produced when any of the specified events occurs.

B [OK] Button

Applies any setting changes and closes the window.

B [Cancel] Button

Closes the window without changing any settings.
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Event Log List

The event logs that can be retrieved from the DME unit as well as their content and countermeasures

are listed below.

Displayed Messages

Contents/Countermeasures

Communication between PC and DME ended.

Communication between the computer and DME (device group
master) has stopped. Check cable connections and router/hub
operation.

Communication between PC and DME started.

Communication between the computer and DME (device group
master) has started.

Communication between mixer (PM5D) and DME
ended.

Communication between the mixing console (PM5D) and DME
(device group master) has stopped. Check cable connections.

Communication between mixer (PM5D) and DME
started.

Communication between the mixing console (PM5D) and DME
(device group master) has started.

Communication between master DME and slave
[IP:*.*.*.*] DME ended.

Communication between the device group master DME and
slave (IP Address: *.*.*.*) has stopped. Check cable
connections and router/hub operation.

Communication between master DME and slave
[IP:*.*.*.*] DME started.

Communication between the device group master DME and
slave (IP Address: *.*.*.*) has started.

Scene [***] recalled.

Scene number *** has been recalled.

Scene [***] stored.

Scene number *** has been stored.

DME Designer to DME unit synchronized.

A configuration has been transferred from DME Designer to the
DME unit and synchronized.

MUTE was turned on. [IP:***]

DME (IP Address: *.*.*.*) turned the MUTE function ON.

MUTE was turned off. [IP:***]

DME (IP Address: *.*.*.*) turned the MUTE function OFF.

Input gain too high. AD [ChannelNo.*]

Input gain too high. [SlotNo.*, ChannelNo.*]
Input gain too high. CobraNet [ChannelNo.*]
Input gain too high. EtherSound [ChannelNo.*]

The input signal (slot number/channel number will be displayed)
has exceeded the clipping level.
Reduce the input signal level or head amplifier gain.

Output level too high. DA [ChannelNo.*]

Output level too high. [SlotNo.*, ChannelNo.*]
Output level too high. CobraNet [ChannelNo.*]
Output level too high. EtherSound [ChannelNo.*]

The output signal (slot number/channel number will be
displayed) has exceeded the clipping level.
Reduce the output signal level.

Scene store failure.

The scene data is protected.

This may have been set by the administrator to prevent
unwanted data changes due to improper operation. To change
this setting turn “Protect” OFF in the “Scene Manager” dialog
box.

Word clock unlocked.

An appropriate word clock is not being received or cannot be
detected.

Re-check the word clock connections and the “Word Clock”
dialog box settings.

Word clock not synchronized. [Slot] (Slot*,
Channel */*)

Word clock not synchronized. [WC INI]

Word clock not synchronized. [Cascade IN]
Word clock not synchronized. [Cascade OUT]

The received word clock (input connector/slot number/channel
number will be displayed) is not synchronized with the DME
word clock.

Revise the “Word Clock” dialog box settings so that an external
word clock that is in sync with the DME word clock is received.

External word clock changed. [Fs=(*)kHz]

The external word clock (frequency: *kHz) has been changed.

Internal word clock changed. [Fs=(*)kHz]

The internal word clock (frequency: *kHz) has been changed.
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Displayed Messages

Contents/Countermeasures

Communication between DME is busy and load
is applied.

Heavy network traffic is causing communication delays.
Check the devices connected to the network. It may be
advisable to reduce the number of devices connected to the
network. If the current link mode is 10Base-T, it may be
advisable to upgrade to 100Base-TX

No Battery.

The backup battery is completely depleted or not connected.
The current settings will be lost and the default settings restored
when the power is turned off. Cease operation immediately and
contact your Yamaha dealer.

Low Battery.

The backup battery is running low.

This will not affect operation immediately, but if operation is
continued current settings may be lost and the default settings
restored. Contact your Yamaha dealer as soon as possible.

MIDI buffer full.

The MIDI receive buffer is full.
Too much MIDI data may have been received.

Flash ROM full.

The flash memory used for data storage is full.
Delete unneeded configurations, presets, and/or wave files.

GPI IN reception. [PortNo. *, AD(0-1023)= *]

A control signal (Level: *) has been received at the GPI IN
terminal (Port number: *).

GPI OUT transmission. [PortNo. *->HIGH]
GPI OUT transmission. [PortNo. *->LOW]

A high or low level control signal has been sent via the GPI OUT
terminal (Port number: *).

Panel Unlocked.

Panel lock has been disengaged.

Panel Locked.

Panel lock is engaged so panel operations cannot be
performed.

Panel operation may have been locked by the administrator to
prevent unwanted data changes due to improper operation. To
unlock the panel press and hold the [CANCEL] button for longer
than 2 seconds.

The power was turned on.

DME power has been turned on.

Communication between external AD unit and
DME ended.

Communication between the external head amp unit and DME
device has stopped.
Check cable connections.

External device control buffer full.

The receive buffer for control commands from external devices
has become full.
Too much control may have been received.

Invalid password.

An incorrect password has been entered via the panel.
If you have forgotten the correct password contact your Yamaha
dealer.

Current Settings lost.

The memory has been erased and current settings have been
lost.

Try a scene recall. If that doesn'’t rectify the problem contact
your Yamaha dealer.

Network hardware error.

A network device error has occurred.
Contact your Yamaha dealer.

Duplicate IP address.

Duplicate IP address.
Set IP addresses so that no two devices with the same address
are connected to the network.

DSP power shortage.

Audio input/output has been muted due to insufficient DSP
resources.

This can occur if a configuration created for 48kHz word clock is
run at 96kHz. To ensure full word clock operation, create
configurations with word clock set to 96kHz.
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Scene Manager

Scenes

Configuration contents can be given a name and saved as “Scenes.” Saving scenes is called “Scene
Store.” Parameter settings in the configuration for each site used can be stored multiple times and
recalled and used when needed. There are 999 scene memories available. When a scene is stored,
DME and SP2060 parameters are saved as “preset parameters.” Presets are automatically created
when a scene is stored.

Bringing back a scene (making a scene the current scene) is called “scene recall.” Scenes are
recalled using the ['¥] button next to the current scene on the Main Panel window or by using the
“Scene Manager” dialog box.

B “Scene Manager” Dialog Box

Click either the [Tools] menu [Scene Manager] item or the “Scene Link Manager” window [Scene
Manager] button to open the “Scene Manager” window that allows editing of scene data. Scene
names, security levels, and presets can be changed and copy/pasted as required. The DME
scene memory is comprised of 999 user memories, while the SP2060 has 12 preset memories and
87 user memories. The preset memories are read-only, while settings and changes can be stored
to the user memories as required.

Security for the Logged On User
The currently logged on user can store, recall, or edit scenes that have a security level equal to or lower than his or her
own. User security levels are set with the [Edit] — [Store/Recall/Edit] item in the “Security” dialog box.

There is no [OK] button or [Cancel] button in the “Scene Manager” dialog box. To close the dialog box, click the [Close]
button at the upper-right of the dialog box.

Changes from storing/recalling scenes or editing, such as changing names or contents, will be applied immediately.
With the dialog box open, you can make the Designer window active and add components or change parameters.
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[Copy] Button [Insert] Button

Chapter 3 Main Panel Window

[Cut] Button [Paste] Button [Clear] Button [Recall Settings] Button

™= Scene: Manager

Gut Gopy Paste Inzert Glear Recall Settings ‘ Del | Store ‘ Hew | Del Unuszed ‘
Preset |
= = T = = = DMEZ4N

Scene No. |Mame | Gonfiguration | Edit Security | Recall Security | Fade |Fade Mode |Fade Time | Protect | Partial Recall | 12| . O 4D

01 Scene 001 Configurationl  Level 1 Level 1 OFF Al 00 s OFF 2 17 @ presetont
02 [No Data] - B & B 7 7 B B P t
03 [No Datal - - - - - - - - TE & mi

I reset00]

04 [Ma Data] - = = 5 = = = = & O Slot

0 [ Data] - - B - B B - B C L@ Presstdl
06 [No Datal - = z = = = B =

07 [Ma Data] - = = 5 = = = =

08 [No Data] - i 7 & 7 7 # &

09 [No Datal - = z = = = B =

10 [Ma Data] - = = 5 = = = =

11 [No Data] - i 7 & 7 7 # &

2 [No Datal - = z = = = B =

3 [Ma Data] - = = 5 = = = =

14 [No Data] - i 7 & 7 7 # &

1] [No Datal - = z = = = B =

i [Ma Data] - = = 5 = = = =

17 [No Data] - i 7 & 7 7 # &

8 [No Datal - = z = = = B =

19 [Ma Data] - = = 5 = = = =

20 [No Data] - i 7 & 7 7 # &

21 [No Datal - = z = = = B =

22 [Ma Data] - = = 5 = = = =

23 [No Data] - i 7 & 7 7 # & -

Q24 Ihig Diato] o = = = - - - - =
Scene Link Feoall Detaibs

| ] |

1 |
List [Store] Button [Detail] Button
[Scene Link] Button [Recall] Button

DME Group/SP2060 Selection
Selects a DME group or SP2060.

The selected DME group or SP2060 is linked with the current device group.

List
Displays the contents of the scene.

Scene No.
Displays the scene number. Click here to select a scene.

Name

Displays the name of the scene. Click the [Name] box to enter a scene name. Up to 18 characters

can be entered.

If the scene has not been stored, “[No Data]” will be displayed. A name can be entered when a
scene is stored. The default names are “Scene001,” “Scene002,” etc. The three-digit number is the
same as the scene number (displayed in [Scene Number]) for the stored scene.

The SP2060 display can only display up to 16 single-byte characters. Some characters that appear correctly on the DME
Designer may change when displayed on the SP2060 display. For example, a backslash character will appear as a yen

symbol on the SP2060 display.
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Configuration
Displays the configuration name. If the scene has not been stored, a hyphen (-) will be displayed.

Sut | Copy ‘ Paste | Inzert | Clear ‘ Recall Settines
Scene Mo, | Mame Configuration | Edit Security | Recall Security | Fade |Fade Mode |Fade Time | FProtect | Partial Recall il
] Scene 001 Configuration]  Level | Level 1 OFF Al a0s OFF -
ooz [No Data] - = z = = = = =
003 [Ma Data] - = = 5 = = = =
004 [No Data] - i 7 & 7 7 # &

005 [No Datal - = z = = = B =
00 [Ma Data] - = = 5 = = = =
007 [No Data] - i 7 & 7 7 # &
oo [No Datal - = z = = = B =
009 [Ma Data] - = = 5 = = = =
oo [No Data] - i 7 & 7 7 # &
0 [No Datal - = z = = = B =
mz [Ma Data] - = = 5 = = = =
k] [No Data] - i 7 & 7 7 # &
014 [No Datal - = z = = = B =
me [Ma Data] - = = 5 = = = =
o6 [No Data] - i 7 & 7 7 # &
m? [No Datal - = z = = = B =
me [Ma Data] - = = 5 = = = =
k] [No Data] - i 7 & 7 7 # &
020 [No Datal - = z = = = B =
021 [Ma Data] - = = 5 = = = =
22 [No Data] - i 7 & 7 7 # &
023 Mo Data] - & 5 o = = S =
4 EMH n,¢j - - - - - - - - ﬂ
Scene Link Stare I Becall Detail>>
Edit Security

Displays the scene edit security levels. Clicking here will display a list where you can change these
security levels. Only levels at or below the security level of the currently logged on user are
displayed in the list. Scenes are stored with the same security level as the user, but their store and
edit security levels can be set lower if required.

Recall Security

Displays the scene recall security level. Clicking here will display a list where you can change the
security level. Only levels at or below the security level of the currently logged on user are
displayed in the list. Scenes are stored with the same security level as the user, but their recall
security levels can be set lower if required.

Fade

It sets whether fade is applied (ON) or not (OFF) when a scene is recalled.

When “ON” the faders in fader components will “fade” to their new settings according to the
specified fade mode and fade time when a scene is recalled. This only applies to fader
components.

The fade function cannot be simulated in DME Designer.

Fade Mode

Sets the fade mode. You can select “All” or “Selected.”

If you select “All,” all channels using Fader components in their configuration will be affected. Even
when multiple components are used, all channels are targeted. If you select “Selected,” the only
channels affected will be those for which the Fade switch in the component editor has been set to
ON.

The Fade switch for each channel is set to OFF by default. The fade effect will not be applied, even if Fade=ON and
Fade Mode=Selected is selected. To apply the effect, you must set the Fade switch to ON for the channels where you
need it.
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Fade Time

Sets the fade time: i.e. the time it will take fader parameters to reach their new settings when a
scene is recalled. The changes are smooth and continuous. If only the presets in the recalled
scene are set when that scene is recalled, the volume will be adjusted while the sound from the
previous scene is playing, until the new level is reached If the configuration also changes, the
volume will rise from silence until it reaches the new value. This can be set from zero to 60 seconds,
in 0.1 second increments.

Protect

Turns the Protect function ON or OFF.
When ON scene data cannot be deleted, overwritten, edited, or renamed.

Right-click in the list and use the contextual menu that appears to set User Defined Button, Program Change, GPI In, or
GPI Out for the scene.

Partial Recall

Partial Recall sets created in the [Partial Recall] tab (page 87) accessed from the “Recall Settings”
dialog box can be selected for each scene.

[Cut] Button

Cuts the scene selected on the list. The button will be grayed out and cannot be used when the unit
is online or when an SP2060 preset is being used.

[Copy] Button

Copies the scene selected on the list. The button will be grayed out and cannot be used when the
unit is online.

[Paste] Button

Pastes the contents of the cut or copied scene into the scene selected on the list. Cuts the scene
selected on the list. The button will be grayed out and cannot be used when the unit is online or
when an SP2060 preset is being used. The selected scene will be overwritten.

[Insert] Button

Inserts the contents of the cut or copied scene into the location of the scene selected on the list.
The selected scene and those below are moved down by one. For example, if “Door_Open” was
stored as scene number “005,” and selected when the [Insert] button was clicked, the inserted
scene would become scene number “005,” and “Door_Open” would be moved to scene number
“006.”

= scene Manager E‘ = Scene Manager E|
Cut | Copy ‘ Paste | Insert | Clear ‘ Recall Safe Lut | Copy | Paste | Insert | Clear | Renall Safe
SceneNo | Name Configuration | Edit Secuity | Recall Security il Scene No | Name Configuration | Edit Security | Recall Security il
oo BGM_Contral Canfiguration!  Level 5 Level 5 a0l BGM_Contral Configuration!  Level 5 Lewel 5
o0z Conwention_Center Configuration]  Level 5 Level 5 anz Convention_Center Configuration]  Level 5 Level 5
o003 Scene 003 Configuration!  Level 5 Level 5 an3 Scene 003 Configuration1  Level 5 Level 5
004 Light_On Configuration!  Level 5 Level 5 004 Light_On Configuration!  Level 5 Level 5
Dooi_Open Configuration]  Level § Level 5 i [No D ata] - = -
006 [No Data) - - - Click the [Insert] 005 Dioor_Open Corfiguration]  Level 5 Level 5
007 [No Data] - - - button 007 [NoData] - - -
ong [Mo Data) - - - ang [Mo Data]
o009 [Mo Data) - - - ana [MoData] - - -
oo MNo Datal . - - =] o Mo Datal . . - <]
Store: Becal | Detail> > | Store Becal | Detail» > |

If a scene is stored in the lowest scene on the scene memory list, the button will be grayed out and
the insert function will not be available. Delete the contents of the lowest scene before attempting
to use the insert function.

Move the scene data to a different scene memory when you don’t want to erase the contents of the lowest scene.
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H [Clear] Button

Deletes the contents of the scene selected on the list. The button will be grayed out and cannot be
used when the DME unit is online or when an SP2060 preset is being used.

If the preset parameters included in a scene are not used in another scene, a “Delete preset?”
message will be displayed.

= DME Designer g|

- Delete praset?
Jy e

If the preset parameters are not needed, click the [OK] button. If you click the [Cancel] button, the
preset parameters will not be deleted. Whichever you click, the scene itself will be deleted.

The [Cancel] button on the “Delete Preset?” message does not cancel the [Clear] for the scene. It merely cancels
deletion of the presets.

B [Recall Settings] Button
This button opens the “Recall Settings” dialog box.

Recall Safe and Partial Recall

Recall Safe and Partial Recall parameters can be set up so that only specified components are
recalled, or specified components are omitted, with a scene is recalled. Recall Safe specifies the
components that will be omitted (i.e. not recalled) when a scene is recalled. Recall safe settings
can be made independently for each configuration, and apply to all scenes that use the same
configuration.

Conversely, Partial Recall specifies the components that will be recalled when a scene is recalled.
Partial Recall “sets” can be saved for use with single or multiple scenes.

The Recall Safe and Partial Recall settings are accessed via the [Recall Safe] and [Partial Recall]
buttons, respectively.

[Recall Safe] Tab
The components that will not be recalled when a scene is recalled are selected via this tab.

2 Recall Settines X
Recall Safe \gama\ Rezall |
=-AD
4 PEC s—
onent
NS 108 OUIPLE se—
! 4O Ossillster Component
P i M Slot Ut e——
£-Slot
6 Tnternal[Analoe]
Select Al
Glear Al

Component Tree
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e Component Tree
Displays all components included in the scene. Check the checkboxes to the left of the
components that you do not want to recall when a scene is recalled.

Components that are checked in the [Recall Safe] tab component tree will not be recalled. If you want all
components to be recalled there is no need to make any settings in this tab.

This function is useful when you want most of the scene’s components to be recalled normally while preventing
specified components from being recalled.

[Partial Recall] tab

In this tab you can select only the components you want to be recalled when a scene recall
operation is carried out. All other (unchecked) components will not be recalled. The selections
made here can be saved a sets. Saved sets can be used with multiple scenes, copied, and edited
as required.

= Recall Settines

Fecall Safe | Partial Recall ]

Add Delete Component
Partiall

Partialz &-AD
- M AEC
[=-Gomponent
- O Analog Output
G- B Oscillatar Component
[ Slot Output
=-Slot
- B InternallAnalog]
Select All
Gilear Al
o] 4 Cancel

Partial Recall List Component Tree

* Component Tree
Displays all components included in the scene. Check the checkboxes to the left of the
components that you want to be recalled when a scene is recalled.

* Partial Recall List
Displays the sets of Partial Recall components settings that have been saved. Up to 64 Partial
Recall sets can be saved for each configuration. Saved sets can be selected via the “Partial
Recall” menu in the “Scene Manager” dialog box.

= Scene Manager

Cut Copy | Pazte | Ihzert Clear | Recall Settings

| DME Groupl |
Scene Mo Gonfiguration | Edit Security | Fecall Security | Fade |Fade Mode |Fade Time | Protect | Partial Recall i‘
an Scene 001 Configuration!  Lewel 1 A _P;tial"l—L|

a0z Scene 002 Configuration]  Lewel 1 Level 1 QFF Al 00 s OFF _

o I betal - : : ol - :

004 [Mo Data] - = = & = = S

005 [Mo Data] - = = & = = = 3

(i3 [Mo Data] - = = = = = S 5

o0z [Mo Data] - = = & = = S =

o0s [No Datal - = T = 5 5 = i
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Click the [Add] button to create a new set with all components selected.

Click the [Delete] button to delete the currently selected set from the list.

Right-clicking in the Partial Recall list displays a contextual menu that provides access to the
following operations:

Add: Add a new set with all components selected (same function as the [Add] button).
Delete: Deletes the currently selected set (same function as the [Delete] button).
Cleanup: Deletes sets that are not being used in the current scene.

Rename: Allows a new name to be entered for the selected set.

Copy: Copies the contents (component selections) of the currently selected set.
Paste: Pastes copied contents to the currently selected set.

Duplicate: Creates a duplicate copy of the currently selected set.

Appropriate icons appear to the left of Partial Recall set names when the set is being used by a scene, and when the
scene the set is being used by is protected. Partial Recall sets that are being used in a scene cannot be deleted.

Fecall Settines

™= Recall Settines

me | Protect | Partial Recall

OFF Partiall

oM Partialz Fecall Safe | | ]
- _ Add Delete |
) E B Partiall

h = & Partial?

The set is being used by a protected scene
The set is being used by a scene

Partial Recall sets cannot be created or edited while online.

Common Tab Functions

* [Select All] Button
Checks all components.

¢ [Clear All] Button
Unchecks all components.

¢ [OK] Button
Applies any settings that have been made and closes the dialog box.

¢ [Cancel] Button
Closes the dialog box without applying or saving any settings.

If the same component is checked in both the Recall Safe and Partial Recall tabs, the Recall Safe function takes
priority and that component will not be recalled.

When a scene that includes Local Link or Component Link settings made via the Parameter Link window (page 94) is
recalled, the linked parameters are recalled.
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B [Store] Button

Stores the contents of the current configuration into the scene selected in the list. If an empty scene
is selected and the contents stored there, a new scene is created. If a scene is already stored in
the selected scene number, it will be overwritten. If [Confirm Scene Store] is checked on the
[Application] tab of the “Preferences” dialog box, a confirmation message will be displayed before
the scene is stored.

The currently logged on user can store scenes at a security level equal to or lower than his or her own only.

When the computer and DME/SP2060 unit are online, a scene stored in the DME Designer will also be stored on the DME
or SP2060 unit, regardless of the DME or SP2060 settings.

The DME64N/24N utility display Misc. page [Scene Store] setting only affects store operation from the DME panel
controls.

When a scene is stored, the configuration parameters at that time are saved as “preset
parameters.” Preset parameters are created automatically.

[Recall] Button
Recalls the scene selected in the list and makes it the current scene.

The currently logged on user can recall scenes at a security level equal to or lower than his or her own only.

[Detail] Button

Expands the dialog box and displays a preset parameters list. If you click the preset parameters
list while it is displayed, the preset parameters list will be hidden. When the dialog box is opened,
its status will be the same as the last time it was closed.

Not available for SP2060 groups.

[Del] Button
[Store] Button
[New] Button
[Del Unused] Button

*Scene Manager

Cut Copy Paste Thsert Clear | Recall Settings | Del | Store | New | Del Unused |
[DME Grovp ] [Preset —
Scene No. | Name Configuration | Edit Security | Recall Security | Fade | Fade Mode | Fade Time | Frotect il DMESNAD DME
00 BGM Gontral  Gonfig D O T 1O Presstonet
002 Gonvention Genter Gonfig Level 1 Level 1 OFF Al 00's OFF O Frosetii—z
03 [No Data] - - = = e 5 oo t
004 [No Data] i & 7z & g # T et
@ Fresetl4-1 = P P
s [No Data] - - = 2 5 2O Presetld-2 e reset Parameters
006 [MNo Data] 7 ] ] 7 i # - O Slot
il [No Data] - - = 2 5 @ Presetlé-1
008 [Mo Data] = & & = 5 # O Preseil4-2
e [No Datal - - = o= e & i
oo deow - - -tk Bty DME
11 [No Datal = ] = 7 & © Presetl4-1
2 [No Data] - ] 5 @ & # O Fresetl-2
3 Mo Dat - - = o= 5 &
oDt - : @ = = £ Component Preset Parameters
04 [No Data] © Presetils-1
015 [No Data] — 2] 2 & & O Presetll4-2
s [No Data] - & 5 @ & # &0 Slat
017 [No Data] — = 5 o i # © FPresetld4-1
g [No Data] - & 5 @ 5 # O Fresetlé-2
019 [Mo Data] = 3 & 7 = 5 & hd|
= A J
=S| __Beoall | ["Detebs
l
[Detail] Button Preset Parameters List
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B Preset parameters List

Displays the preset parameters for each DME unit in the scene selected in the list. When another
scene is selected on the list, the contents of the preset parameters list will be changed.

You can change the preset parameters used in the scene by clicking the radio buttons to the left of
the preset parameters names. You can also create, delete, and store preset parameters or change
their names.

DME

Displays the DME. Below the DME there are [Slot], [Component], and [AD]. If there are preset
parameters below them, a [+] button will be displayed. When you click the [+] it becomes a [-] and
the presets are displayed.

Preset parameters

Displays DME preset parameters.

If you click the preset parameters name, selecting the text that is there, you can change the preset
parameters name. When preset parameters are automatically created when a scene is stored, they
are named “Preset001,” “Preset002,” and so on. preset parameters created with the [New] button
are named “New Preset.”

You can select the preset parameters used in a scene by clicking the radio buttons to the left of the
preset parameters names.

[Del] Button
Deletes the preset parameters selected on the preset parameters list.

Presets used in a scene cannot be deleted.

[Store] Button

Stores the current parameter status in the preset parameters selected in the preset list. The
contents of the selected preset parameters will be overwritten.

[New] Button

Stores the current status and creates a new preset parameters. The newly created preset
parameters is named “New Preset1”, “New Preset2” etc.

[Del Unused] Button

Deletes unused preset parameters from DME units in the selected device group.

[Scene Link] Button

Opens “Scene Link Manager” dialog box.
Refer to “Scene Link Manager” on page 151
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User Control

User Controls

You can create an original control by arranging knobs and sliders in the component editor. Controls
you create are called “user controls.”

Those created user controls are displayed in the [View] — [User Control] submenu in the Main Panel
window

Refer to “User Control Editor/User Module Editor” on page 325 for information on user control editing.

“User Control Manager” Dialog Box

When you click [User Control Manager] on the [Tools] menu, the “User Control Manager” dialog box is
displayed. This dialog box displays a list of user controls included in the configuration of the current
device group. There they can be created or deleted. You can also edit the name and security level of
user controls here.

Security for the Logged On User

The currently logged-on user can create and edit the user controls of all users at lower security levels as well as the controls
specified for that user. Available user controls are displayed in the User Control manager dialog box that can be accessed
through the [User Control] sub-menu of the main panel window [View] menu.

The user control security level for each user is set with [Operation Security] — [User Control Level] in the “Security” dialog
box. For information about user security, see page 157.

Names and Functions

™= User, Control Manager, @

Open [ | Name | Security Level | User

Door Open--- Adriiniztratar
Light On  Level 3

[*] Open User Contral at startup.

New Delete | s | LCancel

Only controls available to the currently logged on user are shown in the list.

® Open

If this checkbox is checked, the user control will open automatically when the project file is opened.
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H Name

Displays the names of the user controls. Clicking here will select the characters in the name,
allowing you to change it.

= User Control Manager,

Open [7] | Mame | Security Lewvel | User

[Door Openl -
Light On Level 3

[*] Open User Control at startup.

New Delete | ak. LCancel

B Security Level

Displays the security level set for each user control.
Clicking here will display a list where you can change the security level.

[*] Open User Control at startup:

Hew Delete | s I LCancel |

m User

Displays the name of the user specified in User Control.
Clicking here will display a list of the available users.

=2 User Control Manager,

Open [ | Mame Securty Level | Usger |
v

Doar Open

: Light On Level 3 User name

Administrakor
O moon

O Morning

[*] Open Uszer Control at startup.

MNew Delate | Ok, Qk
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H [New] Button
Creates new user controls. Clicking here displays the “New User Control” dialog box.

Name ||

Security

+ Userlevel |Levell -

" User Name

Uszer Mame
Adrmiriztrator
boming
Might
Moan

[ Open Uzer Cantral at startup.

ak. LCancel

Enter the User Control name in the [Name] box.

[User Level])/[User Name]
Use the radio buttons to the left to select security-level or user dependent control.

e [User Level]
Select a security level from the drop-down list.

¢ [User Name]
Check a checkbox.
Click [OK] to create the specified User Control setup.

[Open User Control at startup]
If this checkbox is checked, the user control will open automatically when the project file is opened.

B [Delete] Button
Deletes the user control selected on the list.

B [OK] Button
Accepts the changed settings and closes the dialog box.

B [Cancel] Button
Closes the dialog box without changing the settings.
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[Global Link] button/[Local Link]/[Component Link] buttons
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Parameter Link

About Parameter Links

You can group parameters of the same type and link them. These groups are called “Parameter
Links.” When one parameter in a parameter link group is changed, all parameters in the parameter link
group will change in the same way.

There are three parameter link types: global links, local links and component links. Global links link
parameters for DMEs within a device group. Local links and component links link parameters that are
included for a single DME.

Parameters can not apply to multiple groups.

When a library is recalled, the linked parameters in other components will not change even if parameter linking is enabled.

Groups can be created and parameters added to groups in the user control/user module control
editor and component editor. For information about creating parameter links, see “Creating Parameter
Links” on page 368.

You can check the status of parameter links and edit them in the Parameter Link window.

Parameter Link Window

When you click [Parameter Link] in the [Tools] menu, the “Parameter Link” window is displayed. You
can also display the window by selecting [Open Parameter Link] from the context menu displayed in
the user control/user module editor and component editor.

Names and Functions

[Global Link] button/[Local Link] button/[Component Link] button
Switches the window display.

e Global Link
Links to the parameters of multiple DME units in the zone.

Recall Safe and Partial Recall settings (page 86) do not apply to linked parameters when a scene is recalled.

Because there is a large load on the network, the maximum number of Global Links will be limited to eight.
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e Local Link
Links to the parameters of one DME unit.

When a scene is recalled using Recall Safe or Partial Recall settings (page 86), linked parameters will be recalled
with the same settings.

e Component Link
Links component parameters of the same type within a single DME unit.

When a scene is recalled using Recall Safe or Partial Recall settings (page 86), linked parameters will be recalled
with the same settings.

Component Link cannot be used with SPX components.

Parameter Link Group List

Displays a hierarchical list of parameter link group and the parameters that belong to them.
When a parameter link group name is selected, the controls that belong to that parameter link
group are selected.

B SCEIES
Global Link Local Link Compaonent Link

Gilobal | Link. ‘ Keep Oftzet | Min | Max ‘
=T Grow? i
i BOMERI-G2
H & Crossover
L.Output1:1:Level ~INFINITY[dE] 0.00[HB]
=- P Group2 [on | Bee]

= BOMERI-C 2}

2-Crossover
iCenter1:1:Frequency 200[H2] 200k[Hz]
B ter2: - Frequency 200[Hz] 20.0k[Hz]

Center21:Frequency

¢ Group Name
You can select a parameter link group name by clicking on it. Clicking the selected parameter
link group name again will select the characters in the name, allowing you to change it.
Clicking the plus (+) or minus (-) sign to the left of the parameter link group name displays or
hides items that belong to that parameter link group.
You can delete a parameter link group by selecting it and pressing the <Delete> key. You can
also delete a parameter link group by right-clicking on the parameter link group name and
selecting [Delete] in the context menu that is displayed.

* DME Icon
Displays the DME that includes the parameters that belong to a parameter link group. The
components can be displayed or hidden by clicking the plus (+) or minus (-) signs for the
DME icon. The parameters, Min, and Max can be displayed or hidden by clicking the plus (+)
or minus (-) signs for the component.

* Link
Click to turn ON or OFF. Turn OFF to disable parameter linking.

Component linking for multiple parameters can be turned ON or OFF via the contextual menu
that appears when the group name is right-clicked.
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* Keep Offset
Click to urn ON or OFF. When “ON” the parameter offset is maintained so that when any
parameter in the group reaches its minimum or maximum value, further decrease or increase
is not possible.
Keep Offset for multiple parameters can be turned ON or OFF via the contextual menu that
appears when the group name is right-clicked.

* Parameter
Displays the parameters that belong to a parameter link group. You can display or hide
minimum and maximum values for a parameter by clicking the plus (+) or minus (-) signs.
You can delete a parameter from a parameter link group by selecting the parameter name and
pressing the <Delete> key.

Components for user modules are also listed in a hierarchal display, but if user module security is enabled, the
components are not displayed. However, parameters displayed in the user module editor are displayed here.
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Synchronization
(DME Designer and Unit Synchronization)

The DME or SP2060 unit and DME Designer are synchronized by Synchronization. The DME or
SP2060 operates according to the configuration and scene information transferred during this
process.

This Synchronization is used when transferring the configuration in DME Designer and when
controlling the DME or SP2060 unit in real time.

Because Synchronization presupposes that the DME or SP2060 unit can communicate with the computer where DME
Designer is installed, the necessary drivers (USB-MIDI or DME-N Network Driver) must be installed, and appropriate settings
must be made for the driver and for DME Designer communication ports (page 155).

For information about driver installation and settings, see “DME Setup Manual”. For DME Designer communications settings,
see “Online” (page 50).

Because there are no scene settings when the DME unit is purchased, the configuration and scene information in DME
Designer must first be transferred.

When combining DME64N/24N and DME Satellite units in a device group, be sure to assign a DME Satellite unit as the
device group master. Synchronization cannot be performed if a DMEG4N/24N is assigned as the device group master.

For information about the online procedure, see “Online” (page 50).

Online and Offline

When a DME or SP2060 unit is connected to the computer and synchronized with DME Designer, its
status is called “Online.” When a DME or SP2060 unit is not physically connected to the computer or
is not synchronized even when it is connected, its status is called “Offline.” You can check the online/
offline status and message transmission in [Communication Status] in the Main Panel window.

H Online

Sends configurations created in DME Designer to the DME or SP2060 unit and reads data from the
DME or SP2060 unit, so that the DME unit configuration is reflected in the DME Designer
configuration. You can also control the DME or SP2060 in real time from DME Designer. Operations
performed in the DME Designer control editor are reflected in the DME or SP2060 unit, and
operations on the DME or SP2060 side are reflected in DME Designer.

You can not perform configuration editing using the Designer while online.

m Offline
The communication status becomes offline when editing configurations.

B Switching Between Online and Offline
You can switch between online and offline in the “Synchronization” dialog box.

For information about the online procedure, see “Online” (page 50).
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“Synchronization” Dialog Box

When you click the [Synchronization] command on the [Tools] menu, the “Synchronization” dialog box
is displayed. The data from the current device group in the Designer is synchronized with the DME or
SP2060 unit.

Here you can make settings for synchronizing the unit in DME Designer one-on-one with the DME or
SP2060 that actually exists on the network.

When synchronization is executed the connections, components, and other data are automatically checked as part of the
compilation process. A progress bar will appear during compilation, but in some cases it may not exactly match the progress
of the compilation process. Also, the appearance of the progress bar is no guarantee that compilation will be completed
successfully. If compilation continues for an inordinately long period of time, click the [Abort] button to stop processing. Try
eliminating unnecessary components and connections, and replacing components that place a heavy load on resources
with more efficient ones, then compile again.

The Analyze function (page 308) can be used to check whether there are any problems with component layout or
connections without having to actually connect the DME unit. This is a convenient way to check for compile errors that might
occur at the time of synchronization.

Once a configuration has been analyzed or compiled successfully, subsequent analysis or compilation will run quicker
unless changes are made to the configuration. Also, if you save the project file the analysis/compilation data is saved as well.

Names and Functions

[Go On-line]Button  [Go Off-line]Button

= Synchronization

Go Off-line._|
Group | DME Groupl =
DME Designer Metwork
Device |IP Address IP Address Twpe |
DME4io-C 192168000004 1 972 168.000.004 DME4in-C
DMEZ24M 192168000007 R 102 168,000,007 DME24M
[Designer] = - [Network]
J
Message

Message Area =

[Close This window
after synchronization]
checkbox —f= v Close thiz window after synchronization

[Store Project File into DME —f~ v Store Froject File into DME after synchranization
after synchronization]
checkbox
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B [Group] List

Allows selection of a device group to be synchronized.

B [Go On-line] Button

This button will be grayed out when the software is online.
Clicking the button displays a dialog box where you can decide the synchronization method.

R Sync Direction

| DME Designer -» Device

DME Designer <- Device |

LCancel |

[DME Designer = Device] button

A consistency check is performed between the data in the current device group and the DME or
SP2060 data, then the communication status changes to online. Transmits data from the DME
Designer to the DME or SP2060 unit and synchronizes the two.

[DME Designer < Device] button

Data from the DME or SP2060 unit is read into DME Designer. Current data stored in the DME or
SP2060 unit, such as scenes, are read into DME Designer. The configurations in the DME unit and
DME Manager must identical to allow synchronization. If the configuration has been edited,
synchronization can only be achieved by using the [DME Designer -> Device] button. SP2060
configurations cannot be edited, so synchronization is always possible.

If the IP address of the DME device is changed after the device has been synchronized with DME Designer, it will be
necessary to re-transfer the configuration data. The “Full Resync” operation forces a re-transfer of all configuration data,
and can be initiated by clicking the [Go On-line] button while holding down the [Ctrl] key.

For details on backing up the DME or SP2060 data as a file, refer to “Backup” on page 183.

Project files can also be saved internally in the DME unit using the DME File Storage function (page 70). Synchronization
to DME or SP2060 units requires a project file. We recommend saving the project file to the DME unit itself to ensure that
the file is always available.

B [Go Off-line] Button
Clicking this button changes from online to offline. While offline, this button will be grayed out.

H [Close] Button
Closes the dialog box.

B [Close this window after synchronization] Checkbox
When this checkbox is checked the dialog window will close automatically after synchronization.

B [Store Project File into DME after synchronization] Checkbox

When this checkbox is checked the project file (.daf extension) will be automatically saved in the
DME unit after synchronization.
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B Designer

The Designer list displays DME or SP2060 units arranged in the currently valid device group in the
DME Designer.
The unit in the DME Designer is matched with a recognized IP address, and they are compared

one-to-one.
DME Desziener
Device IP Address
ME4io-C 192162000004
Device Name —nimE241 192168000007 f—— IP Address Select Box
DME Name

Displays the names of DME or SP2060 units included in the project.
When multiple DMEs and SP2060s of the same type are arranged in a zone window, it is a good
idea to change the name of each one.

IP Address Select Box

Matches the units in the Designer with recognized IP addresses. Click the [IP Address] column [V]
button to see a list of the IP addresses of all devices of the same type in the area. If the unitis a
DME24N, IP addresses for all DME24N devices in the area will be displayed on the list.

If you click the title bar with “IP Address” written on it (pale [A]/[¥] mark appears), you can line
them up vertically.

B Network

The devices currently connected to the network are displayed in the Network list. To keep
consistency with the Designer list on the left side, the status of DMEs on the network is displayed.

Mebwark,

| IP Address | Type |

Device Icon T1921EB.DDD.DD2 DHEBAM
¢ Device Icon

Displays DME, SP2060 and ICP1 devices connected to the network. The device group master
DME or SP2060 icon is red. Icons for slave DMEs and SP2060s are blue. DMEs and SP2060s
and ICP1 devices with no relation to DMEs and SP2060s in Designer have gray icons.

e |P Address
Displays the DME or SP2060 IP address.

IP Address

B Message Area
Displays a message that synchronization is in progress.
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Event Scheduler

“Event Scheduler” Dialog Box

When you click [Event Scheduler] in the [Tools] menu, the “Event Scheduler” dialog box is displayed.
This sets the scheduling for events. You can schedule events by specifying the date, time, and the
action to execute. You can set up schedules for events to be executed at a specified time, and events
that are to be repeated periodically. Periodic events are those that repeat each year, month, week, or
day. Up to 50 events can be scheduled. Scheduling can be set separately for each device group.
Settings and changes are sent to the DME unit during online status.

Scene changes, parameter changes, GPI output, and Wave file playback can all be scheduled.

Does not apply to SP2060 units

Only users for whom the [Edit] checkbox in the “Security” dialog box has been turned ON can edit scheduling settings.

Names and Functions

== Event Scheduler

[w Enable Event Scheduler

Add... | Edit... | Bermove | LCopy | Paste |

Mo, | Mame | Operation | Date | Time |
o Opening Scene Change 001:5cene 001 Sunday every week 08:00:00
02 Ending Scene Change 002:5cene 002 Sunday every week  20:53:00
03 Maintenance Scene Change 003:5cene 003 4/23/2007 05:00:00

Clock getup Apply | ok | Lancel

H Event View

Displays registered scheduling events. When periodic events (cyclical events) are first displayed
together, they are displayed in order of date.

The order of same-time events can be changed by dragging and dropping.

Click to select an event.

H [No.]
Displays the event number. Numbers are added from the top in order.
This function will not be executed if the checkbox is not checked.

H [Name]

Displays the event names. Clicking an event will select it, allowing you to change its name. There is
no limit to the number of characters.
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B [Operation]

Displays the function that will be executed when the event starts.

H [Date]

Displays the event start date.
Periodic events are displayed as shown below, with an icon and text that indicate a periodic event.

* [January 1 every year]
Each New Year's Day

e [First Monday of January every year]
First Monday in January each year

* [Day 1 every month]
First day of each month

* [Second Monday of every month]
The second Monday of each month.

¢ [Monday every week]
Each week on Monday

* [Every day]
Every day

[Time]

Displays the time for starting the event.

Group List

selects the device group for which events are to be specified/displayed. Only events for the
selected device group will appear in the window.

[Enable Event Scheduler]
Enables the scheduled events.

[Add] Button

Adds an event. Clicking here displays the “Add Event” dialog box. If the maximum of 50 events has
already been registered, this button is grayed out.

[Remove] Button
Deletes the event selected on the list. This button is grayed out when no event is selected.

[Edit] Button

Lets you edit the selected event. Displays the “Edit Event” dialog box. This button is grayed out
when no event is selected.

[Copy] Button

Copies the selected event. This button is grayed out when no event is selected.

[Paste] Button

Pastes the copied event. The event is added. This button is grayed out when no event has been
copied.
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B [Clock setup] Button

Opens the “Clock” dialog box to set the DME internal clock.
- See “Clock” on page 180.

H [Apply] Button

Applies any current setting changes.

B [OK] Button
Applies any setting changes and closes the window.

B [Cancel] Button
Closes the window without changing any settings.

[Add Event (Edit Event)] Dialog Box

The dialog box is displayed when you click on the [Add] or [Edit] button in the “Event Scheduler”
dialog box. Here you can add or edit a scheduling event.

™2 Add Event

Event Name ||

Event Dperation

Operation | Scene Change A

Operation Setting

Scene | 001:5cene 001 -

Ewent Schedule

Sun Mon Tue'Wed Thu Fri Sat
1
2 3 4 5 & F 8
3 10 11 12 13 14 15
16 17 18 13 20 1 2
23 024 25 % ERN
N
T Today: 10/28/2005

Time
00:00:00 5 [hemincsec)

[~ Bepeating Event

i :Z:th o [ap |Januar_l,l J |'| J
" Weck
" Day  Day of the week |Januar_l,l J |First J | Sunday J
" Hour
Exception
ak Lancel |

B [Event Name] Box
Enter the event name. There is no limit to the number of characters.
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B [Event Operation]
Set the operation that is executed when the event starts.

[Operation]

When you click this button, a list of events is displayed. Specify the operation that is executed
when the event starts.

The following four items are on the list:

* [Scene Change]
Changes the scene.

* [Parameter Value Edit]
Changes a parameter.

If user module security is enabled, the components are not displayed. However, parameters displayed in the user
module editor are displayed here.

e [GPI Out]
Sends GPI output.

* [Play Wav File]
Allows initiation of Wave file playback.

[Operation Setting]
The content changes according to the event selected for [Operation].

* When [Scene Change] is selected:

Event Operation

Operation | Scene Change &=

Operation Setting
001:5cene 001

| 001:Scene 001

002:5cene 002

Scene

Select the scene to be recalled from the [Scene] list. Stored scenes are displayed in the list.

e When [Parameter Value Edit] is selected:

Event Cperation

(S CIEW Parameter Walue Edit Jid

Operation Setting

Scene [ 00 Scene 0m | DME | oME2aM

Ei
Companent | Camponent-Unit Cutput | Parameter [OutT1 Level |
]

Valus 000 B

[Scene]

Select a scene from the list.

If the DME unit's current scene differs from the scene specified in event scheduling, the scheduled
scene will be recalled. If the DME unit's current scene is the same as the scene specified in event
scheduling, the scheduled scene will not be recalled.

[DME Unit]
From the list, select the DME unit to which this scheduled event will apply. The DMEs included in the
zone are displayed in the list.
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[Component]
Select the component that has the parameter to be changed. The list displays the components
arranged for the DME that is selected in the [DME Unit] box.

[Parameter]

Select the parameter that will change. Parameters for the component that is selected in the
[Component] box are displayed in a list.

[Value]
Set a value for the parameter. Change the parameter using the spin buttons or the slider on the right.

e When [GPI Out] is selected:

Operation Setting

OME | DMEG4N =

Portl [Port2 [Port3 [Ports [Ports [Ports |Port? |Ports |Ports |PortiD |Portt

Statuz |- il e . iind e - i e ail iind
| | 2

[DME]
From the list, select the DME where you will be making settings.

[Port1]/[Port2]/[Port3] ...

Set [ON], [OFF], or [---] for each port. If it is set to [OFF], the [LOW—HIGH] port outputs
[HIGH—LOW] signal, the [HIGH—LOW] port outputs [LOW—HIGH] signal.

* When [Play Wav File] is selected:

Ewvent Cperation

Operation [FEIEW

Operation Setting

Seene [001:Scene 001 =]
tWave [DEGEHIT Openine

[Scene]
Select a scene from the list.

[Wave]

Select a Wave file from the list.
Wave files set by the Wav File manager can be specified. Files can not be selected unless a Wav File
Player is included in the DME configuration.
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B [Event Schedule]

Set the year/month/date to start the event.

Event Schedule

Sun Mon Tue Wed Thu Fri Sat
1
2 3 4 5 B 7 8
9 10 11 12 13 14 15
16 17 18 13 20 21 2
23024 X % TERM
nm AN
T Today: 10/28/2005

Time
000000 & (heminsec)

[~ Bepeating Event

& Year
£ Morth = Day |January J |1 J

O Week
" Day " Day of the week |January J |Firsl J ‘Sunday J

¢ Hour
Ewxception

Calendar

Sets the date the event will start.
Change the year and month using the [<] and [>] buttons. Click on a day to set that date. February
29 can be set on the calendar, where it appears every four years (each leap year).

[Time]

Sets the time the event will start.

Click the hour and minute, then set numerical values using the spin boxes.
Only the time is set for periodic events.

[Repeating Event]
When a check is placed here, the event becomes a periodic event, and the calendar is ignored.
¢ [Year])/[Month]/[Week]/[Day]/[Hour]
Set the period for the event, using the radio buttons to the left.
* [Day]/[Day of the week]
Set the conditions on the right side. Select [Day]/[Day of the week], and set the date and other
information. The items that can be set vary according to the selected period.
When the event period is [Year]
All settings can be made.

When the event period is [Month]

If [Day] is selected, only the date can be set.
If [Day of the Week] is selected, settings such as “the third Sunday” or “the first Monday” can be
made.

When the event period is [WeekK]
Only [Day Of The Week] can be selected. Set the day of the week.

When the event period is [Day]/[Hour]

Condition settings on the area on the right are not needed.

[Exception] Button
Opens the “Event Exceptions” dialog box.

[OK] Button
Applies any setting changes and closes the window.

[Cancel] Button
Closes the window without changing any settings.
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Specifies “exception” year/month/day and time settings at which events will not be executed.

Sun Mon Tue Wed Thu Fri Sat
. 1
2 3 ¢4 5 B P8
7 Day 3 10 11 12 13 14 15
16 17 18 19 20 21 22
23 024 5 2% X ERN
1 i
T Today: 10/28/2005

& Year 2005 z
" Month ,m
C wissk [Fistweek -]
€ Day of the week ,WJ
" Hour oo T

The available settings will depend on the event cycle.

* When the event cycle is [Year]
Only the [Year] setting is available.

* When the event cycle is [Month]

Only the [Month] and [Week] setting is available.

* When the event cycle is [Week]

Only the [Month], [Week] and [Day] settings are available.

* When the event cycle is [Day]

Only the [Month], [Week], [Day], and [Day of the week] settings are available.

* When the event cycle is [Hour]

Only the [Month], [Week], [Day], [Day of the week], and [Hour] settings are available.

DME Designer Owner’s Manual

107



Chapter 3 Main Panel Window

Wav File Manager

When you click [Wav File Manager] on the [Tools] menu, the “Wav File Manager” dialog box is
displayed. Here you can manage playback settings for Wave files played in the Wav File Player. This is
set for each DME. The setting can be made only when in offline status. Up to 100 Wave files can be
managed.

If a Wave file is added that exceeds the memory limit, a warning message will be displayed.

Does not apply to SP2060 units

These settings can be edited only by users for whom the [Edit] checkbox in the “Security” dialog box has been turned ON.

Only Wave files with file names of 31 characters or less, (including the extension) can be registered. Check the Wave file
name beforehand. Change the name if it has 32 or more characters, including the extension.

When saving project files including Wave files, select “Project File with wave (*.daf)” in the file save dialog box.

Names and Functions

2 Wav File Manager

DME | DME Groupl/DME24N j
Library Store Recall Add... Bemove |

[o01 | Iove Up
002 |MOTIFY NOTIFYMAY (1180 | 0j0s OFF Stop

03 Move Down
004

005 Play
006

on7 i
008

on9

oin

o1

012

013

014

15

016

o1y

018

19

020

021

TT ‘L,j Remaining Memary

256 MB
QK ‘ Cancel

m [DME]

From the list, select the DME where you will be making settings.
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B [Wave File]

Displays the Wave file information. Settings can be made here as well.

[No.]
The Wave file number is displayed in the leftmost column. Numbers are added from the top in
order.

[List Name]

You can set up to 27 characters as a label separate from the Wave file name. The Wave file name is
displayed here by default.

[File Name]
Up to 31 characters are displayed as the wave file name.

[Size]
Displays Wave file size information. The units vary, depending on the file size. The size is displayed
to the first decimal.

Size Display
Up to 1023 bytes 0.X KB
1024 bytes to 1023.9 kilobytes XXX.X KB
1024 kilobytes or more XX MB

[Repeats]

Sets the number of repeats for playback.

Clicking here will display a list where you can select the number of times.
Select [0] to [98] or [INFINITY].

Since external input cannot be edited, [---] is displayed.

[Interval]

Sets the time until the next playback when [Repeats] is set to a value higher than 1. If you click
here, a list will be displayed. You can set [0] to [99].
Since external input cannot be edited, [---] is displayed.

[Auto Start]

Turns automatic playback ON or OFF. When ON, playback begins automatically when the file is
loaded.
If you click here, a list will be displayed. Select [ON] or [OFF].

[Next No.]
Specifies the number for the Wave file to be played next.
If you click here, a list will be displayed. Select the number for the Wave file to be played next.
* [Stop]
This stops playback after this Wave file is finished playing, without specifying the next wave

file.
Since external input cannot be edited, [---] is displayed.

B [Store] Button

Saves the current settings in the “Wav File Manager” dialog box in a file, as a library. Clicking here
displays the file save dialog box.
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B [Recall] Button

Reads a saved library.
Clicking this button displays a menu. A menu displays library files saved in the folder that has been
set as the Contents Folder. Click the library to be read.

[Open File Dialog]

Displays the file select dialog box. You can select a library file that is saved in the folder set as the
Contents Folder, and read it.

[Add] Button

When you click here, External Input and the file select list is displayed.

To add a Wave file, select the row to which it is to be added and click the [Add] button.

It is also possible to add Wave files by dragging and dropping the files from the desktop directly
onto the list in the “Wav File Manager” window.

[Wave File]

The file selection dialog box is displayed, where you can select a Wave file.

If the selected table already has data, an overwrite confirmation message is displayed.

[External Input]

Sets [External Input].

You can select multiple Wave files. If multiple files are specified, they are added after the selected
table. If a Wave file is registered to the number being added, it will be overwritten.

The following Wave file formats are supported: 48, 44.1, 24, 22.05 kHz, 16bit/8bit, Mono/Stereo. If a

file is selected with a format different than these, a message is displayed that says the file cannot
be used.

There is an upper limit to size beyond which a file cannot be used. This limit varies according to the
format. If the size of the selected file is beyond the limit, a message is displayed that says the file
cannot be used.

Maximum Size Per File and Playback Time

DMEG64N/24N DME Satellite

(Memory Limit: 25.8M) (Memory Limit: 11.8M)
. Mono 3.6 Mbyte 174 sec 1.3 Mbyte 65 sec
25,05 kHz 8bit Stereo 7.3 Mbyte 174 sec 2.7 Mbyte 65 sec
. Mono 7.3 Mbyte 174 sec 2.7 Mbyte 65 sec
16bit Stereo 14.7 Mbyte 174 sec 5.5 Mbyte 65 sec
. Mono 4.0 Mbyte 174 sec 1.5 Mbyte 65 sec
8bit Stereo 8.0 Mbyte 174 sec 3.0 Mbyte 65 sec
24 kHz . Mono 8.0 Mbyte 174 sec 3.0 Mbyte 65 sec
6ot Stereo 16.0 Mbyte 174 sec 6.0 Mbyte 65 sec
. Mono 7.3 Mbyte 174 sec 2.7 Mbyte 65 sec
A [ 8bit Stereo 14.7 Mbyte 174 sec 5.5 Mbyte 65 sec
. Mono 14.7 Mbyte 174 sec 5.5 Mbyte 65 sec
1ebit Stereo 25.8 Mbyte 153 sec 11.0 Mbyte 65 sec
o Mono 8.0 Mbyte 174 sec 3.0 Mbyte 65 sec
48 kHz Stereo 16.0 Mbyte 174 sec 6.0 Mbyte 65 sec
16bit Mono 16.0 Mbyte 174 sec 6.0 Mbyte 65 sec
Stereo 25.8 Mbyte 140 sec 11.8 Mbyte 64 sec

The values in the above chart are all approximate. Playback time will also vary according to the Wave file format.

When a Wave file is played back while the DME is set to operate at 88.2 kHz or 96 kHz, only the OUT1 output of the Wav
File Player will be delivered via the Left channel. There will be no output from OUT2.
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[Remove] Button

Deletes settings from the selected line. This button is grayed out when no Wave file is selected in
the list.

[Move Up] Button

Moves the selected line up one. It is switched with the line immediately above.
The button will be grayed out if nothing is selected in the list, or if [No. 1] is selected in the list.

[Move Down] Button

Moves the selected line down one. It is switched with the line immediately below.
The button will be grayed out if nothing is selected in the list, or if [No. 100] is selected in the list.

[Play] Button

Plays the selected Wave file on the computer. Allows monitoring and checking of the Wave file.

[Stop] Button
Stops playback of the Wave file.

[Remaining Memory]
Displays the amount of available Wave file memory.

[OK] Button

Updates the settings and closes the dialog box.

[Cancel] Button
Closes the dialog box without changing the settings.
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GPI
About GPI

GPI is an abbreviation for General Purpose Interface. Using GPI input and output, DMEs can be
remotely controlled from custom-made controllers or external equipment. The number of GPI ports
depends on the type of device. Sets GPI input/output for each DME.

Using GPI input data, you can switch DME scenes and change component change component
parameters.

Refer to the DME owner’'s manual for information on making GPI connections and other hardware-
related issues.

Only users for whom the [Operation Security] — [Edit] checkbox has been checked can make GPI settings.

This cannot be set when online.

Does not apply to SP2060 units

GPI Input/Output Setup Example

B Control Faders (Levels and On) via a CP4SF

A CP4SF control panel connected to the GPI terminal can be used to control the faders (Level and On
parameters) of Fader and Mixer components.

By assigning the component's Level and On parameters via the Parameter Value Edit function in the
GPI IN field it becomes possible to use the CP4SF faders and switches to control the assigned Level
and On parameters. If the port assigned to the Level parameter is set to [Min]=-INFINITYdB,
[Max]=10.00dB, [Terminal]= 1, the parameter will be controlled in proportion to the input voltage (=
fader position). The minimum input voltage will produce a level setting of -cdB, and the maximum
input voltage will produce a level setting of 10.00dB. If the port assigned to the On parameter is set to
[Min]=0FF, [Max]=0N, [Terminal]=0?, the parameter will toggle between ON and OFF each time the
input voltage goes from low to high (= the moment that the switch is pressed).

By assigning the component's On parameter via the Parameter Value Edit function in the GPI OUT
field, the CP4SF switch LED can be toggled by the ON parameter. If [Terminal] is set to 1®, a high level
will be output when the On parameter is on, lighting the LED.

GPIIM
Function Parameter Min | (L | Teminal | -
Part1 Parameter Value Edit | ComponentFaderFader1:1:Level |-NFINITYdE |10.00d8 |
Port2 | Parameter Yalue Edit | ComponentFaderFader2:1:Level |-INFINITvdE [10.00d8 |1
Port2 | Parameter Value Edit | ComponentFaderFader:2:1:Level |JNFINITYdE |10.00d8 |1
Port4d | Parameter Yalue Edit | ComponentFaderFader4:1:Level |-INFINITvdE [10.00d8 |1
Porth | Parameter Value Edit | Component:Fader.Fader1:1:0n OFF ul] o
Porte | Parameter Value Edit | Component:Fader Fader:2:1:0n OFF aM e
Port? | Parameter Value Edit | Component:Fader.Fader:3:1:0n OFF ul] o
Port8 | Parameter Value Edit | Component:Fader Fader:4:1:0n OFF aM e =
GPIOUT
Function Parameter Threshald | Terminal | Folarity |Event 8=
Part1 Parameter Yalue Edit | Component:FaderFader1:1:0n 05
Port2 | Parameter Value Edit | Component:FaderFader:21:0n 0502
Port3 | Parameter Value Edit | Component:FaderFader:3:1:0n 05
Portd | Parameter Value Edit | Component:FaderFader:4:1:0n 0502
Ports | Mo Assign g
Porte Mo Assign r?
Port? | Mo Assign g -
< s o
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B Control Source Selection via a CP4SW

A CP4SW control panel connected to the GPI terminal can be used to switch the channel source of
Source Selector (Position 4) components.

Assign the Source Selector component's Position parameter via the Parameter Value Edit function in
the GPI IN and GPI OUT fields and set the parameter values ([Max] in the GPI IN field, and [Threshold]
in the GPI OUT field) to 1 through 4 for the corresponding ports. The CP4SW switches will then select
the corresponding channel sources, and the corresponding switch LED will light.

[Terminal] in the GPI IN field cannot be altered. If [Terminal] in the GPI OUT field is set to 1?, a high
level voltage will be output and the LED will light when the Position parameter matches the [Threshold]
setting.

GPIIN
Function Parameter ‘ Min ‘ Mar ‘ Terminal | -
Part] Direct Parameter Walue | Component:Source SelectorPosition: 1:1: Position |- 13
Part2 | Direct Parameter Yalue | Component: Source Selector:Position: 1:1:Position | 2
Fort3 | Direct Parameter Y¥alue | Component:Source S electorPosition:1:1:Position |- i
Portd | Direct Parameter Yalue |ComponentSaurce Selectar:Position: 1:1:Pasition |- ar¥
Paorts  |No Assign
Porte | Mo Assign
Port?  |Ma Assign
Paort8  |No Assign j
GPIOUT
Function Parameter Threshold ‘ Terminal | F+
Part] Direct Parameter Walue | Component Source SelectorPosition: 1:1: Position 13
Paort2 | Direct Parameter Yalue | Component: Source Selector:Position: 1:1: Position 2
Port3 | Direct Parameter ¥alue | Component: Source 5 elector:Position: 1:1:Position i
Portd | Direct Parameter Walue | Component:Saurce Selectar:Position: 1:1:Pasition ar¥
Potf  |Mo Assign g
Ports | Mo Assign 3
Port? Mo &ssign o -
d i

“GPI” Dialog Box

When you click the [GPI] command on the [Tools] menu, the “GPI” dialog box is displayed. Sets GP!I
input/output for the DME.

Names and Functions

Contguraton
[DME] — ov [ -| . fig
GFLIN
Function | Parameter i | M Terminal
Parameter Vahe [dn  ComponentComore OFF N T
I |Seers Change (0 Seere (01 T
Play W File 001 Opening T
Mo Azsen
Mo Ascien
Na Assen

Partl |Mo Azeun

Facammter [Thumctold | Termeal [Fotarity [ Ubsm Dbrsd Butiors | Everst Logger = |
e o | Poturiy : J vent Logys
r
-
o
-
o
»
o
-
o
o
o
s
o =1
i ! =|
g L s
Lo o] foe |
| |
[Apply] [Cancel]
Button Button
[OK]
Button
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m [DME]

From the list, select the DME where you will be making settings.

B Configuration
The current configuration name will be displayed.

® GPIIN

The DMEG4N has 16 GPI IN channels, and the DME24N/DME Satellite has 8 GPI IN ports.
These settings determine which DME parameters will be controlled by input received at each
individual GPI IN port. The port numbers are shown in the leftmost column.

[Function]

Specifies the function to be controlled by GPI input. Click to see a list from which you can choose
the function to be assigned to the corresponding GPI IN port.

The ten available functions are: [No Assign], [Parameter Value Edit], [Direct Parameter Value],
[Scene Change], [Scene Increment], [Scene Decrement], [Mute], [GPI Lock], [Time Adjustment],
[Play Wav File].

The [Parameter], [Min], [Max], and [Terminal] items will change according to the selected function.

GPI 1M
Function | Pararneter | Min | Max | Teminal | =]
Partl Pararneter Value Edit Component Delay-Le INFINITYdR | 00048 |
Port2 | Direct Parameter Value Component:Delay-L - 0.00de Lr?
Portd | Mo Assign T
Parts Etaram;ter W alue E.-di: T
Pors_jpielbaaE ke 1
:Scene Change
Part? Scene Increment T
Portg | Scene Decrement T
Port3 El;:i v T b
ocl
[Paiily Time Adjustment
Pl | Play wav File
Porl2  |Mo Assign j

* [No Assign]
No function assigned. This is the default setting.
Select [No Assign] to clear an assigned function.
The [Parameter], [Min], [Max], and [Terminal] items are not available.

e [Parameter Value Edit]
Allows component parameters to be changed via GPI input.
In this case [Parameter] is used to select the parameter to be controlled.
[Min] and [Max] specify the range over which the parameter can be changed.
[Terminal] determines how the GPI input voltage will affect the specified parameter.

Components for user modules are also listed in a hierarchal display, but if user module security is enabled, the
components are not displayed. However, parameters displayed in the user module editor are displayed here.

T and J specify continuous control of continuously-variable parameters from an external
fader, knob, or similar device.
I? and W specify on/off control of 2-state parameters via an external switching device.
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T

The parameter value changes in proportion to the voltage applied to the GPI input.

The minimum voltage applied to GPI IN will produce the specified [Min] parameter value, and the
maximum voltage applied to GPI IN will produce the specified [Max] parameter value, with
intermediate voltages produced the corresponding intermediate parameter values.

Example: Relationship between the voltage applied to GPI IN and the Fader Level when [Fader Level]
is set in the [Parameter] box.

Max. voltage applied to GPI IN —— [Max] parameter value

[Min] parameter value
Min. voltage applied to GPI IN

4

The parameter value changes in inverse proportion to the voltage applied to the GPI input.

The minimum voltage applied to GPI IN will produce the specified [Max] parameter value, and the
maximum voltage applied to GPI IN will produce the specified [Min] parameter value, with
intermediate voltages produced the corresponding intermediate parameter values.

Example: Relationship between the voltage applied to GPI IN and the Fader Level when [Fader Level]
is set in the [Parameter] box.

Max. voltage applied to GPI IN —— [Min] parameter value

[Max] parameter value
Min. voltage applied to GPI IN

n

The specified [Min] and [Max] parameter values are alternately selected each time the voltage
applied to GPI IN rises from below to above the median voltage.*

Example: Relationship between the voltage applied to GPI IN and the Fader Level when [Fader Level]
is set in the [Parameter] box.

Max. voltage applied to GPI IN

Median voltage

Min. voltage applied to GPI IN

[Max] parameter [Min] parameter value  [Max] parameter value

1L

The specified [Min] and [Max] parameter values are alternately selected each time the voltage
applied to GPI IN drops from above to below the median voltage.*

Example: Relationship between the voltage applied to GPI IN and the Fader Level when [Fader Level]
is set in the [Parameter] box.
[Min] parameter value [Max] parameter value  [Min] parameter value

Max. voltage applied to GPI IN

Median voltage

Min. voltage applied to GPI IN

¢ [Direct Parameter Value]
Sets component parameters to a specified value. Select the parameter to be set via

[Parameter], and [Max] sets the parameter value. [Min] and [Terminal] are unavailable.
When the voltage at the GPI input changes from below to above the median voltage, the

parameter is set to the value specified by [Max].
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* [Scene Change]
GPI input can be used to recall a specified scene.
[Parameter] specifies the number of the scene to be recalled.
[Min] and [Max] are not available.
[Terminal] determines how the GPI input voltage will affect the specified parameter.

T

The scene specified by [Parameter] will be recalled each time the voltage applied to GPI IN rises
from below to above the median voltage.*

Max. voltage applied to GPI IN

Median voltage

0

The scene specified by [Parameter] will be recalled each time the voltage applied to GPI IN drops
from above to below the median voltage.”

Min. voltage applied to GPI IN

Trigger

Max. voltage applied to GPI IN

Min. voltage applied to GPI IN

n

Same as T.

1

Same as &.

* [Scene Increment]
GPI input can be used to increment the scene number.
[Parameter], [Min], and [Max] are not available.
[Terminal] determines how the GPI input voltage will affect the specified parameter.

T

The scene number will be incremented each time the voltage applied to GPI IN rises from below to
above the median voltage.”

Max. voltage applied to GPI IN

Median voltage

. 2

The scene number will be incremented each time the voltage applied to GPI IN drops from above to
below the median voltage.*

Min. voltage applied to GPI IN

Trigger

Max. voltage applied to GPI IN

Median voltage

Min. voltage applied to GPI IN

I

Same as T.

1

Same as 4.
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* [Scene Decrement]
GPI input can be used to decrement the scene number.
[Parameter], [Min], and [Max] are not available.
[Terminal] determines how the GPI input voltage will affect the specified parameter.

T

The scene number will be decremented each time the voltage applied to GPI IN rises from below to
above the median voltage.”

Max. voltage applied to GPI IN

Median voltage

0

The scene number will be decremented each time the voltage applied to GPI IN drops from above to
below the median voltage.”

Min. voltage applied to GPI IN

Trigger

Max. voltage applied to GPI IN

Min. voltage applied to GPI IN

r

Same as T.

1

Same as &.
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e [Mute]
GPI input can be used to engage or disengage the DME mute function.
[Parameter], [Min], and [Max] are not available.
[Terminal] determines how the GPI input voltage will affect the specified parameter.

T
Mute will be ON when the voltage applied to GPI IN is above the median voltage*, and OFF when the
voltage is below the median.

Max. voltage applied to GPI IN
I - ,,,,,,,, Median voltage

Mute OFF Mute OFF
Min. voltage applied to GPI IN

.
Mute will be OFF when the voltage applied to GPI IN is above the median voltage*, and ON when the
voltage is below the median.

Max. voltage applied to GPI IN

Mute OFF
Median voltage

Min. voltage applied to GPI IN

I
Mute will be alternately turned ON and OFF each time the voltage applied to GPI IN drops from
below to above the median voltage.”

Max. voltage applied to GPI IN

Median voltage

Min. voltage applied to GPI IN

ON OFF ON

1
Mute will be alternately turned ON and OFF each time the voltage applied to GPI IN rises from above
to below the median voltage.”

ON OFF ON

Max. voltage applied to GPI IN

Median voltage

Min. voltage applied to GPI IN
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¢ [GPI Lock]
GPI Lock can be turned on or off via GPI input. When GPI Lock is ON, all GPI inputs other than
the one being used for GPI Lock control are locked and input will be ignored.
[Parameter], [Min], and [Max] are not available.
[Terminal] determines how the GPI input voltage will affect the specified parameter.

T
GPI lock will be ON when the voltage applied to GPI IN is above the median voltage*, and
OFF when the voltage is below the median.

Max. voltage applied to GPI IN
I - ,,,,,,,, Median voltage

Lock OFF Lock OFF
Min. voltage applied to GPI IN

. 2
GPI Lock will be OFF when the voltage applied to GPI IN is above the median voltage*, and
ON when the voltage is below the median.

Max. voltage applied to GPI IN

Lock OFF
Median voltage

Min. voltage applied to GPI IN

I
GPI Lock will be alternately turned ON and OFF each time the voltage applied to GPI IN drops
from below to above the median voltage.*

Max. voltage applied to GPI IN

Median voltage

Min. voltage applied to GPI IN

ON OFF ON

1
GPI Lock will be alternately turned ON and OFF each time the voltage applied to GPI IN rises
from above to below the median voltage.*

ON OFF ON

Max. voltage applied to GPI IN

Median voltage

Y Y
Min. voltage applied to GPI IN I
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* [Time Adjustment]
GPI input can be used to adjust the DME internal clock as follows:

Internal clock time Time after adjustment
0~14 seconds Returned to 0 seconds
15~29 seconds Advanced to 30 seconds
30~44 seconds Returned to 30 seconds
45~59 seconds Advanced to 0 seconds

[Parameter], [Min], and [Max] are not available.
[Terminal] determines how the GPI input voltage will affect the specified parameter.

1+ and I specify continuous control of continuously-variable parameters from an external
fader, knob, or similar device.
I and by specify on/off control of 2-state parameters via an external switching device.

T

The internal clock time will be adjusted each time the voltage applied to GPI IN rises from below to
above the median voltage.”

Max. voltage applied to GPI IN

Median voltage

Min. voltage applied to GPI IN
. 2

The internal clock time will be adjusted each time the voltage applied to GPI IN drops from above to
below the median voltage.”

Trigger

Max. voltage applied to GPI IN

Min. voltage applied to GPI IN

n

Same as T.

1L

Same as 4.
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* [Play Wav File]
GPI input can be used to initiate playback of the specified Wave file.
[Parameter] specifies the Wave file to be played. Files specified by the Wav File Manager can
be selected. Wave files can only be selected if a Wav File Player is included in the DME
configuration.
[Min], and [Max] are not available.
[Terminal] determines how the GPI input voltage will affect the specified parameter.
4+ and I specify continuous control of continuously-variable parameters from an external
fader, knob, or similar device.
I and b specify on/off control of 2-state parameters via an external switching device.

T
The specified Wave file will be played each time the voltage applied to GPI IN rises from below to
above the median voltage.”

Max. voltage applied to GPI IN

Median voltage

Min. voltage applied to GPI IN

4

The specified Wave file will be played each time the voltage applied to GPI IN drops from above to
below the median voltage.*

Trigger

Max. voltage applied to GPI IN

Min. voltage applied to GPI IN

n

Same as T.

1L

Same as &.

* “Median voltage” refers to the voltage halfway between the maximum and minimum voltages detectable by the GPI
input terminals. Refer to the DME owner’s manual for details on GPI voltages.
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® GPI OUT

The DMEB4N has sixteen GPI OUT ports, the DME24N has eight, and the DME Satellite has four.
These settings determine which DME parameter values will be output via each individual GPI IN
ports. The ports numbers are shown in the leftmost column.

[Function]

Specifies the function to be transmitted via a GPI output.

The six available functions are: [No Assign], [Parameter Value Edit], [Scene Change], [GPI Lock],
[Direct Parameter Value], and [Audio Detector].

The [Parameter], [Threshold], [Terminal], and [Polarity] items will change according to the selected

function.

GPI OUT
Function | Parameter Threzhold Terminal Folarity Evel
Port2 | Mo Aszsign o
Part3 o
Portd Scene Change P

GPI Lock

Direct Parameter Walue
Audio Detector

¢ [No Assign]
No function assigned, and no GPI output will occur. This is the default setting.
Select [No Assign] to clear an assigned function.
The [Parameter], [Threshold], [Terminal], and [Polarity] items are not available.

* [Parameter Value Edit]
Allows component parameter values to be output via GPI.
[Parameter] selects the parameter to be output via the GPI OUT terminals.
[Threshold] specifies the parameter threshold value.
[Terminal] and [Polarity] determine how the GPI voltage will be output in response to
parameter changes.

Terminal

Polarity GPI Output

r

Ignored When value of the specified parameter is above the threshold level the output
will be high, and when below the threshold level the output will be low.

1,

Ignored When value of the specified parameter is below the threshold level the output
will be high, and when above the threshold level the output will be low.

T A pulse*1 will be output when the value of the parameter changes from below
to above the threshold.

A pulse*1 will be output when the value of the parameter changes from above
to below the threshold.

to above the threshold.

4
T A pulse*2 will be output when the value of the parameter changes from below
.

A pulse will be output when the value of the parameter changes from above
to below the threshold.
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* [Scene Change]
The recall status of the specified scene is transmitted via GPI output.
[Parameter] specifies the scene for which the recall status is to be output.
[Threshold] and [Polarity] are not available.
[Terminal] determines how the GPI voltage will be output in response to parameter changes.

Terminal GPI Output

i) When the current scene is the same as the scene specified by [Parameter] the output will be
high, and when different the output will be low.

1y When the current scene is the same as the scene specified by [Parameter] the output will be
low, and when different the output will be high.

I A pulse™! will be output when the current scene is the same as the scene specified by
[Parameter].

1 A pulse™ will be output when the current scene is the same as the scene specified by
[Parameter].

* [GPI Lock]

The GPI Lock status is transmitted via GPI output.
[Parameter], [Threshold], and [Polarity] are not available.
[Terminal] determines how the GPI voltage will be output in response to parameter changes.

Terminal GPI Output
I When GPI Lock is ON the output will be high, and when OFF the output will be low.
1y When GPI Lock is ON the output will be high, and when OFF the output will be low.

¢ [Direct Parameter Value]
GPI output is produced when a component parameter reaches a specified value. [Parameter]
sets the parameter name. [Threshold] sets the parameter value. [Polarity] is unavailable.
[Terminal] specifies the type of GPI output produced.

Terminal GPI Output
I A high level is output when the value specified by [Parameter] is equal to [Threshold].
1y A low level is output when the value specified by [Parameter] is equal to [Threshold].
I Pulse waveform 1 (*1) is output at the instant the value specified by [Parameter] becomes
equal to [Threshold].
1P Pulse waveform 2 (*2) is output at the instant the value specified by [Parameter] becomes
equal to [Threshold].

* [Audio Detector]
The audio signal status detected by the Audio Detector component is output via GPI OUT.
[Parameter] selects the Audio Detector component that will produce GPI output according to
the detected audio signal status. [Terminal] and [Polarity] specify the type of GPI output

produced.
Terminal Polarity GPI Output

I Ignored High level while an audio signal is detected, low level while no audio signal is
detected.

1y Ignored High level while no audio signal is detected, low level while an audio signal is
detected.

I T Pulse waveform 1 (*1) is output when the status changes from no audio signal
detected to audio signal detected.

4 Pulse waveform 1 (*1) is output when the status changes from audio signal

detected to no audio signal detected.
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Terminal Polarity GPI Output
1 T Pulse waveform 2 (*2) is output when the status changes from no audio signal
detected to audio signal detected.
4 Pulse waveform 2 (*2) is output when the status changes from audio signal

detected to no audio signal detected.

*1 Pulse waveform 1 *2 Pulse waveform 2

Hl o _______ Hl o ____

LO ___  mmm———__________Iemmmmmmm—___ LO ____________ emmmmmmmm——l____________

250msec 250msec

Event Scheduler

Event Schedule is shown when [GPI OUT] is set in “Event Scheduler.”
See “Event Scheduler” on page 101.

User Defined Button

User Defined Button is shown when [GPI OUT] is set in “User Defined Button.”
See “User Defined Button (User Defined Parameters)” on page 132.

Event Logger

Event Log is shown when [GPI OUT] is set in “Event Logger.”
See “Event Logger” on page 75.

[Apply] Button
Applies any current setting changes.

[OK] Button
Applies any setting changes and closes the window.

[Cancel] Button
Closes the window without changing any settings.
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When you click the [MIDI] command on the [Tools] menu, the “MIDI” dialog box is displayed. Here you
can make remote control and other settings.

Does not apply to SP2060 units

Names and Functions

| DME Group./DMEG4N =]

Caontral Change ] Program Change ] Parameter Change ]

Clear | Clear Al |

Mo. | Function | Fararmeter | Mir | Maz i‘
00
ooz
003
004
(3]
006
007
(]
0na

] =
] |>H

Gancel |

B Common to All Tabs
DME
From the list, select the DME where you will be making settings.

[OK] Button
Applies any setting changes and closes the window.

[Cancel] Button
Closes the window without changing any settings.

DME Designer Owner’'s Manual 125



Chapter 3 Main Panel Window

[Control Change] Tab

Assigns components to control change for each DME. You can change DME parameters by sending
control change messages from external equipment.
You can assign to control change numbers 1-31, 33-95, and 102-119.

Because control change numbers 0 and 32 are used for bank select MSB, numbers 96-101 are RPN/NRPN related, and
120-127 are used for mode messages, they cannot be used for component assignment.

| DME Group,/DMEG4N =]

Control Change l Program Change l Parameter Change ]

Clear | Clear Al |

e | Function | Parameter | Iiry | Mlaix i‘
|
002
003
004
005
006
oo
00z
(]

010 =
Bl |>H

Gancel |

B Control Change List
The control change numbers and current settings are displayed in the list in the center.

No.
Displays the control change numbers.

Component

Displays the assigned components. Control changes that have no component assigned to them
are blank. If you click here, a list will be displayed. Usable components are on the list. Click the
component name to select it.

If user module security is enabled, the components are not displayed. However, parameters displayed in the user
module editor are displayed here.

| DME Group,/ DMEG4N ~|

Control Change l Program Change ] Parameter Change ]

Oear | Cearar |

Mo, | Function Parameter Iin -
| GomponentGompanderH |

Component:Auto Mixer
§|::::.:|r‘r'||:u:|ne CompanderHy
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When you click here, a list of parameters included in the component is displayed. Select the

parameter you want to assign.

| DME Groupl /DMEG4N |
Control Change | Program Change | Parameter Chanes ]
Gear | Cearal |
.| Function Parameter
001 Component:Compr
002
o0z Kewlnd1:Kevln
004 Dyl Threshold
s} Cyril:1:Ratio
LI} Dyncd:1:kKnee
ooy Dt 1:Attack
nna Dyril:1:Releasze
nng Dyrid:1:Gain
010
011
<

QF Cancel |

Min/Max

Sets the range of operation for the parameter. The current values for the [Min] (lower limit) and
[Max] (upper limit) are displayed. If you click here, a slider will be displayed. The range and
parameter units that can be set will vary, depending on the parameter selected in the [Parameter]

box.

You can change the parameter by dragging the slider. To make a finer setting, press the <Shift>
key while dragging the slider. The value for the parameter will be shown while you are dragging the
slider. When you finish dragging and release the mouse button, the slider will disappear.

The same slider is displayed whether you click the [Min] box or the [Max] box. The black part is the
parameter range. If you drag the left edge of the black part, the [Min] value will change. If you drag

the right edge, the [Max] will change.

| DME Groupt /DMESI-C |

Contral Change | Program Change | Parameter Change }

e | Clear &l |

Mo, | Function Parameter Iin Ma::‘

Component: CobraM et Dutput Out:1:1:Level
AMFINITYdB

E
0.00d8

-
1 | LIJ

QK LCancel |

H [Clear] Button
Clears assignments for the selected control change numbers.

H [Clear All] Button
Clears assignments for all control change numbers.
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[Program Change] Tab

Assigns scenes to program control change numbers 1 through 128. Switches scenes when program
changes are received. These settings are shared by all DMEs in the device group. Up to 999
assignments can be made. Scenes above number 128 are assigned by changing banks.

| DME Group/DMEG4N x|

Control CGhange

Program Change Event

| Program Change ]Parameter Chanee |

Mo | Scene

|
ooz
003

[Seens0l] Scene 001

—

Clear &l
Clear
Agzign Al

004
003
006

007 Bank Select LSB
e Ca—
0ng

aa

011

oz

013 hd|

Cancel

B Program Change Event
Program numbers and the scenes assigned to them are displayed in a list.

No.
This displays program numbers from 1 to 128.

Scene

Displays the scene number and name of the assigned scene. Program changes that have no
scene assigned to them are blank.

When you click here, a list of scenes is displayed. Select the scene you want to assign.

| DME Group/DMEG4N |

Cortrol Change | Prosram Chanee l Parameter Chanee l

Clear Al
Clear
Agsign All

Program Change Event

-

017 E
[Sceneln2] Oonventlon_
[Srene003] Scene 003
[Scene004] Light Cn
[Scene005] DoorOpen

007 Bank Select LSE
b C—
oog

010

011

012

013 =

0] 4 Cancel

B [Clear All] Button
Clears all scene assignments.

B [Clear] Button

Clears the scene assignment for the program number selected in the list, so that no scene is
assigned to that number.
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H [Assign All] Button

Assigns all scenes in order starting from program number 1.

B Bank Select LSB

Chapter 3 Main Panel Window

The bank is changed when assigning scenes numbered 129 and higher. Eight banks can be used,
numbered from zero to seven. Click the [ ¥] and select the bank where you will make settings.

| DME Group,/DMEG4N

Program Change Evert

Contral Change | Program Chanee lParameter Change l

Clear All

Mo. | Scene

-

ooz
004
005
006
oo?
(o]
oog
il
011
oz
03

001 | [Scenel0l] BGM Cantrol
002

=

Clear
Agsign Al

Bark Select LSB

[Parameter Change] Tab

Specifies the parameter to be controlled by parameter change commands for each address. Up to

128 can be set.

| DME Group,/DMEG4N

Control Chanege

Program Chanee | Parameter Change ]

Clear |

Clear Al |

Function

meter

of

0] 4 Cancel |
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B Parameter Change List
The current settings are displayed in the list in the center.

No.
This displays the parameter change numbers.

Component

Assigns components. If you click here, a list will be displayed. Assignable components are on the
list. Click the component name to select it.

| DME Group/DMEG4N ~|

Gontrol Chanee ] Program Change | Parameter Chanee l

Gear | Clasl |
Mo |Functi0n |Parameter |Min |Maxi‘

001 Component:CGompanderH il 1:0n QOFF 0N

-

o1 =
4 | E

0] 4 Cancel |

Parameter

Set the assigned component link parameter.

When you click here, a list is displayed of parameters included in the component selected in the
[Component] box.

Select the parameter you want to assign.

| DME Group/DMEG4N |

Gontral Change | Program Chanee | Parameter Change l

Clear | Clear &l |

Parameter

ComponentCompan... [In:1:1:0n
(K] Keyvln1:1:Kevin

004 Dyvrel:1:Threshald

005 i

006

na7 Divnel:1:fAttack

oo Dvrel1:Release

009 Dync11:Gain

010

Al -
4| | B

0] 4 Cancel |
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Min/Max

This sets the parameter range. The current values for the [Min] (lower limit) and [Max] (upper limit)
are displayed. The range and units that can be set will vary, depending on the parameter selected.
If you click here, a slider will be displayed.

You can change the parameter by dragging the slider. To make a finer setting, press the <Shift>
key while dragging the slider. The value for the parameter will be shown while you are dragging the
slider. When you finish dragging and release the mouse button, the slider will disappear.

The same slider is displayed whether you click the [Min] box or the [Max] box. The black part is the
parameter range. If you drag the left edge of the black part, the [Min] value will change. If you drag
the right edge, the [Max] will change.

| DME Group/DMEG4N =]

Contral Change ] Program Change | Parameter Ghange l

Oear | Clasl |
Mo, | Function | Parameter | Iin | Ma)i‘
001 ComponentCompan... Inl:1:0n QOFF OFF.

2 Component:Compan... Dynd:1:Threshold =
\pOnEn pan... Dy ==t _4dB Max : 27

i
0dB

=
4 [ »

(0] 4 Cancel |

B [Clear] Button
Clears the assignment for the parameter change selected in the list, so that nothing will be
assigned to it.

m [Clear All] Button
Clears all parameter change assignments.
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User Defined Button (User Defined Parameters)

User Defined Parameters

Parameters that the user can operate using function keys <F1> through <F6> in the DME64N/24N unit
or ICP1 are called “User Defined Button.” Frequently changed parameters can be assigned in
advance to any of 24 (four pages times six) presets, and operated on the DME64N/24N unit or ICP1
even if DME Designer is not being used.

This function sets parameters in DME Designer that can be called by these function keys <F1>
through <F6>.

In DME Designer, user defined parameter settings are made using the “User Defined Button” dialog
box. The user defined parameter settings are shared between device group configurations.

“User Defined Button” Dialog Box

When you click [User Defined Button] in the [Tools] menu, the “User Defined Button” dialog box is
displayed.

Does not apply to SP2060 units

B Names and Functions

= User. Defined Button

| DME Group j
1] e 3 4
GClear

LGD Displa| Function Parameter Min |Max |
F1 [GompOn] [CompCn Parameter Walue Edit  |DMEG4MCGomponentCompanderHInd1:0n  |OFF 0N
F2 [SceneChal  |SceneChange | Scene Change 001:BGM Gaontrol = -—
F3
F4
F&
F&

0] 4 Cancel

m [Group]

Select the device group to be set up from the list.

m [1]/[2])/[3)/[4] Tabs
Switches the set to which settings will apply. You can set up to six function keys in each set. The
user defined parameters set on a single tab are displayed on one page in the DME64N/24N unit or
ICP1 main screen.

Function Keys

The function keys are displayed in the leftmost column of the table. When you enter text for [LCD
Display], a short name with up to eight characters will be created and displayed to the right of the
function key.
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Function
Specifies the function to be assigned to the function keys.

" User. Defined Button

|DMEGr0up j
LU O T I

LD Dizplay | Function | Parameter Min | (B |
F1 [SompOn] CompOn |Parameter Value Edit | DMEG4MN:Component:CompanderHIn1:1:0n  |OFF |oN
F2 [SceneChal|SceneChanee | Scene Chanee « | 001:BGM_Control |— |
F3 Mo Aesien [ |

§ Parameter Value Edit

. | Direct Para er Walue
F5 | 5cene Change
Fi GPI Out

Play Wav File

(0] 4 | Cancel

¢ [No Assign]
No assignment. Select this option to clear an assigned function.

* [Parameter Value Edit]
Allows the parameter specified in the [Parameter] field to be changed.

Components for user modules are also listed in a hierarchal display, but if user module security is enabled, the
components are not displayed. However, parameters displayed in the user module editor are displayed here.

¢ [Direct Parameter Value]
Allows the value of a parameter to be set directly. The target parameter is specified in the
[Parameter] field, and the value to be set is specified in the [Max] field.

Components for user modules are also listed in a hierarchal display, but if user module security is enabled, the
components are not displayed. However, parameters displayed in the user module editor are displayed here.

* [Scene Change]
Allows scene recall. The scene to be recalled is specified in the [Parameter] field.

e [GPI OUT]
Allows GPI output. The GPI setting is made in the [Parameter] field.

¢ [Play Wav File]
Allows initiation of Wave file playback. The Wave file setting is made in the [Parameter] field.
Wave files set by the Wav File manager can be specified. Files can not be selected unless a
Wav File Player is included in the DME configuration.
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Parameter

Sets the parameter assigned to each function key. If you click here, a list will be displayed. This list
displays the parameters that are included in the current configuration. Select the parameter you
want called by the function key.

"= User Defined Button

| DME Group x|
L R |
Clear
LCD Display | Function Parameter ‘ Min | Iax ‘
F1 [Compande] ODmpanderOngParameter “alue Edit  |DMES4N.Component:Compander H:Irtre OEE La1]
F2 [Scenedl] Scenell |Scene Change |001:BGM_Contral C.{\ppnneht |
=) ot - 1) S-DMEBI-C &)
i il - | ;£{=--Onmponent
F4 | | =-Slat
F5 - Internal[Analog]
F6 (- Internal [GobraMet]
A5
[=- DMES4N
=-Component

LCD Display

Sets the text displayed on the DME unit or ICP1. Click the [LCD Display] box and enter text. Up to
23 characters can be entered into the [LCD Display] box.

After you confirm the name by pressing the <Enter> key, a short name will be created and
displayed in the function key area as follows: “F1 [shortnam].” The short name will also be
displayed in the DME unit or ICP1 main display. A short name is automatically created with up to
eight characters for display as the user defined parameter name on the DME unit or ICP1 main
screen

Min, Max
Sets the lower and upper limits for a parameter.

[Clear] Button
Clears assignments for the selected function keys. This is the same as “No Assign.”

[OK] Button
Accepts the changed settings and closes the dialog box.

[Cancel] Button
Closes the dialog box without changing the settings.
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Setting User Defined Parameters

Set the user defined parameter.
1 Create a configuration.

2 Click [User Defined Button] in the [Tools] menu.
The “User Defined Button” dialog box will be displayed.

| DME Group ﬂ
T ] 2 | s 4
Clear
LGD Displa| Function Parameter Min |Max |
F1 [CompOn] |CompOn Parameter Value Edit :DMEﬁ4N:Oomponent:CompanderH:In:1:1:On OFF |OM
F2 [ScemeChal  |SceneChange |Scene Change 001:BGM_Cantral | |---
F3 | [
F4
F&
F&
Qf Cancel |

3 Click one of the tabs numbered [1] through [4] to select the set of user defined parameters
you will assign your parameters to.
The four tabs correspond to the pages on the DME unit or ICP1 main screen.

4 ciick the [Parameter] box for the function key to which you will assign the parameter.
A list of parameters included in the current configuration will be displayed.

5 Select the parameter to assign to the function key.

6 Click the [LCD Display] box and enter text for the user defined parameter name.
The [LCD Display] box can accept up to 23 characters, but only eight characters can be displayed
in the DME unit or ICP1 main screen. When making a user defined parameter name, the first eight
characters should be understandable.

When making multiple registrations, you can save time by first setting just the [Parameter] box for all keys, then setting
the [LCD Display] box names. When you enter a user defined parameter name into an [LCD Display] box and press the
<Enter> key to confirm it, the next [LCD Display] box down will be selected, and you can enter text there immediately.
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DAW Control

When you click [DAW Control] on the [Tools] menu, the “DAW Control” dialog box is displayed. Here
you can make settings for when the DMEG64N/24N is controlled from a DAW controller. This is set for
each zone configuration. The setting can be made only when in offline status.

DAW Control can be set on DME64N/24N units only.

DAW control editing can be performed only by users for whom the [Edit] security checkbox has been checked.

Names and Functions

= DAW Control

D Type | OFF -

Function | Controller Label Parameter | =
Chl  MoAssiogn | | :1
Ch2  [Nodssin

Ch3  |MoAszsign

Ché  |Modesign

Cha  |MoAszsign

Che  |Modesign

Ch?  |MoAszsign

Che  |Modesign

Ch3  |MoAszsign | |

ChID |NoAssian | ' | | ]

gk LCancel |

m [DME]
From the list, select the DMEG4N/24N where you will be making settings.

B [DAW Type]
Select the DAW type. The available settings are: MIDI, DAW(Type1), and DAW(Type?2).
The [DAW Type] parameter has the same function as Protocol in the “Utility” dialog box MIDI tab.

MIDI: Use this setting when any MIDI device other than a general purpose ProTools controller (HUI
protocol) or general-purpose Logic or Cubase controller (Mackie control protocol) is to be connected.

DAW (Type1): Use this setting when a general purpose ProTools controller (HUI protocol) is to be
connected.

DAW (Type2): Use this setting when a general purpose Logic or Cubase controller (Mackie control
protocol) is to be connected.

® DAW Control Table
The following can be set for each channel from 1 to 64: [Function], [Controller], [Label], [Parameter].
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Selects the function that will be changed by the DAW controller. If you click here, a list will be

displayed.

=% DAW Gontrol

DME | DME24N =

DAW Type [Off  +

Function
Ghl  |No hesi ~|
R L k
TR Parameter Walue Edt
Scene Change
Ch4 Seene Increment
Chb  [Scene Decrement

Muite
S GPI Lock.

ST | Play Wav File
Che  |Mo Assien

Ch9 | Mo Assign

Controller

Label

Farameter ﬂ

o

oK Gancel |

¢ [No Assign]

Makes no assignments. Select this when you are erasing an already set assignment.

e [Parameter Value Edit]

Allows the parameter of the component specified in the [Parameter] field to be changed.

Components for user modules are also listed in a hierarchal display, but if user module security is enabled, the
components are not displayed. However, parameters displayed in the user module editor are displayed here.

* [Scene Change]

Recalls a scene. The scene is recalled even if the current scene, and the one changed by the

DAW controller, are the same.

When a selection has been made, [SCENE] is displayed in the [Label] field. The last scene is

set in the [Parameter] field.

* [Scene Increment]

Sets the scene increment. Recalls the next valid scene after the current scene.
When a selection has been made, [SINC] is displayed in the [Label] field.

* [Scene Decrement]

Selects the scene decrement. Recalls the next valid scene before the current scene.
When a selection has been made, [SDEC] is displayed in the [Label] field.

* [Mute]

Sets all mute. Mute is set ON and OFF by the DAW controller.
When a selection has been made, [MUTE] is displayed in the [Label] field.

e [Component]

Changes the component parameters. Selectable component names that are arranged in the

configuration are displayed in a list.

When selected, the first parameter included in the component is set in the [Parameter] field.

* [GPI Lock]

Assigns GPI Lock. GPI Lock is set ON and OFF by the DAW controller.
When a selection has been made, [LOCK] is displayed in the [Label] field.

« [Play Wav File]

Allows initiation of Wave file playback. The Wave file setting is made in the [Parameter] field.
Wave files set by the Wav File manager can be specified. Files can not be selected unless a

Wav File Player is included in the DME configuration.
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[Controller]

Selects a controller from the list when [Parameter Value Edit] is set in [Function]. [Switch], [Fader],
or [Knob] can be selected.

[Label]

Enter a label. Double-click to enter the text. You can enter up to 16 characters of text. Set the value
with the <Enter> key, or cancel it with the <ESC> key.

If [Scene Change], [Scene Increment], [Scene Decrement], [Mute], or [GPI Lock] is selected for [Function], the label
name is fixed.

[Parameter]

If [Scene Change], [Parameter Value Edit] or [Play Wav File], is set in [Function], set the
parameters.
If you click here, a list will be displayed.

* When [Scene Change] is set in [Function]
Displays scenes that can be selected.

e When [Parameter Value Edit] is set in [Function]
Selectable parameters are displayed.

* When [Play Wav File] is set in [Function]
Selectable Wave files are displayed.
To select a Wave file, the file must first be specified in the Wav File Manager and then the Wav
File Player must be placed in the DME configuration.

[OK] Button
Applies any setting changes and closes the window.

[Cancel] Button
Closes the window without changing any settings.
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When you click the [Remote Control Setup List] command on the [Tools] menu, the “Remote Control
Setup List” dialog box is displayed.
Registers the parameters to be controlled from an external controller.

DME V3.8 or later/DME Satellite units allow remote control via the [NETWORK] connector as well as via the [REMOTE]
connector. The port to be used is specified via the “Remote” tab of the “Utility” dialog box (page 172).

For details about the communication protocol, refer to the “DME Remote Control Protocol Specifications” on the Yamaha Pro

Audio website (URL below).
http://www.yamahaproaudio.com/

Does not apply to SP2060 units.

Names and Functions

Function Parameter Min Max Tupe | i‘
1 Parameter Walue Edi| Component: Delay-Li -138M 0/ de
2_ Parameter Value Edi| Component:Slot] Oy 1] |-
3_ Level Meter Component: 5P
4 Level Meter Component: Cazcade -
[} Mo Assign
5 Mo Asszign
7 Mo Assign
g Mo Assign
9_ Mo Asszign
T Mo Assign
T Mo Assign
Z Mo Asszign j
Clear String Dizplay || Hurneric ok | LCancel |

[DME]

From the list, select the DME where you will be making settings.

[Function]

Select [No Assign], [Parameter Value Edit] or [Level Meter].

[Parameter]

Specifies the parameter to be controlled. A list of parameters will be displayed according to the

selection of [Function].

Components for user modules are also listed in a hierarchal display, but if user module security is enabled, the
components are not displayed. However, parameters displayed in the user module editor are displayed here.
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[Min]/[Max]
Displays the minimum and maximum values for the parameter.

[Type]

Selects a fader curve when level, etc., is select for [Parameter].

Select [dB] to directly control the level in dB, or [Curve Table] to use one of the DME fader curves
for level adjustment.

[Clear] Butiton
Clears the selected row.

[String Display]/[Numeric] Buttons

Switches the parameter value display format.

String Display: The value displayed in the editor windows.
Numeric: The internal value.

[OK] Button
Applies any setting changes and closes the window.

[Cancel] Button
Closes the window without changing any settings.
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Internal HA Control

The gain and phantom power (+48V) of the DME24N/DMES8i-C/DME4io-C/DMES8I-ES/DME4io-ES
internal head amplifiers can be controlled from a PM5D, and LS9 or other compatible mixing console.
The digital mixer communicates serially with one DME unit in a device group, and that DME unit
controls all other DME units in the group. Only one DME unit in a device group may be connected to a
digital mixer for direct serial communication. This can be a DME unit other than the group master or a
DME unit that does not have head amplifiers.

There are three possible ways to connect a DME unit to a digital mixer for serial communication: 1) via
the [REMOTE] connector, 2) via CobraNet, and 3) via EtherSound. In all cases it is necessary to set
the communication port that the DME unit will use, and if CobraNet or EtherSound are to be used it is
necessary to make the appropriate settings for those protocols as well.

It is also necessary to assign an ID to the internal head amp of the DME that is to be controlled
(page 146). Since AD8HR protocol is used for communication between the DME units and digital
mixer, the head amp IDs allow multiple DME units to be viewed and controlled as AD8HR head amps
from the mixer. Details on making the appropriate settings are provided on the following pages.

¢ Only one mixer can be communicated serially within each device group.

¢ |f the connection between DME series units is interrupted, communication with DME units with ID numbers higher than
that of the unit at which the interruption occurred will not be possible.

e The variable range of GAIN differs between the AD8HR and the DME series. You cannot use the mixer to specify a
value that exceeds the variable range of the DME series.

e |f the DME unit that is communicating serially with the digital mixer is changed, or it’s internal head amp ID assignment
is changed, it will be necessary to restart the DME unit.
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Remote Connection

Connect the digital mixer to the [REMOTE] connector of one of the DME units, and set the port to be
used for head amp control to “Remote” via the [Internal HA Control] parameter in the “Remote” tab in
the “Utility” dialog box (page 172). Use an Ethernet cable connected to the [NETWORK] connectors to
make connections between DME series units.

D-SUB 9-pin Cable

é REMOTE é REMOTE

| . |:| @ ° @~ Ethernet
oo umD J =
DME24N Nsevtmgrrlk
= B,
DMES8i-C
\
Digital Mixer | = Euu] g | ;:
DME4io-C
(=
DMESI-ES
L 0 | =
DME4io-ES

* Only control signals are transmitted and received via the REMOTE connection. Audio connections must be made

separately.
e Connection can also be made to the [REMOTE] connector of a DME unit with built-in head amplifiers.
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CobraNet Connection

Use a CobraNet interface card such as the MY16-Cll to make CobraNet connections between the
digital mixer and DME units. Use an Ethernet cable connected to the [NETWORK] connectors to make
connections between DME series units. The port to be used for head amp control is specified via the
[Internal HA Control] parameter in the “Remote” tab in the “Utility” dialog box (page 172). Select “Slot
1” when the DME unit to be used for serial communication is a DME24N, “Slot 1” through “Slot 4” if it is
a DMEG4N, or “CobraNet” if it is a DME Satellite unit. The settings for all other DME units should be
“OFF”.

It is also necessary to match the CobraNet serial communication channels of the interface card
installed in the serially connected DME unit with that of the interface card in the digital mixer. Refer to
page 495 for DMEB8I-C/80-C/4io-C information. Refer to the CobraNet Manager Lite for Yamaha
Owner’s Manual for more information on setting the MY16-ClI. Set the serial channel for all other
devices to “OFF”.

CobraNet

Network
Switch

Network
) = | @ ot Ethernet Switch
[ e [ =
L om 0o00o00joo gm0
DME24N

oaaoaoa jof| GeweEq

mu@mualo @-mmv

oo

=)

DME4io-C

LS9

When two MY 16-ClI or similar CobraNet interface cards are installed in an LS9-32 in order to control multiple DME units,
use the COMM PORT parameter in the LS9 EXTERNAL HA display to select the slot to be used.
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EtherSound Connection

m Digital Mixers Without a [REMOTE] Connector

Use an EtherSound interface card such as the MY 16-ES64 to make EtherSound connections between
the digital mixer and DME units. Use an Ethernet cable connected to the [NETWORK] connectors to
make connections between DME series units.

The port to be used for head amp control via direct serial communication with a DME unit is specified
by the [Internal HA Control] parameter in the “Remote” tab in the “Utility” dialog box (page 172).
Select “Slot 1” when the DME unit to be used for serial communication is a DME24N, “Slot 3” or “Slot
4” if it is a DMEG4N, or “EtherSound” if it is a DME Satellite unit. The settings for all other DME units
should be “OFF”.

Use the AVS-ESMonitor software from AuviTran to specify the following EtherSound settings for both
the digital mixer’s interface card and the DME unit.

¢ Serial Communication mode: Unicast for bidirectional operation.
e AD8HR Remote Option: Mode 2
¢ Baud Rate: 38400

In order to turn serial communication off for the interface cards installed in all other DME units, set the
Serial Communication mode to “Slave”.

Etrersound Networks B Prpwins | f= HoiPich | @ 10 Poch [ Cornal Etherround Nt B Fopeties | & NetPach | @@ LOPsch |4 o

B Lit [ Tree| M Grop E e [ Ties| e Gione
= 8 NET = B3 v

MYIGESES 81 S MYIBESEA 1
g MYIEESEL 82 g MIBESEE B2
G DMEGES =3 DMEGHES K3
S DME&oES 24  DMEdoES 14

V. [ Emergency Clock
"] Lock Inputs Tects ] e Ingens Tk
[0 Lock Outps [Cizenn | Dtock Ouguas

Serisl Pot Made

) Ioeernal)
] e |
P ARt St < 547t gy
© Mudicat @ Mode 2 g;i eode 2
© Ui reEaE g endSkPotco EheSand ivs
OMode3 " —

O stave
@ Tursi o HA Remele | SeralPer <3 ElbGeurd

O Moda 1
A Remate : Sesial Part ¢ It Skt Poct gy

@ Mode 2
P R ]
Osire CMode

i i HA Remete: Seil Fort ¢ Etherourd

4 Port Carbapasions Sevial Pout Corfiguration

BusdRse e v Paity BadRate [3q4m (v Pasty
Bits pae Chae Pasty Bits pee Char. Paiy
Stop Bies Hamdihake Shoo B Harddiboke
a g
EtherSound

ELLLLLITTELLEITS
=
=
=
n

-

MY16-ES64

MY16-ES64
(mode 2)

(mode 2)
— Network
i |:| @ o @ Ethernet Switch
) - [ e [
00 wlb

DME24N

mEo

=]

WITTTTTEETT LT T ELT LT LT

RO = |o
]

DMESI-ES

“oooooal ol
aoaaoal ol

LS9 DME4io-ES

¢ When installing an MY16-ES64 or similar EtherSound interface card in an LS9-32, be sure to install it in SLOT 1. Also
select “SLOT 1” using the COMM PORT parameter in the LS9 EXTERNAL HA display.

¢ DME24N units with firmware version V3.04 or later are compatible.

¢ You can download the AVS-ESMonitor software from the AuviTran website.
http://www.auvitran.com/

DME Designer Owner’s Manual


http://www.auvitran.com/

Chapter 3 Main Panel Window

B Digital Mixers With a [REMOTE] Connector

Connect the mixer’'s [REMOTE] connector to the MY 16-ES64 or similar EtherSound interface card via a
9-pin D-sub cross cable, and make the appropriate EtherSound connections between the interface
card and DME units. Use an Ethernet cable connected to the [NETWORK] connectors to make
connections between DME series units.

The port to be used for head amp control via direct serial communication with a DME unit is specified
by the [Internal HA Control] parameter in the “Remote” tab in the “Utility” dialog box (page 172).
Select “Slot 1” when the DME unit to be used for serial communication is a DME24N, “Slot 3” or “Slot
4" if it is a DMEB4N, or “EtherSound” if it is a DME Satellite unit. The settings for all other DME units
should be “OFF”.

Use the AVS-ESMonitor software from AuviTran to specify the EtherSound serial communication
settings for both the digital mixer’s interface card and the interface card installed in the serially
connected DME unit.

e Serial Communication mode: Unicast for bidirectional operation.

e Set the digital mixer’s interface card to “Mode 3,” and the DME unit to be used for serial
communication to “Mode 2.”

¢ Baud Rate: 38400

In order to turn serial communication off for the interface cards installed in all other DME units, set the
Serial Communication mode to “Slave”.
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* DME24N units with firmware version V3.04 or later are compatible.
® You can download the AVS-ESMonitor software from the AuviTran website.
http://www.auvitran.com/
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Setting the Internal Head Amp ID

Click [Internal HA Control] in the [Tools] menu to open the “Internal HA Control” dialog box. ID
numbers for the internal DME head amplifiers that are to be controlled from the digital mixer are

assigned via this dialog box. The ID numbers are displayed as AD8HR IDs on the digital mixer. Click

on a [Device Label] field and select the target DME unit from the drop-down menu that appears.

™= Internal HA Control

| DME Group1 =
Device Label Inzert
ID#1 [DMEdic-C Clear
D#2 [DMESIC =
ID#3 |DME24N _ Clexst |
ID#4 |-
ID#5
IDHE
IDg7 |-
ID#s |-
IDHS |- Iove Up
ID#10 |-
D#11 |- Mowe Down
I #12 |-
ID#13 |-
ID#14 |-
ID#15 |-
ID#1E6 |-
Ltiliby | ’TI Lancel

Device Group Select Field
Selects the target device group.

[Device Label]
Selects the DME unit to which head amp control is to be applied.

[Insert] Button

Inserts an unassigned row at the currently selected DME in the list. The originally selected DME will

be moved to the next row.

[Clear] Button
Deletes the currently selected DME from the list.

[Clear All] Button
Clears all settings from the list.

[Move Up]
Moves the selected DME up one row in the list.

[Move Down]
Moves the selected DME one row down in the list.

[Utility] Button
Opens the “Remote” tab in the Utility dialog box. Select the DME unit to be used for serial

communication with the digital mixer and specify the port to be used for head amp control via the

[Internal HA Control] parameter.

[OK] Button
Applies the settings and closes the dialog box.

[Cancel] Button
Closes the dialog box without applying the setting changes.
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When you click [Parameter List] in the [Tools] menu, the “Parameter List” dialog box is displayed. A list
of parameters in the current configuration of the current zone are displayed. Here you can check

things like the parameter IDs. You can also print the list of parameters.
When the dialog box is opened or when a DME is selected from the [DME] list, the parameter values

are displayed.

Does not apply to SP2060 units.

Names and Functions

™= Parameter List

DME | DME Groupl/DME! =
Carpohent 1D Value Iira | b~
=-{Companent
+- Cobrabet Output 10001
=8 Crossover Processor 10004
- 11T Level 0:0:0:0:0 0.00dB AMFINITvdB 1
- Delay1:1:Level 1:0:0:0:0 0.00dB AMFINIT'dE 0
- Delay:1:1:Mute 1:0:0:1:0 OFF OFF C
- Delay:1:1:0n 1:0:0:20 0N aOFF C
- Delay:1:1:Delay 1:0:0:30  0.00mz 0.00rmz [
- Delay: 2:7:Level 1:1:0:0:0  0.00dB AMFINIT'dE 0
- Delay: 27 :Mute 1:1:0:1:0 OFF OFF C
- Delay:2:7:0n 1:1:0:20 0N aOFF C
- Delay: 2:1:Delay 1:1:0:20  0.00msz 0.00rmz [
- Band:1:1:HPFFrequency 20:0:30 800Hz 20.0Hz 2
| - Band:1:1:HPFTupe 20:0:50 484B/0ct Linkwitz  Thru 4T
L »
Preview. . | Save.. | String Display Mumeric | LCloze |

m [DME]

From the list, select the DME where you will be making settings. Components in the selected DME

are displayed in the component list.

Component List

The components and user modules included in the DME, their IDs, and the component parameters
are displayed in hierarchal list. The AD and slot are also displayed.

Components for user modules are also listed in a hierarchal display, but if user module security is enabled, the
components are not displayed. However, parameters displayed in the user module editor are displayed here.

[ID]
Displays the component or parameter ID.

The following is displayed for the parameter ID: “Element No. : X : Y : Parameter No. : Index No.”

[Value]
Displays the value for the parameter.

[Min]/[Max]

Displays the minimum and maximum values for the parameter.

The displayed parameter values are those that were in effect when the dialog box was opened or when the displayed
DME was selected from the [DME] list. They cannot be changed here.
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B [Preview] Button
Prints a list of parameters. When you click this button a preview screen is displayed.

B [Save] Button

Saves the parameter list as a CSV file. When you click this button, the standard operating system
save dialog box is displayed.

The CSV format is a comma delimited text file that can be read by many types of software, such as word processor,
spreadsheet, or database programs.

The parameter values are saved in the display format selected by the [String Display] or [Numeric] button.

B [String Display]/[Numeric] Buttons
Switches the parameter value display format.
String Display: The value displayed in the editor windows.
Numeric: The internal value.

H [Close] Button
Closes the dialog box.

B Printing a List of Parameters

Prints all parameters for the component selected in the list, all parameters for the selected DME, or
all parameters for all DMEs.

When you click the [Preview] button, the dialog box display will change, and the print preview will
be displayed in the center. Buttons will be added to the upper part of the dialog box.

2 Parameter List @
Print... ‘ Setup... ‘ Prev ‘ Mest | Cloze |
Ereview. Save Ok LCancel

[Print] Button

Prints a list of parameters. Clicking here displays the “Print” dialog box. When you click the [Print]
button, printing begins.
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B [Setup] Button

Clicking here displays the “Print Setup” dialog box.

Here you can set the paper size, paper orientation, and font.

[Paper Size]

== Print Setup

Paper Size: Ad
Origntation:

% Partrait
" Landscape

Fant

Lancel

M5 Shell Dig

Taiget
" Selected Companent
* Selected DME
" AIDME

Lo font

Select the paper size from the list.

[Orientation]

Set the orientation of the paper by clicking one of the radio buttons.

e [Portrait]

Prints on the paper with it oriented vertically.

e [Landscape]

Prints on the paper with it orientated horizontally.

[Font]

Chapter 3 Main Panel Window

Displays the set font. Clicking the [Font] button displays the “Font” dialog box, where you can

change the font.

[Target]

Set the parameters to be printed by clicking one of the radio buttons.

* [Selected Component]

Prints all parameters for the component selected in the list.

* [Selected DME]

Prints all parameters for the selected DME.

« [All DME]

Prints all parameters for all DMEs.

[Close] Button

Ends the preview and returns the screen to the original dialog box.

[Prev] Button/[Next] Button

Switches the page being previewed when there are multiple pages. The [Prev] button goes to the
previous page. The [Next] button goes to the next page.
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Component Lock

Click [Component Lock] in the [Tools] menu to display the Component Lock dialog.]

Does not apply to SP2060 units

Names and Functions

Component

DMEZN
,ﬁ,D
= omponent
L[ Analoe Output
ot
i [ Internal[DME24N DAl
i. O Internall[DME24M HA-AD]
DMES4N
L AD
.Component

O Crossover Processor I Select All

O EQ-Comp-Compressar

O EQ-Comp:PEQ-Steren Clear All

O My-Others

[ Speaker Processar

i sln sk

2-5lot

L O SLAT 1My-Cthers]

The component/user module names included in the DME will be displayed. AD and Slot will also be
displayed.

When the checkbox to the left of the component name is checked, the component is locked so that it
is not possible to change parameters from a PM5D or other external device controlling the DME unit
via the RS-422 interface. While the component is locked it is still possible to control the internal DME
head amps via the Internal HA Control function. The lock settings will be transferred to the DME when
the unit is placed on-line. The settings can only be changed while off-line.

If user module security is enabled the components will not be displayed. Components displayed by the User Module Editor
will be displayed.

Only users who's [Edit] box is checked can edit the lock status.

B [Select All] Button
Checks all component checkboxes.

B [Clear All] Button
Clears all component checkboxes.

H [OK] Button

Enters the settings and closes the dialog box.

B [Cancel] Button
Closes the dialog box without entering the settings.
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Either click the [Scene Link Manager] item in the [Tools] menu, or the [Scene Link] button the “Scene

Manager” window to open the “Scene Link Manager” window.

“Scene Link Manager” Window

This window allows setup and recall of scene linking between DME groups and SP2060 units. Scene
linking makes it possible to simultaneously recall scenes on multiple DME groups and/or SP2060 units.

Up to 999 scene link setups can be specified.

Only users with security status in which [Edit] is checked can edit this feature.

This is a DME Designer feature and it does not affect scene recall or store operations carried out from the device panel or

external devices.

Names and Functions

™ Scene Link Manager

Scene Link
%..DD‘I : Scenelink 001
| E-8P Groupl
i..5P2060
..5P2060(2)
=-5F Group2
.. SP2060E3)
..5P206044)
- OME Groupl
i t.DME Group2
3002 : Scenelink 002
= 5P Groupl
i..5P2060
..5P2060(2)
=-5F Group2
.. SP2060E3)
..5P206044)
- DME Groupl

Scene Manager

Scene Mo,

ma:
013

ma:
ma:
: Goene 001
ooz

oo

04
014:

04
014
ooz :

Seene 013
Scene 013

Seene 013
Scene 013

Seene 002

Scene 014

Scene 014

Scene 014

Scene 014
Seene 002

Move UP
Move Down

Becall

Gloze

B Scene Link Tree View

Displays the scene link name, DME group and/or SP2060 scene number, and scene name for each
Scene Link setup. Clicking on scene number or scene name opens a list from which a new
selection can be made. Click on the scene link name to edit it.

H [New] Button

Creates a new scene link setup. Enter a name and click the [OK] button to add a new scene link

setup.
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B [Delete] Button

Deletes the scene link setup currently selected in the scene link tree view. When clicked an “Are
you sure?” dialog will appear. Click the [Yes] button to delete the selected scene link setup.
Click the [No] button to abort the scene link delete operation. The [No] button will be grayed out
and inoperable if a scene link setup is not selected.

[Copy] Button

Copies the selected scene link setup. The [Copy] button will be grayed out and inoperable if a
scene link setup is not selected.

[Paste] Button

Pastes a cut or copied scene link setup to the currently selected scene link setup in the scene link
tree view. The selected scene link setup will be overwritten. The [Paste] button will be grayed out
and inoperable if no scene link setup has been cut or copied.

[Cut] Button

Cuts the selected scene link setup. The [Cut] button will be grayed out and inoperable if a scene
link setup is not selected.

[Insert] Button

Inserts a cut or copied scene link at the currently selected scene link position in the scene link tree
view. The selected scene link setup and all others below it will be moved down one position. The
[Insert] button will be grayed out and inoperable if no scene link setup has been cut or copied.

[Move UP] Button

Moves the currently selected scene link setup up one position in the scene link view. The [Move
UP] button will be grayed out and inoperable if a scene link setup is not selected.

[Move Down] Button

Moves the currently selected scene link setup down one position in the scene link view. The [Move
Down] button will be grayed out and inoperable if a scene link setup is not selected.

[Recall] Button

Recalls the scene number specified for the currently selected scene link setup in the scene link
view to the corresponding devices. The [Recall] button will be grayed out and inoperable if a scene
link setup is not selected.

Scenes can only be recalled in real time for DME and SP2060 units in an online device group.

[Scene Manager] Button
Opens the “Scene Manager” window.

[Close] Button
Closes the window.
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SP2060 Library Manager

Click the [SP2060 Library Manager] item in the [Tools] menu to open the “SP2060 Library Manager”
window.

“SP2060 Library Manager” Window

Allows editing of SP2060 Speaker Processor component libraries. Up to 60 libraries can be stored for
each component, and up to 360 libraries can be stored for each SP2060 unit

Only users with security status in which [Edit] is checked can edit this feature.

B Names and Functions

"2 5p2060 Library Manager

Device Library Lizt Library File = Add File
=-Zanel IF2108 C:/Program Files/YAMAHAOPT Toolz/DME De -
=.5P2060023[192.168.000.013] IF2108_mani C:/Program Files/YBMAHAOPT Toole/DME De M
| [E-Speaker Processor IF2108_sub Ci/Proeram Files/YAMAHASOPT Tools/DME De Move UP
a1 ey IF2112A5 pa Gi/'Program Files/Y&MAHA/OPT Tools/DME De
72 Way IF2112A5 pa_moni  Cu'Program Files Y AMAHAOPT Toolz/DME De Mave Down
.. O 3 Way IF211245 pasub  Gi/Program Files/YAMAHA/OPT Tools/DME De
- O 4 Way IF2112M64_pa C:/Program Files/Y&MAHA/OPT Tools/DME De
.. O B ay IF2112M64_pa_sub G/ Program Files/YAMAHAOPT Toole/DME De
.. O 6 Way IF2112M95 pa C:/Program Files/YAMAHASOPT Tools/DME De
-SP2060[192.168.000.012] [F2112M95 pa_sub  C:/Program Files/YBMAHAOPT Taols/DME De
4J.Speaker Pracessor IF2112M39 pa C:/Program Files/YAMAHA/OPT Toole/OME De Duplicate
O 1 Way IF2112M99 pa_sub  Gi/Program Files/YAMAHA/OPT Tools/DME De
- O 2 Way IF211545 pa C:/Program Files/Y&MAHA/OPT Tools/DME De
.. O 3 Wiay IF211545 pa_moni G/ Program Files/YAMAHAOPT Toole/DME De
. O 4 Way IF211545 pa_sub  Gi/Program Files/YAMAHASOPT Tools/DME De—
- [ B Way IF2115MG4_pa C:/Program Files/YBMAHA/OPT Tools/DME De
.. O 6 Way IF2115ME4 pa_sub  Cu/Program Files/YAMAHAOPT Toolz/DME De Impart List
IF2115M95_pa C:/Program Files/YAMAHASOPT Tools/DME De .
IF2115M95 pa_sub  C:/Program Files/YBMAHA/OPT Taols/DME De M
IF2115M99 pa C:/Program Files/YAMAHAOPT Tools/DME De
IF2115M99 pa_sub  Gi/Program Files/YAMAHA/OPT Tools/DME De
[F2205 C:/Program Files/YAMAHAOPT Toolz/DME De
IF2205_sub C:/Program Files/YAMAHAOPT Tools/DME De
IF2202 C:/Program Files/YBMAHA/OPT Taolz/DME De .
IF2208_mani Ci/Proeram Files/Y&MAHA/OPT Toolz/DME De = M
« | o

B Speaker Processor List
Displays a list of the SP2060 units connected to the specified port.

B Library List

Library titles and library file names are displayed in this list. The default titles are the file names
minus the file extension. Click a title to edit it. Titles can be up to 23 characters in length, but the
SP2060 display will only show 16 characters. 2-byte characters can also be used, but they will not
appear on the SP2060 display.

m [Add File] Button

Adds a library file saved by the component editor (.cel extension) to the SP2060 selected in the
SP2060 list. When the [Add File] button is clicked the “Open” window will appear. Select a library
file and click the [Open] button to add the library.

The [Add File] button will be grayed out and inoperable if no SP2060 is selected.

Refer to the “Libraries” section on page 364 for information on component editor libraries.
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B [Delete File] Button

Deletes the selected library from the library list. When this button is clicked an “Are you sure?”
dialog box will open. Click the [YES] button to delete the selected library.

Click the [NQO] button to abort the library delete operation.

The [Delete] button will be grayed out and inoperable if a library is not selected.

[Move UP] Button

Moves the currently selected library up one position in the library list. The [Move UP] button will be
grayed out and inoperable if a library is not selected.

[Move Down] Button

Moves the currently selected library down one position in the library list. The [Move Down] button
will be grayed out and inoperable if a library is not selected.

[Duplicate] Button

Copies the library from the SP2060 selected in the SP2060 list to a different SP2060. When the
[Copy] button is clicked the “Duplicate” window will open. Select the destination SP2060 and click
the [OK] button to copy the library. Multiple destination SP2060 units can be selected.

Click the [Cancel] button to abort the library copy operation.

The [Copy] button will be grayed out and inoperable if no SP2060 is selected.

[Import List] Button

Imports a library file (.IIf extension) to the SP2060 selected in the SP2060 list. When the [Import List]
button is clicked the “Open” window will appear. Select a library file and click the [Open] button to
import all libraries included in the library file.

Click the [Cancel] button to abort the import operation.

The [Import List] button will be grayed out and inoperable if no SP2060 is selected.

[Export List] Button

Exports and saves the library of the SP2060 selected in the SP2060 list as a library file (.IIf
extension). When the [Export List] button is clicked the “Save As” window will appear. Select a file
format and click the [Save] button to save the library file. If you select the “Library List File” format
only the paths will be saved, and if you select the “Library List File with data” format the actual
library data will be saved to the file.

Click the [Cancel] button to abort the export operation.

The [Export List] button will be grayed out and inoperable if no SP2060 is selected.

[Upload List] Button

Sends the SP2060 library to an SP2060 unit. When the [Export List] button is clicked the “Select
Device” window will open. Select an SP2060 and click the [OK] button to send the library. Multiple
destination SP2060 units can be selected.

Click the [Cancel] button to abort the send operation.

The library is not sent to the SP2060 unit until the [OK] button is clicked even when the SP2060 unit is online. It can be
sent even when the SP2060 unit is offline.

[Close] Button
Closes the window.
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Chapter 3 Main Panel Window

Click the [Communication Port] item in the [Setup] menu to open the “Communication Port” dialog
box. In this window you can set the communication port of the master current device to be used by the

DME Designer.

Selects either the USB-MIDI Driver or DME-N Network Driver for the communication port. Refer to the “DME Setup Manual”

for driver installation and setup instructions.

Only USB x-1 can be selected for a DME Satellite unit connected via USB.

“Communication Port” Dialog

™2 Communication Port

Box

Tx | Rx | Drevice Group |

1 DME4io-ES #1 DME4io-ES #1 DME Groupl
2 |3P2050 #1 | 5P2050 #1 | 5P Group?
3 Mo &ssign DMEdic-ES #1 Mo &ssign

| SP2050 #1

DME4ic-ES #2

Mo Assign

DK LCancel

[TX]

Selects the driver communication port to be used for transmission.

[Rx]
Selects the driver communication port to be used for reception.

[Group]

Select the device group to be set up from the list.
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Shortcut Keys

Click [Shortcut Keys] in the [Setup] menu to display the “Shortcut Keys” dialog.

Names and Functions

== Shoritcut Keys @
Command | ey | -
= Main Panel
- File
- R N
- Open... Chrl+0
- Save Crl+5
- Save s
- DME File Storage
- Preferences Enter new key
- Lag OIff
- Exit Chil+M
- | mport DME Desigrer All File Clear
- Enport DME Dezsigner All File 2
- Edit
- Undo Cril+Z
--Fedo Chrl+y
- Undo History
=Yg
i Designer
=I-User Control
L Mew User Control
- Event Logger Chrl+L
- M avigatar Crl+B j ok Cancel

Click to select the desired shortcut item.

B [Enter New Key]

If assigned, the current shortcut will be displayed.
A shortcut entered via the computer keyboard will be displayed.

B [OK] Button
Enters the settings and closes the dialog box.

B [Cancel] Button
Closes the dialog box without entering the settings.
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Security (Creating Users and Making User Settings)

When you click the [Security] command on the [Setup] menu, the “Security” dialog box is displayed.
Here you can create and delete users. You can also set the security level for each user. Users are
saved as DME Designer settings. You don’t need to create users for each file.

v Enable Auto Log On UAdministrator ﬂ}— — Auto-Logon User
Uszer List
Name | Operation Security
Administrator v Edit
i SustemEngineer

M v igw DME Design Window
-Manager

[v Control Component Editor

< Main peratar ) .
P v igw Component Editar
perator]

- Operatord [V Change Configuration
=1 Dperatord -
L. Operatord ¥ Synchronization

I~ Wiew Log Window
Scene Store/Recall Level |2 El:

User Control Level : 3

View Zone |
Zonel
O Zore2

Add User... Remove User Change... |

0K | LCancel

B User Setting Restrictions

Various restrictions apply, depending on the security level of the user that is currently logged on.
¢ The currently logged on user can edit only users at a security level lower than his or her own.
* The currently logged on user cannot raise his or her own security level.

B [Administrator] User

The [Administrator] user is registered by default, and can use all functions. Immediately after DME
Designer is installed, there is no password set for the [Administrator] user.
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Level 1 User Administrator ¥ Edit
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B Security Level

User security levels are set with the [Operation Security] item at the right of the “Security” dialog
box.

Edit Security User Level

= Security

v Enable Auto Log On | Adrminiztratar ﬂ H Igh

User List

MName | Operation S ecurity

yatemE ngineer

v iew DME Design Window

anager
Level 2 User U=l v Cantrol Compaonent Editar Low
ain0 perator . .
: v ‘iew Component E ditar
Level 3 User I Operatort
¢ Operatord [+ Chanhge Configuration
=) Operator? L
Level 4 User .. Operatard ¥ Synchronization

™ Wiew Log Window

Scene Store/Recall Level |2 il

User Control Level z 3

L Security Level Settings

Yiew Zone |
Zorel
O Zone2

Add Uszer.. FRemove Uzer Change... |

ak. LCancel |

You can allow or disallow editing and the ability to open windows or set controls.

Ten levels, 1 through 10, are set for scene storage/recall and user controls. Level 1 is the highest
level and 10 is the lowest. By default, level 1 is set for the [Administrator] user. Level 1 can be set
for the [Administrator] only. Users created by the [Administrator] directly below itself can be set at
levels 2 through 10. New users created subordinate to users at level 2 can be set at levels 3
through 10. New users can be created no higher than one level below the user that created them.
Scene sets the level for storing and recalling scenes. The logged on user can store or recall scenes
at levels equal to or lower than his or her own level. For example, a user at level 3 can recall scenes
set for scene recall at levels 3 through 10.

Levels are also set for user control. The logged on user can display or edit user controls at levels
equal to or lower than his or her own level.

The log-on user can use zones that are checked in the [View Zone] field.

Users with security level lower than level 2 form groups with a level-2 user as the leader.
Regardless of user security level, user controls and scenes created by users of a different group
cannot be used or edited.
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Names and Functions

[Enable Auto-Log On]

Enables auto-logon. If this checkbox is selected, the user displayed in the box to the right will be
logged on automatically when DME Designer is started. Auto-logon logs on the user without any
password entry.

Click the [ ¥] at the right of the box, and select the user for auto-logon from the displayed user list.

If auto-logon is turned OFF, the “Log On” dialog box will be displayed whenever the DME Designer is
started. Each time a user must be selected and a password entered in order to log on.

If auto-logon is changed from ON to OFF, “Confirmation of Current User” dialog box will be displayed.

*=- Confirmation of Current User g|

Llzer | Adrminiztrator J

Pazzword |

LCancel

Enter the user’s password into the [Password] box, and click the [OK] button.
If you click the [Cancel] button, auto-logon will remain ON.

B Auto-Logon User
Selects the user for auto-logon when [Enable Auto Log On] is checked.

= Security.
[v Enable Auto Log On | Adriniztrator j
User List Administratar
| b airi perator
Harne Operator
Administrator Operator?
i SystemE naineer Operatord
Designer Operatord
= MainOperatar Designer
+ - Operatar SystemE ngineer
=1 Mreratar? TR =T

The currently logged on user can set this command for users at a security level equal to or lower
than his or her own. If a user at a higher level is selected, a message that warns “Cannot access
higher user level.” will be displayed. Click the [OK] button.

=2 DME Designer

e Cannat access higher user level,

To set auto-logon for a user at a security level higher than the currently logged on user, first log off
as the current user, then logon as a user at a higher security level.
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User List

The registered users are displayed here. The currently logged on user is displayed in bold text. Click
the name of the user whose settings you want to edit.

User List

T | Operation Security
Administrator v Edit
L SusternE ngi
[ RvsEmEnanEet ¥ View DME Design Window
Iv¥ Control Companent Editar
%--Dperatoﬂ v iew Component E ditar e
L Operatard I¥ Change Configuration
= Operatar? -
b Operator3 ¥ Synchronization
- I Wiew Log Window
Scene Store/Recal Level |2 =
User Control Level z 3
\
View Zohe |
Zonel
O Zorez
QddlUser... | Bemol\fe User | Ehalnge... |

The [Administrator] is the user set by default, and it is used for administering the system. The
[Administrator] user has the highest level and can use all functions.

All new users are created at a level lower that the [Administrator] user, and are displayed below the
[Administrator].

If a user at level 2 and below has other users subordinate to him or her, a [+] or [-] button will be

displayed to the left of higher level user's name on the list. Clicking the [+] or [-] buttons displays or
hides the users subordinate to that higher user.

The currently logged on user can create multiple users at lower levels.

© Name
Displays the user names. The currently logged on user is displayed in bold text.

© [Add User] Button

Adds a user subordinate to the user selected on the list. Clicking here displays the “Add User”
dialog box. Select the user that will be superior to the new user, then click this button.

If a user higher than the currently logged on user is selected, the button will be grayed out and
no user can be added.

© [Remove User] Button

Deletes the user selected on the list. Only users at levels lower than the currently logged on user
can be deleted.

Furthermore, the currently logged on user cannot delete himself.

O [Change] Button

Changes settings for the user selected on the list. Opens the “Change User Information” dialog
box. The contents of the dialog box are the same as the “Add User” dialog box.
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@ Operation Security

Sets the functions that can be used by the user selected on the [User List] to the left. Selecting
a checkbox enables use of the corresponding function.

e [Edit]
You can change the following settings: editing in the Designer window, user control edit, user
defined parameter edit, word clock, scene edit, GPI and MIDI.

* [View DME Design Window]
Allows display of the Designer window.

e [Control Component Editor]
Allows parameter editing in the component editor.

* [View Component Editor]
Allows display of the component editor.

¢ [Change Configuration]
Allows switching between configurations.

* [Synchronization]
Allows synchronizing with the DME or SP2060 unit.

e [View Log Window]
Displays the “Event Logger” window.

* [Scene Store/Recall Level]
Sets the level at which scenes can be stored and recalled. Click the [A] and [ ¥] buttons or
enter a number into the box to set the level. While levels 1 through 10 are available, the range
of levels that can be actually set varies according to th